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Celemony says thank you!

 

Celemony says thank you!

 

Thank you for choosing Melodyne! Melodyne offers a new, musical and 
intuitive way of working with audio data that we’re confident you’ll enjoy. 

This user manual explains the individual functions of Melodyne as well as 
the underlying concept. Please take the time to read it through carefully. 

Our software is constantly being further developed and improved. Please 
always make sure that you are working with the latest version of Melodyne. 
(The „Updates“ function in the „Help“ menu checks via Internet to see 
whether or not a later version exists). You can always find the latest version 
in the Celemony Download Area: http://www.celemony.com/support/
downloads.html. Please have your Serial Number ready when you log in.

Even as we were printing this manual, a newer version of the program, 
offering additional functions, was released. Whenever you see this icon in 
the margin, please consult the relevant passage in the final chapter of this 
manual to find out what’s new in Version 2.6.

If you have any questions concerning Melodyne, first please read the 
relevant pages in this handbook and consult our FAQ pages to see whether 
we’ve already answered the same question there: 
http://www.celemony.com/support/faq.html.

If any questions remain, please contact our support  
(support@celemony.com) and we will be happy to help you further.

Have fun with Melodyne!
Your team at Celemony

V2.6
p.155
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Contents of the package

 

In addition to this user manual, the Melodyne package includes the 
Installation CD containing the program and your Serial Number (inside, on 
the sleeve of the CD). If you purchased the program online from the 
Celemony Web Shop, you will have been sent your Serial Number by e-mail. 
The Serial Number identifies you as a legitimate owner of Melodyne. Please 
take care not to lose it.

When you start Melodyne for the first time, the Licence Panel will appear. 
Please enter there your Serial Number, the User Name of your choice and 
your Licence Key that you will be given when you register. You can use 
Melodyne for ten days without entering a serial number, but after that you 
will be unable to launch the program, so please request your Licence Key 
in good time.
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What is Melodyne?

 

Melodyne is software providing an entirely new approach to working with 
audio material. Before the Melodyne era, hard disc recording programs 
simply replaced the classical tape recorder with a computer and added 
some additional features. In essence, neither a tape recorder nor a 
computer digital recording “understands” the recorded material. To make 
changes in recorded audio one has to first find the appropriate segment 
before doing any cutting, pitch shifting, or time stretching.

By analyzing the recorded music, Melodyne “understands” the musical 
content of the recorded material. Therefore, it is no longer necessary to 
think in terms of cutting, pitch shifting, or time stretching while working 
with Melodyne. Melodyne does it all for you in the background using 
proprietary algorithms that deliver outstanding sound quality. The user only 
works with the musical elements: the notes that were identified in the 
recording by Melodyne. Each note knows its pitch and rhythmical place 
within a melody. Each note can then be pitched as you like it; the melody 
and the rhythm can be altered according to the user's wishes. Using the 
copy and paste functions, you can create a new melody or just replace an 
ugly note by one that you like better. There is no need to care about zero 
crossings. Melodyne knows the place where a note starts and ends. The new 
note doesn't even have to be identical in length to the one it replaces. A 
change in temporal relation is not a problem for Melodyne. You can even 
add a track played in a free tempo to an existing arrangement: each note 
will find its place in the new rhythm.

Whatever Melodyne does, it makes sense and fulfills musical expectations. 
This is due to a new technology working within Melodyne called “Local 
Sound Synthesis”. Sound and time are completely independent of each 
other. Thus it is possible to change a pitch freely without influencing the 
duration of the note, the tempo can even be slowed down to a sustained 
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sound without influencing the pitch of the note. Any change of pitch is 
accompanied by a correction of the formant position in order to preserve the 
character of a voice. However, you can change the formant position of single 
notes or complete melodies in order to create a different sound character. 
Changes of tempo are performed dynamically in order to keep the 
characteristic start of any given note. However, you can change the 
temporal relation within a note, e.g., to make the attack sound more 
percussive or smoother.

Melodyne requires monophonic audio files as input. Melodyne does not 
process polyphonic files. The audio files should also have been recorded as 
“dry”as possible. Reverb may create polyphony by the physical nature of the 
effect. Percussion can be readily processed with Melodyne and a rather 
steady tempo will be handily identified. Melodyne has a special algorithm 
for percussion; even extreme changes in tempo will be performed without 
“smearing” the percussion sound. Recordings of speech can also be 
processed easily - Melodyne identifies the syllables of spoken words and 
preserves the character of speech while performing temporal changes.

In essence, audio material is not “frozen” any longer. Melodyne enables you 
to work with recorded material as freely as you would with musical 
instruments or notes.
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Installing and Licensing Melodyne

 

System Requirements and Installation

 

Mac: 

 

To work with Melodyne on Apple Macintosh, you need an Apple 
Macintosh Computer with a 500 Mhz Power PC -Processor und 256 MB 
main memory, 867 Mhz Dual and  512 MB or more are recommended. The 
Operating System should be at least Mac OS 9.0.4 or Mac OS X 10.2 
(Jaguar). 

On Mac OS 9, the CarbonLib 1.6 has to be installed. If there is an older 
version of CarbonLib installed on your computer, please update it from 
Apple’s website. Also in Mac OS 9, make sure to have the following 
configuration:

 

■  

 

FileSharing is turned off. 

 

■  

 

WebSharing is turned off. 

 

■  

 

AppleTalk is turned off. 

 

■  

 

VirtualMemory is turned off. 

On PowerBooks you should also disable any energy saving options. 
On Mac OS X there are no special requirements.

 

PC: 

 

To run Melodyne on a PC, you need a 800 Mhz Pentium class computer 
with 256 MB main memory, SVGA Graphics, 16 bit @ 1024x768, 512 MB 
or more are recommended.

Melodyne requires Windows 98, SE, ME, or Windows XP.

 



 

Melodyne user manual   

 

11

 

Licensing Melodyne

 

Mac & PC: 

 

Installing Melodyne is easy:

Double click the “Melodyne Installer” on the CD and follow the instructions 
for installation. Read the License Agreement in the installer Window 
carefully. If you agree with it, continue the installation.

 

Licensing Melodyne

 

When you start Melodyne for the first time, the License Panel will appear. 
In this panel, you will have to enter your serial number, your name and the 
license key. You can use Melodyne for 10 days without the license key. 
Please make sure to order your license key in time.

The Host Id is a unique identification number for your computer hardware. 
Depending on your operating system, the Host ID is based on the Ethernet 
address of your Ethernet card, on vendor specific information of one of your 
hard disks or on your processor and motherboard. If Melodyne has two or 
more options to identify your computer, the license panel will ask for which 
option to take.

 

Mac OS 9: 

 

In Mac OS 9,  “Ethernet Card” is the recommended option. 
Please enable the system extension “Apple ENet” to get the “Ethernet 
Card” option. Keep in mind that Melodyne for Mac OS X will only offer 
“Ethernet Card”. If you choose a hard disk to identify your computer and 
then upgrade to Mac OS X, you will get a new Host Id. So hard disks as 
identifiers should only be used on beige Macs, which will not run under Mac 
OS X.
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PC: 

 

In Windows, “Processor & Mainboard” is the recommended option. If 
you want to coose “Ethernet Card” make sure that you have the correct 
driver for your Ethernet card installed. If you have an ISDN or DSL modem, 
you may get different Host Ids when being online or offline. In that case, 
choose the processor or a hard disk for your Host Id or run Melodyne only 
when being offline.

The serial number is unique for each software package and can be found 
on your registration card, or it has been sent to you by email if you have 
bought the program online. The license key is not provided with the 
program. The license key will be provided to you by Celemony Software 
GmbH based on host Id and your Melodyne serial number. 

You can get your license key via the Internet - go to the website

 

http://www.celemony.com/support/licensing

 

/ and enter the data from your 
License Panel there. Your license key will be sent to you by email 
immediately. Please make sure to enter exactly the same user name into the 
field on the web site and on the license panel. If your computer is 
connected to the Internet and you use the button “Open License Website” 
in the License Panel, the licensing website will be opened automatically.

If you don’t have access to the Internet, you can also get your license key 
by mail. Please enter your name and the given Host Id on the registration 
card and send it to Celemony Software GmbH. We will return your license 
key as soon as possible.

Enter the license key provided into the text field in the license panel and 
click 

 

“

 

Set” - now you can work with Melodyne!

 

Please note: If you change the hardware that the Host Id is based on, the Host Id will also 
change and you will have to license the software again.

 

Audio Configuration

 

Though you do not need to configure any audio hardware to get started with 
Melodyne, you can use ASIO to get more audio channels, lower latencies 
and sampling rates other than 44.1 kHz.

Configuring your audio hardware is pretty easy. Simply open the 
“Preferences” panel and select “Hardware” in the pop up at the top of the 
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dialog box. The first pop-up menu below “Hardware” allows you to choose 
the kind of hardware driver to be used. By default the most common driver 
is selected: DirectX in Windows, SoundManager in Mac OS 9 and CoreAudio 
(HAL) for the built-in device in Mac OS X.

 

PC: 

 

In Windows, if any ASIO driver is installed on your system, you can 
choose between DirectX and ASIO. To take advantage of recording, multi-
channel IO and high audio performance, we recommend you use ASIO. If 
ASIO was chosen in the first pop-up menu, a second pop-up menu allows 
you to choose the specific ASIO driver. 

 

Mac: 

 

In Mac OS 9, you can choose between SoundManager and ASIO. To 
take advantage of recording, multi-channel IO and high audio performance, 
we recommend you use ASIO. If ASIO was chosen in the first pop-up menu 
button, a second pop-up menu button allows you to choose a specific ASIO 
driver. Unlike other ASIO applications, Melodyne does not have an “ASIO 
Drivers” folder. Instead you can use the “+” button and choose the ASIO 
driver that was shipped with your hardware directly. 

In Mac OS X, the first pop-up menu button allows you to choose any 
CoreAudio (HAL) driver that is installed on your system directly. If your 
Melodyne version supports DirectIO on Mac OS X and finds Digidesign 
hardware that is not currently used by another application, a “DirectIO” 
entry is added. Note: While you are running Melodyne on DirectIO, no other 
application can access the chosen hardware. ASIO and SoundManager are 
not supported in Mac OS X.
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Mac & PC: 

 

After setting a new driver, Melodyne takes a few seconds to 
update the capabilities of the other parameters. Please restart Melodyne 
whenever you changed your configuration.

 

Note: With ASIO only one application can use the same hardware at the same time. So you 
will have to quit other recording applications before you start Melodyne and vice versa, 
if you use ASIO to access the same hardware from both applications.

 

The “Sample Rate” parameter sets the sample rate that is used for playing 
and recording. Note that this value does not need to fit the sample rate of 
your sound files, though you get the best audio quality if sample rates 
match. 

The “Buffer Size” shows the number of bytes used to communicate with the 
audio hardware. Low values result in short latencies and high values in large 
latencies. Note that short latencies may cause poor user interface 
performance or drop outs while playing audio. With DirectX a value of 2048 
is a good choice while with all other drivers 512 works in most cases. 
Latency also depends on the hardware used and the chosen sample rate. 
High samples rates result in low latencies and vice versa.

The next two fields, “Inputs” and “Outputs” limit the number of audio 
channels used. These values determine the channels available in 
Melodyne’s audio mixer. Especially with ASIO drivers, limiting the number 
of channels can significantly increase the overall system performance. If 
Melodyne does not support recording with the chosen driver, the number of 
“Inputs” is zero.

The “File Cache” defines the amount of sound data Melodyne tries to keep 
in your computer's main memory while playing. If you perform operations 
that require a great deal of processing time (like changing the pitch of all 
notes at the same time, or setting the tempo of single bars), low values for 
the “File Cache” may result in “buffer under runs” which cause playback 
drop outs. On the other hand, large values result in high memory usage and 
Melodyne may terminate unexpectedly if you haven't assigned enough 
memory (under Mac OS 9). A file cache of 5 or 10 seconds will be a good 
choice for most cases. The best values for all of these parameters depend 
on your personal working style and on the hardware you are using. So if 
something does not work as expected, play around with these parameters to 
get the best results.
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How to Work with Melodyne

 

The use of Melodyne is very intuitive. However, Melodyne has features not 
available in other audio programs. Please take some time to become 
familiar with the way Melodyne works. Melodyne's controls will be 
presented first, followed by typical working scenarios. In the second part of 
the manual all functionalities will be presented in detail.

 

Melodyne Handling Specialities

 

Many operations in Melodyne can be performed using keyboard shortcuts. 
The shortcuts described in this manual always refer to the keys that the 
operations are assigned to by default. However, you can change or define 
most of these shortcuts, as described in the “Preferences” chapter.

 

Mac: 

 

In Mac OS 9, to use the function keys (F1-F12), you may have to 
switch off the Mac OS function keys in the Keyboard control panel.

Some operations, like for example choosing a tool from the toolbox, are best 
done in Melodyne with the right mouse button. If you don’t have a two-
button mouse in Mac OS, you can hold down the “Ctrl”-key on a mouse 
click, whenever an operation with the right mouse button is described in 
this manual.

 

PC: 

 

The most common keyboard commands are usually performed with a 
given key combined with a “command” key pressed. This standard 
command key is different in Mac OS and Windows: In Mac OS it is the “ ” 
key, in Windows the “Ctrl” key. In this manual, that command key is always 
referred to as “ /Ctrl”, as for example, “ /Ctrl - Z” for the “Undo” 
command.
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The Tool Box Use with the Mouse

 

Most of the editing procedures in Melodyne are performed with the mouse. 
Different procedures use different tools; these are characterized by a 
distinctive mouse cursor for each tool. The tools are chosen from a toolbox 
that can be accessed by a right click of the mouse or from a toolbox palette 
on the upper left side of the active window. A right click of the mouse 
causes the toolbox to appear on the screen next to the cursor's position.

 

 

 

Most of the main tools have subtools. Subtools appear below the main tool 
when you select a main tool by clicking and holding the mouse over the 
main tool icon. Each main tool has a play function symbolized by a speaker; 
this provides a convenient way to listen to single notes or to selected 
melodies while editing. You can switch between the speaker tool and the 
currently active editing tool quickly using function key F12.

 

Inspector Bar and Text Fields

 

The inspector bar, positioned to the right of the toolbox and above the time 
ruler, changes its appearance depending on the tool chosen. The inspector 
bar may contain text fields with information about a selected melody or 
note. It is not always necessary to edit notes with the mouse. In many cases 
you can alter notes by typing a numerical value into text fields. 
Alternatively, you can drag edit the value directly by clicking the text field 
and dragging the mouse up or down. To edit a value directly by typing, 
double click the text field.

In many cases there will be an action menu next to the tool box that you 
can use to perform actions specific to the currently selected tool.

 

Turning Knobs and Sliders

 

With the turning knobs responsible for panorama and amount of effect, 
values can be changed either by up/down or by left/right movement. A 
movement from lower left to upper right will result in faster value changes, 
whereas a movement from upper left to lower right will have no effect.
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Dragging the knob with the “Shift” key pressed will result in higher 
resolution of value changes. “Alt”-clicking in Mac resp. “Ctrl”-clicking in 
Windows on a knob (or slider) will set its value to its default position, e.g. 
0 db for amplitudes or center position for panorama.

Other controls generally behave as they do in other software programs.

 

The Working Windows in Melodyne

 

The Arrangement Window

 

In Melodyne you will do most of your work in three windows, the 
Arrangement Window, the Editor Window and the Melody Definition 
Window. You always start working with an “arrangement” using the 
Arrangement Window. Even if youwant to work on a single melody, it will be 
loaded into an arrangement.

An arrangement consists of several tracks each of which can contain one 
monophonic file. You can record a single melody per track or you can import 
one monophonic sound file into a track. For pragmatic reasons, the content 
of a track will always be called a “melody” even when you work with 
percussion or speech. Initially, a melody within a track is always identical 
to the recorded or imported sound file. As you work with it, the melody may 
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ultimately consist of several different segments of notes from recordings 
that you have added with the copy and paste function. 

A new recording or an imported sound file not yet analyzed by Melodyne is 
presented by an envelope display like the ones used by a sample editor. An 
analyzed melody is easily identified because the single notes are displayed 
higher or lower according to their pitch.

When you click on the melody in a track, it is selected for editing. You can 
also select a track by clicking on the track bar to the left of the target 
melody in the arrangement window. The selected track shows a frame in the 
track bar, and the selected melody is represented by a darker color 
compared to the non-selected melodies. If you want to select an empty 
track, because, for example, you want to paste a melody copied from a 
different track onto it, you will have to click on the empty track's track bar. 

You can change the height of the display of a track by dragging the 
separation line between the track rectangles in the track bar. You can 
change the order of the tracks by clicking somewhere in the area of a track 
bar's rectangle and dragging it upward or downward.

If you want to switch from the envelope display to a common note 
representation, you can do so by clicking the staff icon button to the left of 
the time ruler and above the track bar column. Melodies that have not yet 
been analyzed will only display their rhythm notation. Likewise, tracks that 
have been specified to be percussive material on detection will only display 
note time value. 

In the Arrangement Window you can do the following things:

Record or import monophonic sound files.

Rearrange your arrangement by copying and pasting single notes or whole 
melodies.

Move an entire melody in its track in time (however, moving single notes or 
parts of the melody has to be performed in the Editor Window, as explained 
below).
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Automatically adapt the tempo of imported melodies to the tempo of the 
arrangement.

 

Change

 

 the tempo of the entire arrangement.

 

Define

 

 the tempo of the entire arrangement.

In order to perform detailed changes within a melody you have to open the 
Editor Window.

The use of the Editor Window requires sound files that have already been 
detected and defined by Melodyne. The detection performed by Melodyne 
provides the exact course of pitch and other important features of a melody 
and ultimately enables you to work on single notes. A double click on a track 
in the Arrangement Window will start the detection. Thereafter, the melody 
will be represented in the corresponding track in its detected form. Tracks 
that have been submitted to the detection process will create a file with this 
detection information on the hard disc. This procedure ensures that the 
melody is ready for future purposes and does not have to be analyzed again. 

A double click on the detected version of the melody opens the Editor 
Window where you will see the detected melody.
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The Editor Window

 

  

In the Editor Window you will find the recorded sound separated into 
sections that have been detected to be single notes. These notes are 
displayed according to their pitch. The background imitates a piano 
keyboard with the white and black keys. The notes will not necessarily drop 
onto a defined piano key but will be shown at the individual center of 
intonation, performed by a singer or player of an instrument. When the 
pitch-shifting tool is selected, the precise course of the pitch within a note 
will be displayed including any phrasing or vibrato. 

You can grab a note or a group of notes with different tools and change a 
variety of parameters according to your musical imagination. 

In the Editor Window you can do the following things.

Create new melodies using copy and paste or replace single notes. Pasted 
notes can be positioned independently of timing or can be snapped into a 
defined beat.

Shift the pitch of notes (correct intonation or change a melody). The pitch 
can be moved freely within the tone range or can be adjusted to match a 
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note of a defined scale. An adjustment to a given semitone also 
automatically provides intonation correction. 

Change the amount of pitch deviation within a note by changing the vibrato 
or the phrasing. Simple pitch-shifting with Melodyne will not influence the 
phrasing or vibrato of a note at all.

Change the velocity of transition between pitched notes. Melodyne adapts 
the transitions between pitch-shifted notes in a musically sensible way but 
you can override the transition as described later. 

Change the formant position of a whole track or of a single note. Melodyne 
adapts the formant position when pitch-shifting in order to preserve the 
character of a voice. However, you have the option of changing the formant 
position according to your wishes. In addition, you can also alter the 
transition velocity between notes with altered formants.

Change the amplitude of a note, and change the transition between notes 
with changed amplitude. Select the mute function for a note.

Move notes in time, resulting in a change of time phrasing. Quantify notes 
on a defined beat. Stretch or squeeze single notes or groups of notes in 
time. 

Modify the attack of notes in order to obtain a more percussive or smoother 
start of a note. 

Modify note separation. For example, cut the beginning of a note in order 
to insert an ornament or dissect a long note and insert a little melody in the 
middle of the long note.

The Editor Window may contain a single melody or several melodies. 
Melodies that are currently not processed are shown in the background in a 
pale color. Melodies can be imported in the Editor Window by a double click 
on the corresponding track in the Arrangement Window or via a pop-up 
menu. In the Arrangement Window as well as in the Editor Window, a 
processed melody can be presented in score notation.
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The Working Windows in Melodyne

 

The Melody Definition Window

 

The Melody Definition window is similar in most ways to the Editor Window, 
however, its only purpose is to provide a melody definition and to correct 
mistakes of detection manually. The use of this window is strongly 
recommended if you want to work intensely with a melody and if you want 
to use this melody in other arrangements. You can check the result of 
detection and correct mistakes as explained in a later section of this 
manual.
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A Musical Tour with Melodyne

We have prepared some examples to present the various options provided 
in Melodyne. You will find these examples in the folder “.../Manual/
Tutorial” in the Melodyne Application Folder.

Change of Pitch and Tempo of an Arrangement

Start Melodyne and open the file “.../Manual/Tutorial/Boarisch/
Boarisch.mar” via the menu item File -> Open. Opening a whole arrangement 
may take some seconds. You should then see an Arrangement Window 
containing 6 tracks. Start the playback. The following start and stop 
functions can be used:

■   via the corresponding buttons in the transport bar. If the window does 
not show up on launching Melodyne you can find it using the menu item 
Window -> Transport Bar

■  via the numeral keypad on your computer keyboard. The “Enter” key 
performs “Start” and the “0” key performs “Stop”. The “Space”-bar 
performs “Start” and “Stop” alternately.

■  via a double click into the upper light gray part of the time ruler 
(positioned above the tracks) for “Start”. A single click performs a 
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“Stop”. A click into the time ruler also defines the playback position; the 
playback will start at this position when you double click.

You will hear musical greetings from the Bavarian homeland of Melodyne 
performed by 6 wind-players recorded on monophonic tracks (Thanks to 
Wolfgang Netzer’s “Bavario”, www.bavario.de).

Open the “Temporary Play Offsets”- Panel via the menu item Window   -> 
Temporary Play Offsets.

You see three input fields for pitch, formant position, and tempo. When you 
change values in these fields you only change the global playback 
characteristics of the arrangement, but you don't alter the arrangement 
itself. With the Button “Fix to Arrangement” these values can be used to 
change the arrangement itself. Don’t use this button now.

Play the music; now enter “400” into the pitch field - you will hear the 
entire piece a third higher (100 cents correspond to a tempered semitone, 
1200 cents correspond to an octave). Use the “Reset”-button to return to 
the original version. While the music plays, click the pitch field, keep the 
mouse pressed and go upwards or downwards - you change the pitch of the 
entire arrangement while the music plays, without any impact on the 
tempo.

Change the formant position of the entire arrangement by clicking the 
formant field and moving the mouse up or down. A change of the formant 
position affects the timbre. This does not happen in the way ordinary filters 
work, instead, the resonance volume of the instruments is enlarged or 
diminished without any impact on the pitch.

Now change the tempo of the entire arrangement during playback clicking 
the tempo field and moving the mouse up or down. Slow down the tempo 
until you reach a complete stop - a nice demonstration of what “local sound 
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synthesis” means: You hear the local sound at a given place without any 
impact on pitch and without artifacts. Or listen to the piece at a tempo of 
1 bpm, i.e. more than a hundred times slower than the original tempo.

Another application of “local sound” is represented by the Melodyne-
specific scrub-mode: Go back to the original version of the piece by using 
the reset keys for all parameters in the global offsets panel. Click into the 
Arrangement Window and select the fourth subtool under the first main 
tool, the arrow icon, (as described under “The tool box use with the 
mouse”). The tool is named “scrub play”. Click in the arrangement with this 
tool and move the mouse with the mouse button pressed. Go to and fro. You 
hear the local sound with its pitch independent from the velocity of your 
movement. The fifth subtool, which is named “scrub solo”, does the same 
thing for a single melody but not for the whole arrangement.

In the next example you will change the tempo at specific locations within 
the arrangement. This procedure will change the arrangement itself and not 
just its temporary playback properties as happened via the “Temporary Play 
Offsets”. However, whatever you do with Melodyne will not destroy your 
initial recordings - all changes executed with Melodyne will not touch the 
original sound files; there is also no generation of new sound files except if 
you explicitly want to preserve the result of your work as a sound file.

Scroll bar 16 of the arrangement to the middle of the window (you will find 
the bar numbers in the gray time ruler above the arrangement). 

Select the third tool named “Edit Arrangement Tempo”; in the inspector bar 
you will see a text field indicating the tempo. At the beginning of bar 16 
and 17 thicker blue lines appear, indicating a change in tempo or signature. 

Click into bar 15 of the arrangement - in the text field displaying the tempo, 
you will see a value of 167, however, in bar 16 the value is 148.2 and in 
bar 17 the value is 167 again. The tempo is also indicated in the time ruler 
at the beginning of each bar where the tempo changes. The musicians did 
not play with a metronome click when the piece was recorded and 
introduced a ritardando before starting the second part of the piece - so bar 
16 appears to be slower:

Now we want to exaggerate the delay as we approach the transition to the 
second part and we will set the whole second part to a tempo of 150.
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To achieve this, set the play position to the middle of bar 16 using a mouse 
click, and set the value in the tempo field to “120”: Bar 16 stretches out 
immediately and the following notes re-arrange accordingly. 

Then set the play position to somewhere after bar 17 and adjust the tempo 
field to “150”: beginning at bar 17 the new tempo will take effect and 
again the following notes will be re-arranged accordingly.

Now, let us adjust the ritardando approaching the transition between the 
parts. To do this we insert yet another tempo change. Double click the 
beginning of bar 15 directly in the arrangement (not the time ruler) and be 
careful not to click on a note but into a free space between the tracks. A 
new blue line will appear that defines the new tempo for this sequence. The 
tempo in bar 15 remains at 167. Set the play position now to bar 15 and 
set the tempo field to “140”. This will achieve the ritardando as we 
approach the transition.

You can adjust the transition further by inserting another tempo change 
before bar 15. This will achieve a more graduated ritardando. If you want 
to cancel a tempo change you do so by double clicking the blue line at the 
start of the bar. 

Changing the Pitch of Single Notes in a Melody

Open the file “.../Manual/Tutorial/SingleMelodies/MaterSummiDomini.wav” 
using the menu item File -> Open. This is a single vocal line that is opened 
in a new arrangement. Melodyne has previously detected the melody so that 
the notes appear with their pitch in the Arrangement Window. Double click 
the melody to open the Editor Window.
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Activate the score note representation in the Editor Window by clicking on 
the staff icon to the left of the time ruler.

Now start playing the melody by double clicking the upper light gray section 
of the time ruler. Scroll the melody until you can see the last phrase of the 
melody in bars 7 and 8. 

Use the mouse to drag a selection rectangle across the last notes of the 
melody beginning with the last note of bar 6. (To drag the selection 
rectangle click in the background beside a note and drag the rectangle over 
the desired notes by holding down the mouse button).

Double click the lower dark gray part of the time ruler; this will set the left 
and right locators to include the selected notes. These locators are the red 
“L” and “R” markers in the time ruler.

Activate the cycle mode by clicking the far left cycle button in the transport 
bar and play the tune. The selected sequence will now be repeated in a 
loop.

Now select the second tool that is used to make pitch changes, labeled 
“Edit Pitch”. The display shows the exact course of the sung pitch - for 
example you can see a vibrato on the penultimate note. 
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Grab the penultimate note that begins in bar 8 and pull it a little upwards 
while the music is playing. The note changes its pitch. Pull the note up by 
a few semitones.

Select the first subtool of the pitch tool. It is the “Pitch Align” tool. Use it 
to grab a note and move the mouse upwards or downwards. You thus change 
the phrasing of the note - in this case the vibrato is amplified or decreased. 
If taken to the extreme, the vibrato is cancelled out. Set the phrasing to its 
original state with the action “Reset Pitch Align to Original” from the “Edit 
Pitch” action menu in the inspector bar.
 

Now select the third subtool of the pitch tool, labeled “Pitch Transition”. 
The arranged note should still be shifted a few semitones above its original 
position. Blue lines appear at the transitions between the notes. Grab the 
transition of the pitch- shifted note and move the mouse upwards or 
downwards. This changes the slope of the pitch transition. Set the 
transition to its original state with the action “Reset Pitch Transition to 
Original” from the “Edit Pitch” action menu in the inspector bar.

Now again select the main pitch editing tool labeled “Edit Pitch”. Select 
all notes with “ /Ctrl - A” and perform the action “Reset Pitch Center to 
Original” from the “Edit Pitch” action menu in in the top inspector bar. All 
notes will be reset to their original pitch. The pop-up menu for setting the 
pitch quantize mode in the inspector bar now displays the “No Snap” mode. 
This means that you can freely change the notes in their pitch. Choose the 
mode “Note Snap” in the pop-up menu. Behind the notes blue rectangles 
will appear exactly in the semitone positions that are assigned to the notes. 



Melodyne user manual   29

Shifting the Formants of a Melody

If you click on a note it will align itself to the corrected position. If you 
select all notes and then click on one of them, all notes will be corrected to 
their respective semitone positions. (You can predetermine for the whole 
arrangement where the correct positions are located since any desired 
tuning can be defined. See “Defining the Tone Scale and Tuning”) If you 
now move a note, it will always snap to the closest semitone position of the 
predetermined scale. 

Now select the mode “Scale Snap” in the pitch quantize pop-up menu. On 
the left edge of the window, buttons will appear which allow you to select 
the key of the arrangement. The blue rectangles also move to the positions 
required by the new key. With the a usual mouse click you select the major 
scale, with the a mouse click with the “Shift” key pressed you select the 
minor scale. The notes can now only move to those pitch positions 
permitted by the key. Select all notes and set the locators to the entire 
length of the melody by double clicking the dark gray part of the time ruler. 
Let the music play. Change the key with the buttons to the left of the Editor 
Window. The melody changes continuously according to the chosen key. 
The transitions between the shifted notes are still maintained in a musically 
sensible fashion. 

Shifting the Formants of a Melody

You can change the formant position of an entire melody to give a different 
character to the recorded voice. You can also change the formant position 
of single notes to keep the character of a piece more coherent after notes 
change pitch position dramatically from their original course. 

Again choose the pitch shifting tool and the “No Snap” mode. Select all 
notes and reset them to their original position using the the action “Reset 
Pitch Center to Original” from the “Edit Pitch” action menu. The first text 
field in the inspector bar for the pitch shifting tool serves to change the 
notes in semitone steps. 

Select all notes again. Let the music play. Enter “-12” in the semitone 
field. The notes will shift one octave lower. The original formants of the 
voice still remain, which in this case is rather inadequate. An actual singer 
would not sound that way singing an octave lower. We want to change the 
formants such that they would make our singer sound more like a tenor.
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Choose the third tool, which is used to change the formant position of a 
note. Select all notes and play the music. Enter “-1200” in the formant 
position change field. Now, you hear the voice in the way it would sound an 
octave lower without a correction of the formant position. Realistically, the 
formant position of a tenor voice is located somewhere between the 
corrected and the uncorrected formant positions. You can find the sound 
you would expect from a tenor voice by dragging the formant position bar to 
a different position while the music is playing. Alternatively, you can 
change the formants by clicking the formant text field and dragging up or 
down.

Moving Notes with Time Adaptation

Now, let us duplicate a melody and shift the second voice such that the 
piece turns into a canon.

Reset all notes and formants to their original position by using the “Reset” 
actions from the from the “Edit Pitch” action menu. If actions in the action 
menu are displayed as inactive, it is indicated that the respective property 
is in its original state. Then, close the Editor window. Alternatively, you 
could close the arrangement without saving and open it again.

Stay in the Arrangement-Window. Select and copy the entire melody. Select 
a second track by clicking the left vertical track bar. A frame drawn around 
the track bar display will indicate the track selection.

Choose the item “Bar” in the quantize pop up menu and set the position of 
insertion close to the start of the first bar. Paste the melody into that 
position. With the “Bar” option active, it is not necessary to paste the 
melody into its exact location. The notes will automatically be moved to the 
same relative position to the bar start as they occupied in the track from 
which they were copied.

Now, select the second tool, which is used to move a melody in time. Make 
sure that the “Bar” option in the quantize pop-up menu is active. Click the 
right arrow key next to the action menu in the inspector bar. The melody 
moves by a bar in time. Have a look at the gray time bar over the 
arrangement:
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Each bar shows a different tempo; the singer recorded the melody in a free 
and very varied tempo. Since the melody was previously detected and 
defined, each note knows its rhythmical position. This is why the melody is 
not simply moved as a whole exactly as it was recorded. Each note is moved 
to the position in the bar that corresponds to the respective tempo in that 
bar. Turn on the metronome click in the transport bar and listen to how the 
tempo changes throughout the melody.

Now, we want to add a track with percussion to the arrangement. To do so, 
we open the file “.../Manual/Tutorials/SingleMelody/Drums.wav” via the File 
-> Add Melody menu item. It is opened in track 3. Listening to the 
arrangement, you will discover that the percussion track does not fit the 
arrangement. It was taken from another recording, which had nothing to do 
with the first melody. Because Melodyne had previously detected the 
recording, its tempo can simply be adapted to the arrangement.

Reselect the second tool to move the melody in time and select track 3. In 
the inspector bar you will find an action menu entitled “Edit Timing”. 
Choose its first action entitled “Adapt Time”: the percussion track 
automatically adapts to the irregular tempo of the sung track. Now we want 
to select a regular tempo for the entire arrangement.

Select the third tool which is used to change the tempo of the entire 
arrangement. Blue lines will appear at the beginning of each bar of the 
arrangement. They show where the tempo changes are located in the piece. 
In the inspector an action menu entitled “Edit Tempo” will appear. Choose 
its “Equal Tempo” action: all tempo changes are removed, and all notes are 
moved to achieve a regular tempo. You can change the resulting tempo in 
the “Tempo” field as you wish.
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Detecting and Defining a Melody

To use the audio material in this fashion, each melody you work with has to 
be first detected by Melodyne. Depending on the success of the detection 
- which depends on the material - you might need to make some 
corrections. This is the case when a melody has an irregular tempo such as 
the melody in the last example. In any case, you should check whether the 
assignment of each note is correct in the Melody Definition Window after 
each detection process.

Let us use the vocal track from our last example to detect and define a 
melody. Load the “.../Manual/Tutorials/UndetectedMelodies/
MaterSummiDomini.wav” file into a new arrangement using the File -> Open 
menu item. Take care to choose the sound file from the folder 
“UndetectedMelodies”. The same sound file located in the 
“SingleMelodies” folder, which we worked with before, has already been 
detected. Thus in the “SingleMelodies” folder there is a corresponding 
saved file with the extension “.mdd” which contains the detection data for 
MaterSummiDomini. If we want to detect the melody anew we will have to 
choose its raw version.

The opened melody is located in track 1. The envelope displays notes 
without pitch assignments indicating that the melody has not been 
previously detected. Choose the action “Detect Melody” in the “Define 
Melody” action menu in the inspector bar. The Detection Panel will appear 
- ignore the values specified in it and start the detection process by pressing 
the “Detect” button.

When the detection is completed the notes of the detected melody are 
assigned to their respective pitches. Now, let us check the detection and 
make some corrections, if necessary. To that end, choose the action “Edit 
Definition” in the “Define Melody” action menu. The Melody Definition 
Window opens. It resembles the Editor Window in many ways. In order to 
make it easier to recognize, it has a red background.
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A melody is never edited musically or its sound modified in the Melody 
Definition Window. Only the assignment of the audio material to musical 
parameters is examined and, if necessary, corrected.

The second tool is used to correct falsely detected notes. The most frequent 
mistake is the incorrect identification of an octave position - we can easily 
find these mistakes by playing and listening to the melody and drag them 
to their correct pitch with this tool, if necessary.

Select the first subtool to listen to the melody. By changing to this subtool 
the pitch curve turns red: now the melody is not played with its own sound; 
it is resynthesized with a continuous sound. Listen to the melody with that 
sound - in this case no pitch detection errors have occurred. (Later, you can 
detect the soundfile “.../Manual/Tutorial/UndetectedMelodies/Guitar.wav” 
and listen to the melody in this mode for comparison - there you will find 
that the third note is not assigned to the correct octave.) 

Now, use the third main tool - it is used to correct note separations. Vertical 
lines appear between the individual notes denoting note separations.

Choose the “Play Note” subtool to play individual notes. (You can switch 
between the speaker tool and the currently active editing tool quickly with 
the function key F12.) Click on the individual notes in the melody - you will 
hear the region between the two separation lines. Click on the last note in 
bar 1: you will hear that a very short note was not separated from the next 
one. Change to the main note separation tool and double click on the note: 
the notes are separated at the appropriate position.

Change again to the “Play Note” subtool and click on the second and third 
note in the middle of bar 2: here the initial sound “Frrr...” of the syllable 
“Fra” was erroneously separated. Fuse both parts of the note by double 
clicking on the separation line between the notes.

Listen to the first note in bar 3: here, two notes with the same pitch were 
not separated appropriately - separate them with a double click. 

Listen to the last note of bar 2 and the following one in bar 3: here the 
“sss...” that belongs to the next note was attached to the previous one. Grab 
the separation line between the notes and move it a bit to the left.
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The last separation error is right at the start or bar 4: double click that 
separation line.

Another way to quickly check and edit note separations will be introduced 
in the main chapter “Detecting and Defining a Melody”.

Select the fourth main tool, which is used to define the tempo of a melody. 
If the tempo of a recording is regular, Melodyne will in most cases detect it 
correctly. In that case you just might have to drag the start of the first bar 
to the first beat with this tool. In this melody however the tempo is very 
irregular and we have to define each bar start, if we want to have the ability 
to adapt the melody to any given tempo later on.

At the start of the first bar you can see a vertical yellow line - this is the 
“time- anchor”. Grab this line and move it such that it is located at the start 
of the first note. Then grab the bar background at the start of bar 2 and 
move it to the left until the tempo field shows about 100 bpm. Now triple 
click the note that now is located at the beginning of the second bar. This 
sets a new bar start and attaches the bar to this note. Bar 2 is a lot slower 
- drag the bar out by grabbing the bar background at the start of bar 3 and 
pull it to the start of the next note. There double click the background in 
order to set a new bar start. The next bar is again a little faster - shorten it 
accordingly by pulling the background and set the bar start to the start of 
the first note of the bar with a triple click on that note. Throughout the next 
bars, the tempo is somewhat more regular - if the notes are sufficiently 
close to the bar start, the new bar start is set by triple clicking the respective 
notes. A falsely set bar start can be removed by double clicking on the red 
line yet again.

The other tools will be exhaustively discussed in the main chapter 
“Detecting and Defining a Melody”

Close the Melody Definition Window and confirm the changes you made. 
This updates the file with the extension “.mdd” that belongs to a detected 
sound file. In this file the definition of the melody is saved. If a melody was 
detected it can be reused in any arrangement without having to be detected 
again. 

Never erase the .mdd file if its corresponding sound file is used in an arrangement and 
always copy the .mdd along with the sound file if you need it some other place (e.g. on 
another computer)!



Melodyne user manual   35

Detecting and Defining a Melody

When you have confirmed the changes, the melody in the Arrangement 
Window from which the defined melody was opened will be updated 
accordingly. If you previously made pitch changes to the melody prior to 
editing the detected definition the pitch changes will not be automatically 
updated. If you want to update the melody with the latest changes of the 
definition and thus lose the prior pitch changes in the arrangement, you can 
do so with the action “Reset to Definition” in the action menu entitled 
“Define Melody”. If you want to avoid loosing changes made in the edit 
window you must always detect and define a melody before editing it 
musically. 
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The Basic Functions of Melodyne

Opening Sound Files

Melodyne supports the AIFF, WAV (PCM coded formats) and SND sound file 
formats, and additionally SDII in Mac.

 A sound file is either opened in an arrangement of its own, or it can be 
inserted into an existing arrangement.

If you want to work on a melody whose tempo you already know (e.g. you 
have recorded it with a defined tempo), first create a new arrangement 
using the menu item File -> New. You then set a defined tempo for the 
arrangement as described in the chapter “Tools to Define the Tempo of an 
Arrangement”. If you know the key in which the melody was recorded, you 
should also define the key of the arrangement prior to loading the melody 
(as described in the chapter “Defining the Tone Scale and Tuning”). Only 
when you have completed the above steps load the sound file into the 
arrangement using the menu item File -> Add Melody. If a tempo was set for 
the arrangement this tempo will be set in the detection process for all the 
melodies loaded into the arrangement.

If you want to detect and edit a melody whose tempo you do not know you 
should load it directly using the menu item File -> Open. This creates a new 
arrangement and Melodyne will attempt to detect the tempo of the melody 
and assign it to the arrangement. If the tempo was not well detected 
automatically, you can define it manually as described in the chapter “The 
Tool to Define the Tempo of an Arrangement”.

During the detection process Melodyne also attempts to detect the scale 
key based on the notes used in the melody. It then assigns the scale key to 
the arrangement as long as it is the first melody opened in the arrangement.

V2.6
p.167
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Importing Note Related or File Related

You can drag a sound file into Melodyne’s Arrangement or Editor Windows, 
either from the Finder(Mac)/Explorer(Windows) or, more comfortable, from 
the Melody Manager (see next section). The position where the content of 
the sound will be inserted in the arrangement can either be related to the 
start of the sound file, or to its musical content, the notes.

Importing file related means that the musical content of a sound file is not 
considered. If you drag a file to the start of bar 1, the sound file will start 
there, regardless if the melody it contains starts there or if there is silence 
in the beginning. This would be the “usual” behaviour that you may expect 
from other programs.

In Melodyne, you can also import a melody note related if it has been 
detected by Melodyne before. This means that the notes in the sound file 
know the musical beats they belong to, and will be inserted at their right 
musical locations. This also means that the tempo will be adapted 
automatically if necessary, also if there is an irregular tempo define in the 
arrangement.

When you drag a sound file over Melodyne’s windows, you will see a 
rectangle that shows where the sound file will go if you drop it, and you will 
also see if the insertion will happen with the file’s original tempo, or if a 
musical tempo adaptation will be performed. You can determine the 
positioning behaviour in several ways.

A sound file that has not been detected yet by Melodyne will always be 
inserted based on the start of the file itself. If the quantize pop up in the 
upper right corner of the arrangement window is set to a value other than 
“None”, the start of the sound file will snap to the positions specified.

For a sound file that is detected, you can specify with the quantize pop up 
if you want to insert it musically with position and tempo adaptation or at 
an arbitrary position with its original tempo. If the quantize pop up is set to 
a value other than “None”, the notes will snap to the beat positions relative 
to their original position. If you select “Bar” quantize, for example, the 
notes can only be inserted at the positions within a bar that they had in the 
original recording. If the quantize pop up is set to “None”, no beat related 
insertion and no tempo adaptation will be performed.
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If you need to insert a detected sound file with its start exactly at the 
arrangement’s zero point, you should not import it by drag’n’drop, but with 
the File -> Add Melody command from the menu.

Please note that you can drag detected sound files both into the 
Arrangement and Editor Windows, whereas undetected files can only be 
dragged into the Arrangement Window.

The Melody Manager

With the Melody Manager, you can browse through your sound file library 
very comfortably, and it is a very smart arranging tool as well. You see the 
musical content of your sound files, you can play the files, and you can even 
select parts of a sound file down to single notes and drag them into your 
arrangement where you need them.

We have prepared a demo library from Ueberschall, manufacturers of fine sampling CDs, 
that comes with a lot of different instrument melody samples, vocals, and drum loops, all 
readily detected for Melodyne. We recommend to install the library with the installer 
provided on the demo CD, so that Melody Manager finds it on launching, and it will be 
ready for you to play with it.

You open the Melody Manager with the menu item File -> Melody Manager... 
It is basically a file browser that is specialized on working with sound files. 
The left column is the “Favourites” shelf. In its upper part it shows all hard 
drives, volumes or CDs that are mounted on your system. To its lower part, 
you should drag all folders that contain your soundfile library. Clicking on 
one of them will show the folder in the right part of the window. If a root 
folder contains subdirectories, you can browse through them with the file 
hierarchy display. 
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If a folder contains any soundfiles, they will be displayed with a Play button 
that you can click to listen to the sound. But you can not only listen to the 
sound files, you can also view their content. You can drag the window wider 
and adjust the width of the last column to see as much of your sound files’ 
duration as possible. At the top of the Melody Manager window, with the 
second pop up from the right, you can select the view mode. You can either 
display 

the titles only

or the waveform

the notes

notes and waveform

or “waveform notes”

If a sound file is not detected, only the waveform will be displayed. In any 
view mode, you can see the play cursor indicating the current play position. 
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You can also select part of the melody with the mouse. If notes are 
displayed, your selection will always be aligned to note boundaries, and you 
will always hear exactly the selected notes. For easy arranging, you can drag 
your selected notes or the whole melody into a Melodyne arrangement, with 
or without tempo adaptation, as described in the previous section.

You can start and stop playback for the selected sound file either with the 
play button next to its name, or with a double click (stop with a single click) 
in the display. If you started playback with a double click, it starts at the 
location where you clicked. If you made a selection and double click into 
the selected region, the selection is played.

With the pop up next to the view mode pop up, you select the playback 
mode: “Plain” plays just the selected sound file. “Cycle” repeats the 
selected sound file - this is useful if you want to hear, for example, what a 
drumloop sounds like when it is played as a loop. With “Sequence”, you can 
hear all sound files in the current folder as a sequence - this is useful to 
explore the contents of a whole folder without having to start each single 
file. With the button next to the pop up you can adjust the playback volume.

At the top of the Melody Manager window, on the left hand side, there are 
two more controls: With the “Path” pop up you can go back in the file 
hierarchy. With the “Actions” pop up, you can execute some actions for the 
currently selected sound file: “Open in new Arrangement” will open the 
selected file in a separate arrangement (like the “Open” command from the 
main menu). With “Add to current Arrangement” you can insert the 
selected file at time zero on a new track in the current arrangement, without 
tempo adaptation, instead of dragging it into the arrangement window (like 
the “Add Melody” command from the main menu). With “Edit Melody 
Definition”, you can open the selected melody in the Definition Window 
directly to edit its definition if necessary. With “Update MDD File” you can 
cause Melodyne to write a new mdd file for the selected sound file, if the 
file was detected by an older version of Melodyne.

Please note: For fast display of the detected sound files’ content, the detection files 
(mdd’s) must be written by Melodyne version 2.5 or later. If Melody Manager finds older 
mdd’s while you navigate through your library, it brings up a panel to ask you if older 
mdd’s should always be updated automatically for faster display. This is recommended, 
but please note that you would not be able to use the new mdd files with older Melodyne 
versions any more. This panel is only shown once, but additionally to your decision in that 
panel, you can also change this decision in Preferences -> Other -> Auto-Update MDDs 
in Melody Manager.
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Working with Related Sound Files

If you want to work with several sound files that belong together because, 
for example, you recorded them together as one piece with a non-Melodyne 
program, you should export the sound files so that all the tracks start 
simultaneously.

For related sound files with a common start point you should always 
proceed as follows: First, generate a new empty arrangement with File -> 
New. Then add all sound files with File -> Add Melody. With Add Melody, all 
files will be inserted at the start of bar 1, resp. at time 0 sec.

If you would open the first sound file with File -> Open instead, Melodyne 
opens the sound file in a new arrangement and would try to find the tempo 
and its starting point for that arrangement, based on the sound file’s 
content. This new starting point may not be identical to the sound file’s 
start. Thus, sound files added later using File -> Add Melody will be inserted 
at the new start point and may not be aligned to the sound file that was 
opened first.

If the recorded piece has a regular tempo, and you know what that tempo 
is, the sound files should have been exported from the recording program 
with their common start at the downbeat of bar 1. You then create a new 
empty arrangement and define its tempo. After that, you add all sound files 
with “Add Melody” to insert them exactly at the zero point. Thus they will 
keep their common start.

On the other hand, you may not yet know the tempo of your recording, or 
the tempo may be irregular, and you want to identify it within Melodyne. In 
that case, you also create a new empty arrangement, but leave the tempo 
as given at 120 first, and import all sound files with “Add Melody”. All 
sound files must have been exported with a common start point here as 
well, but that start point would not necessarily be identical to the musical 
bar 1 downbeat. Now there are two ways to define the arrangement’s tempo:

1. If the tempo is well determined by a single track, for example a 
continuous percussion track, you first define the tempo for the melody on 
that track and then assign the defined tempo to the whole arrangement. In 
that case, you proceed as follows:
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■  Select the track with the best determined tempo. Start the detection 
process for this track and edit the detection, especially if the tempo is 
irregular, as described in the chapter “Detecting and Defining a Melody”.

■  After closing the Melody Definition Window, choose the tool labeled 
“Define Arrangement Tempo” in the Arrangement Window. Choose the 
item “Tempo from Melody” in the action menu entitled “Define Tempo”.

■   The course of the tempo defined for the melody will be assigned to the 
arrangement.

2. If the tempo is only determined by several tracks playing together, for 
example if some tracks are alternately more or less rhythmical, you define 
the tempo directly in the arrangement based on the respective tracks. In 
that case:

■   Define the tempo of the arrangement as described in the chapter “The 
Tool to Define the Tempo of an Arrangement”. You can do that with the 
undetected melodies, but you also can detect the melodies before in 
order to have their note separations checked and edited beforehand.

If you now detect the other undetected melodies after the arrangement’s 
tempo has been set, the arrangement’s tempo will be assigned to the 
definitions of the newly detected melodies automatically.

Those melodies had been detected before the tempo was defined now only 
know their tempo within this arrangement, but you should assign the valid 
tempo of the arrangement to their individual melody definitions as well. To 
do so, choose the selection tool in the arrangement window and execute the 
action “Apply Arrangement Properties...” from the action menu. With this 
action, the tempo definition (and tone scale) of that arrangement will be 
assigned to the definitions of all melodies present in the arrangement, and 
their .mdd files will be saved automatically with that setting.

You may also add a melody to a given arrangement that is not related to the 
tracks present in the arrangement and that has an independent tempo. 
Melodyne should have detected this melody previously in order to be able 
to adapt to the tempo of the arrangement. If Melodyne has not previously 
detected the melody you should open it in an independent arrangement 
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using the menu item File -> Open. There, you can detect it independently 
from the other arrangement. This temporary arrangement can be closed 
without saving (the detection data of the melody is saved independently of 
the arrangement). Now, add the melody to the desired arrangement using 
the menu item File -> Add Melody, or insert it into the appropriate location 
via drag’n’drop.

Alternatively, you can also load the undetected melody into the present 
arrangement. In that case, you must choose the “Own Tempo” option in the 
tempo definition radio button in the detection panel that appears when 
detecting a melody.

By using “Own Tempo” the tempo of the arrangement will not be assigned 
to the melody which is about to be detected. The detection then identifies 
the melody's tempo independently. On the basis of this process it is 
integrated later into the arrangement, and the tempo of the melody can be 
adapted to that of the entire arrangement automatically.

Saving Files

While working with Melodyne, you always edit a “Melodyne Arrangement”. 
The arrangement is represented by the contents of the Arrangement 
Window. It consists of single melodies you have edited, or melodies you 
added to the arrangement without editing. If you choose the menu item File 
-> Save this arrangement is saved.

Please note that the sound files themselves are not saved within the arrangement file: 
Melodyne assumes that the sound files remain at the same location as they were when 
the arrangement was saved. The arrangement can only be re-opened if this is the case. 
If Melodyne is unable to find the sound files when an arrangement is 
opened, a File Choice Panel is opened. There, you can enter where the 
sound files are located. If you copy the arrangement to a different 
computer, you must also copy the sound files along with it!
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Melodyne always creates an “.mdd” file when it detects a new sound file 
and stores the “.mmd” file in the same folder containing the detected 
sound file. The “.mdd” file is saved automatically. The “.mdd” file is also 
required if you want to re-use a melody in other arrangements without 
having to redetect it. Melodyne also assumes the presence of the “.mdd” 
file when opening an arrangement. 

Never delete an .mdd file if you are still using its respective sound file in an arrangement. 
If you copy a sound file to another computer you must also copy the “.mdd” file!

You can open an individual sound file in an arrangement, detect it, and 
correct the result if necessary without changing its content musically. This 
allows you to re-use a sound file in any other arrangement and to furnish 
your Melodyne library with detected and universally applicable melodies. If 
you created an arrangement only to detect new melodies, it is not necessary 
to save the arrangement before closing it. The data concerning the original 
musical content of its sound files were automatically saved in their 
respective “.mdd” files.

However, if you have edited a melody by changing the intonation of a piece 
or selecting only a part of a larger melody as a single melody, you must save 
the arrangement containing this single melody. Otherwise, the result of your 
work will not be saved, as changes to the original melody will not be saved 
in the “.mdd”- file. If you want to use this edited melody in another 
arrangement later on, you open its arrangement and insert it in the desired 
target arrangement using the copy and paste functions. Alternatively, you 
could also export the edited melody or parts of it, as described in the next 
section. If you export each track as a single audio file, you have the option 
to “Write MDDs”. With this option, the detection data of the edited melody 
will be written along with the audio file, so that you can work with the 
melody immediately without having to detect it over again.

Exporting Files

The menu item File -> Export... does not save an arrangement as a Melodyne 
arrangement, but rather saves the arrangement in a variety of different 
formats.
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Here, you can 

■   save the entire arrangement as a finished stereo mix. It will be saved as 
a sound file that contains the arrangement exactly as you hear it. (“post 
mixer”).

■   save the entire arrangement or selected tracks as sound files (“pre 
mixer”) for use in other programs. If a track is defined as a stereo track 
in the mixer window, the corresponding soundfile will be saved as a 
stereo file, otherwise as mono.

■   save the entire arrangement or selected tracks as standard MIDI files.

In the first pop-up menu of the top line of the “Export” panel you can 
choose whether you want to save the file in an Audio or MIDI format. If you 
want to save it as an audio format, you can define in the other pop-up 
menus of the line, which audio format, sampling rate and resolution you 
want to use. 

In the second line you can specify which time segment of the arrangement 
you want to export: 

■   If you choose the “Entire Arrangement” option, the entire time region 
from the first sounding note to the end will be saved.

■   If you choose the “Between Locators” option, the time region between 
the locators you have set will be saved. 

V2.6
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■  If you choose the “As Reference Track” option, you can set a track as a 
reference in the next pop up. All segments of all active tracks will be 
exported with the exact duration that the sound file of the reference track 
has in its original. This is useful if you imported a melody from another 
program to edit it with Melodyne. When you want to re-export it to re-
insert it with its original duration, this option is best. 

■  If you choose the “From Start of Reference Track until End of 
Arrangement” option, the start time will chosen in the same way as in 
the “As Reference Track” option. However, Melodyne will save the file 
up to the end of any sound in the arrangement.

■   If you choose the “Individual Range for Each Track” option, each track 
will be exported with its own start and duration. This is especially useful 
if you are using Melodyne as a sample editor, having multiple soundfiles 
in one arrangement that are not related to each other in time.

■   If you choose the “Individual Sound File for each Marker Region” option, 
your defined marker regions will be exported as single sound files (see 
“Navigation with Markers”). This is especially useful if you have a long 
recording on one track that you want export being split up into individual 
regions. On exporting, the names of the markers will be used to name the 
single sound files. This option is only available if a single track is 
selected for export.

In the next line, you can specify whether you want to save the active tracks 
into a single file, or whether you want to create a single file for each track. 
If you choose the audio format, with “Stereo Mix” Melodyne will save the 
arrangement as a stereo sound file as you hear it. It will contain all the 
amplitude, panorama and effect settings that were specified in the mixer. 
If you choose the “Save each track as a single file” option, each active track 
will be saved as a sound file. If a track is defined as a stereo track in the 
mixer window, the corresponding sound file will be saved as a stereo file, 
otherwise as a mono file. With the single file option, each track will be 
exported with its tracks settings, like gain, EQs, and insert effects, but not 
master section related settings like aux effects.

If you choose the “Save each track as a single file” option, you will also see 
the option “Write MDDs”. With this option active, the detection data of 
each edited melody will be written along with the exported audio file, so 
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that you can work with the new exported melody immediately without 
having to detect it over again.

If you have Group Tracks or ReWire Tracks in the arrangement, these will 
be exported as well. In the case of ReWire Tracks, export will be performed 
in real time.

If you choose the MIDI option, you can decide if you want to save the tracks 
either as a multichannel MIDI file or save each track individually in single 
track MIDI files. 

In MIDI export, you can determine desired velocity mappings, and the 
export options of pitch bend and envelope data for each track individually. 
These options have to be specified before exporting with the “Send MIDI” 
tool as described in the MIDI section. To export MIDI with these settings, 
you select the option “As Specified in Tracks”. If you want to use the MIDI 
file for notation purposes, you select the option “Quantized for Notation”.

In the bottom of the panel, you can choose which tracks shall be included 
in the export. At first, all tracks are selected that are active in the 
arrangement and not muted. However, you can change the export selection 
as you please. 

If you have chosen the option to save as single files, you can specify a folder 
into which the files are saved after confirming the “Export” command. The 
single files are automatically named after the tracks they were saved from 
in the arrangement. In the case of a single file, you name it yourself as 
usual.

If clipping has occurred during audio export, Melodyne will report this, and 
will offer you to set the appropriate amplitude values in the mixer 
automatically, so that you can repeat the export without clipping.
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The Start/ Stop Functions

The Start/ Stop Functions are operated:

using the Start / Stop buttons in the Transport Bar (if it is not visible when 
starting Melodyne you can make it appear using the menu item Window -> 
Transport Bar).

using the “Enter” key of the numerical keypad of the computer keyboard for 
“Start” and the “0” key of the numerical keypad for “Stop”. The “Space” 
bar on the keyboard performs “Start” and “Stop” alternately, if there are no 
notes selected. If notes are selected when the space bar is pressed, the 
selection range will  play. This provides a quick audit of just the notes being 
edited.

by double clicking in the upper light gray part of the time ruler for “Start” 
and by a single click in the time ruler for “Stop”.

A further playback option is to use the “Play Note” tool, which is always the 
last subtool of the tools operated with the mouse. If you click on a note with 
this tool only the selected note will be heard. If you drag a selection 
rectangle over several notes, all notes will be played which are touched by 
the selection rectangle. You can switch between this playback tool and the 
currently active editing tool quickly with function key F12.

You can play the original sound for comparison with your edited version 
using the letter “o” key of your keyboard. This key has the same alternating 
start, stop behavior as the “Space” bar described above.

Another Melodyne specific playback option is the scrub mode tool. If you 
choose this tool you can click anywhere in the arrangement and listen to the 
“local sound” by keeping the mouse button depressed. Dragging the mouse 
a little will result in playing the music at a speed proportional to the mouse 
speed and with its original pitch independently of the speed of play. This is 
rather handy if you, for example, want to check a harmony at a specific 
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place in the melody or if you want to listen to the exact course of pitch 
independently of the actual tempo.

You can find the scrub tool for listening to the entire arrangement and the 
scrub solo tool for listening to the selected melody in the Arrangement 
Window.

In the Editor Window, the “Play Mode” pop up menu specifies whether one 
listens to the edited melody, all melodies currently present in the Editor 
Window, or the entire arrangement with the scrub tool. 

When operating the buttons for fast forward or rewind, you will hear the 
music faster, but in its original pitch, just as in the scrub mode.

On recording or playback you can activate the metronome with the “Click” 
switch in the Transport Bar. You can also adjust the click level with the 
volume control next to that switch.

Setting the Play Position

You can set the play position by clicking in the main area in the 
Arrangement Window or Editor Window. The same is true for the time ruler 
or the score notation display if it is visible.

If you click in a track where a melody is located, the play position always 
snaps to the start of a note. If one or more notes are selected, the play 
position always snaps to the start of the first selected note.

If the stop button in the transport bar or the “0” key in the numerical 
keypad is used, the play position is always set to the start of the note closest 
to the stopping position. Pressing the stop button a second time sets the 
play position to the start of the current locator position, a third time sets it 
to the beginning of the arrangement. Playback with the “Play Note” mouse 
tool does not affect either the selection or the play position.

The play position can also be set in the position field of the transport bar.

The play position is also the position where pasted notes will be inserted.
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The Locators and the Cycle Function

The time ruler in the upper part of the window is divided into an upper light 
gray and a lower darker region. The Start/ Stop function of the time ruler is 
executed by clicking in its upper part. The lower part serves to set and 
display the locators. The locators are a pair of markers that display the start 
and end of a region. They are labeled “L” and “R”.

The locators are used to set a region that is repeated if the cycle function 
is active and to set a recording region, particularly when punch in/ out 
recording is used.

You set the locators 

■  by grabbing and dragging them directly, 

■   by setting their start and end position by dragging the mouse in the 
locator region of the time ruler, 

■   by setting the left locator by clicking in the locator region in the time 
ruler with the “Alt” key pressed and the right locator with the  “ ” key 
pressed in Mac, in Windows left with “Ctrl”, right with “Alt”, or

■  by entering their position in the text fields in the transport bar, or

■   by selecting a few notes and then double clicking the locator region of 
the time ruler. The locators will then be set exactly to the start and end 
of the selected notes. This is especially handy when replacing specific 
notes with punch in/ out recordings. 

The quantize size selected in a window determines if the locators can be 
moved to any position, or if they will snap to the selected quantize size.

You activate the cycle function by clicking on the cycle switch in the 
transport bar.
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Navigation with Markers

You can generate pairs of markers that allow you to easily jump to defined 
regions. You will find the marker functionality under the menu item 
“Navigation” in the main menu. 

If you execute the first command “Create Marker” the current position of the 
locators is used to generate a new pair of markers. In the time ruler a text 
field will appear where you can enter a name for the new marker. The names 
of all created markers will stay visible in the time ruler. Once a marker is 
created you can use it for the other actions in the menu:

■   Scroll to...: The current play position will be set to the start of the marker 
region and will be scrolled into the visible area if that position is currently 
not visible. Additionally, the current locators will be set to that region, 
thus that region becomes the cycle region as well if a cycle is active.

■   Zoom to...: Is similar to “Scroll to...”, but in addition the marker region is 
scaled to fit into the visible area of the window.

■   Delete Marker...: Deletes the chosen pair of markers. Once a pair 
of markers is defined, their start and end positions cannot be moved, but 
you can easily change them by setting the current locators to the marker 
positions with “Scroll to...”, delete the marker, move a locator and 
generate a new pair of markers.

You can also assign various keyboard shortcuts for jumping to defined 
markers, see “Shortcuts” in Preferences. The marker regions can also be 
used to split up a single track into into separate sound files while exporting, 
as described in “Exporting Files”

Navigation and Zoom with the Navigation Tool

With the Navigation Tool, you can easily move the window’s content as well 
as zoom in or out. The Navigation Tool is the first subtool of the Select Tool 
in any window.

If that tool is displayed as a hand, you can simply grab the window's content 
and move it directly in horizontal and vertical direction.
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 You can switch that tool to act as a Zoom Tool, either by double clicking 
and holding the mouse down on the second click, or by pressing the “Alt” 
key (“Ctrl” in Windows) before or while moving. As you drag the mouse, you 
will zoom in or out in horizontal and/or vertical direction. 

You can assign a keyboard shortcut for switching quickly between the 
current edit tool and the Navigation Tool. (Default is “5” on the numerical 
keypad)

The View Options and Time Display Format

Under the menu item “View” in the main menu you can define some 
options on how your arrangement should be displayed.

■   With the “Autoscrolling” option, you determine whether the visible region 
of your arrangement should follow the play cursor. If autocrolling should 
generally happen continuously or page per page is determined in 
“Preferences -> Appearance”.

■  With the options “Always show Pitch Curve” and “Always show Note 
Separations” you can determine if these display elements will also be 
shown if no tool for editing the pitch or note separation is selected.

■   With the “Time Display” submenu you can determine if the time of the 
arrangement is displayed in musical bars and beats, or in seconds. The 
grid of the arrangement background and the position display in the 
transport bar will change accordingly. If you select a tool that only makes 
sense in a context of musical beats , like the tempo tools or the tool for 
quantizing, the view will change to the bars and beats background 
automatically, but the time display in the transport bar will stay in the 
selected mode. If seconds or SMPTE display is selected, all quantizing 
will be disabled. The SMPTE display is nearly the same as the seconds 
display, except that the fractional part of seconds ist shown as frames or 
decimals respectively.

■   With the “SMPTE Type” submenu you can determine the frame rate to 
be used for SMPTE time code (24, 25, 29.97 drop, 30). This selection 
applies to the display format in the transport bar as well as to the frame 
rate that Melodyne sends out via MIDI if it is defined to be a MIDI Time 
Code master.

V2.6
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The Functions of the Track Bar

The track bar is located at the left side of the Arrangement Window. It 
displays each track as a rectangle containing some controls:

■   A track can be selected by clicking on a track rectangle in the track bar. 
It will then be displayed with a frame. Tracks that contain a melody can 
be selected by clicking on the melody. Empty tracks can only be selected 
by clicking on the track bar.

■   Clicking in the track bar of an already selected track will select all notes 
of the melody in that track.

■   By double clicking in the track bar the melody on that track will be 
opened in the Editor Window.

■   You can change the height of a track display by dragging the separation 
lines between tracks. This serves the same function as a vertical zoom of 
a single track.

■  By clicking in the rectangle of a track and dragging it up or down, the 
tracks can be resorted. 

■   By clicking on the name of a track you can rename it - a track is at first 
assigned the name of its sound file.

■  By clicking the mute switch a track is muted.

■  By clicking the solo switch you can hear a track on its own. If you click 
this switch while keeping the “Shift” key pressed, you can also set more 
than one track to solo, so that you don't have to mute all other tracks if 
you want to hear two tracks together.

■  By clicking the record switch you activate recording for the track. 
Recording can be activated or deactivated for single tracks while 
recording, which provides punch in/out on the fly.

Name of the Track

Activate a track for recording (Record-Switch)

Make a track play solo (Solo-Switch)

Mute a track (Mute-Switch)
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Recording with Melodyne

You can record on a single track, or on multiple tracks in an arrangement. 
How many tracks are available for simultaneous recording depends on the 
chosen driver and the selected input channel count. Melodyne supports 
recording only if you are using ASIO, DirectIO or CoreAudio drivers, DirectX 
and SoundManager can only be used for playback. Both driver and channel 
count can be set in Melodyne’s hardware preferences. The file format for 
saving your recording to disk can be specified in the recording preferences. 
(See the “Preferences” chapter.)

If you record within an arrangement that has been saved before, e.g. under 
the name “MySong”, the audio files will be saved into a folder named 
“MySong Audio” that Melodyne automatically generates next to the 
arrangement. 

If you record within an arrangement that has not yet been saved, the audio 
files will be saved into a default folder that can be specified in the 
“Preferences->Recording”. As soon as you save your arrangement, 
Melodyne generates the audio folder for that arrangement and move the 
recorded files there.

You record as follows: 

■  Activate a track for recording by clicking the record button in the track 
bar of the Arrangement Window or with the record button for the track in 
the Mixer Window. 

■   Click on the recording button in the transport bar. In order to record, the 
record buttons in the respective track bars as well as in the transport bar 
have both to be activated.

■  If the Mixer Window is open, you will now see the input level of the 
recording tracks displayed in the level meters. The input gain has to be 
adjusted with your external mixer or with your microphone preamp.

■  If the option “Rec Monitor” is active in the mixer, you will hear the 
incoming signal with all effects active in the signal chain (with a latency 
that depends on the buffer size set in the “Preferences”).
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■   Previously recorded tracks are audible during recording. You can activate 
the metronome click with the “Click” switch in the Transport Bar.

■  Start the recording with “Play”. After the recording is completed, the 
recorded melodies show up in their tracks. You can detect them in 
Melodyne by double clicking them. This procedure is explained in detail 
in the chapter about Detecting and Defining a Melody.

You can also activate or deactivate recording on the fly at any time during 
playback, either by activating the record button in the transport bar to 
record on all tracks that are prepared for recording, or by activating single 
tracks with their individual record buttons if the record button in the 
transport bar is active.

You can also use automatic punch in/out. For that purpose, the current 
locator positions determine the punch in or out positions. You can activate 
punch in and punch out separately in the transport bar. If you only select 
“Punch In”, recording will start at the left locator position and will continue 
until the transport is stopped. If you only select “Punch out”, recording will 
start at the current play position and will stop at the right locator position, 
even if the transport is still running. If you select both “Punch In” and 
“Punch Out”, the recording region will be determined by both locator 
positions.

With Melodyne you can perform punch in/out recordings very comfortably 
to replace single notes or whole melody segments by a new recording. As 
Melodyne knows the start of any note, notes can be replaced exactly. To 
execute this type of punch in/out recording:

■  Select the notes on the track you want to replace. 

■  Double click in the locator region of the time ruler. That places the 
locators automatically to the start and end of the selected notes. 

■   Activate the “Punch In” and “Punch Out” switches in the Transport Bar.

■  Then, execute the recording procedure as described above. 
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The singer or instrument player does not have to be overly careful to attack 
exactly in sync with the first note of the notes to be replaced because 
“internally” the recording begins a little early. If the note is played a little 
early, the decay of the previous note is shortened a little, if necessary. (in 
Melodyne, that does not however mean that it is “cut off”!) The same is the 
case for the end of the recording: if the last recorded note spills over the 
right locator, it will automatically be inserted such that it is completely 
audible. Yet, the attack of the next note is not delayed. Thus, the punch in/
out recording works similar to the editing of a melody with the copy and 
paste functions described below.

Re-arranging Melodies with Copy and Paste

You can select individual notes with your mouse. You can select the entire 
melody with the “Select All” function ( /Ctrl - A). The selected notes or 
melodies can be removed with “Cut” ( /Ctrl - X), or they can be stored in 
the copy memory with “Copy” ( /Ctrl - C). 

You can create a polyphonic arrangement from a single melody. To do this, 
you copy a melody, select a free track, and insert the copied melody parallel 
to its original with “Paste” ( /Ctrl - V). Or you can re-arrange the melody 
within its track by copying and pasting notes. 

Besides the usual “Select All” function, there are several other functions in 
Melodyne that serve to select more than one note. You can find them in the 
Edit menu: Edit - > Select.

■  “Select all” selects all notes of the current melody. In the Arrangement 
Window, you can also select all of a melody's notes by clicking the 
melody's track bar.

■  “Select following Notes” selects all notes from the currently selected note 
to the last note of the melody. This is useful for inserting melody 
segments in the middle of an existing melody. 

■  “Select same Notes” selects all notes that have been assigned the same 
semitone as the selected note. This is useful if you want to move all equal 
notes of a semitone to a different semitone together. 
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■  “Select same Notes in all Octaves” works in a similar way, however, it 
selects the same notes irrespective of their octave positions.

■  “Select same Beats” selects all notes in the melody that are on the same 
beat as the selected note. This is useful if you want to change the rhythm 
in a percussive track, e.g. by dragging all notes on the first beat a bit 
earlier in time. You can also select a pattern of notes within a beat with 
“Shift-Click”. If you execute “Select same beats” then, the same pattern 
will be selected in all bars.

■  “Select Notes between Locators” selects all notes beween the current left 
and right locator position. Inversely, you can select some notes and 
double click the lower part of the time ruler to set the locator region to 
enclose the selected notes.

■  “Invert Note Selection” selects all notes that are currently unselected and 
vice versa.

While the “Select All” function is assigned to the “ /Ctrl - A” command 
by default, you can assign the other selection functions to your own 
keyboard shortcuts as described in the “Preferences” chapter.

Copying and pasting notes or melodies with the “Paste” function ( /Ctrl- 
V) is slightly different from what you are used to from other audio programs. 
For Melodyne, a “Note” is much more than a simple segment of the audio 
material: a note literally is a “note”. Musically speaking, a Melodyne note 
knows its own pitch and rhythmical position in the melody.

Therefore it is possible to copy single notes or entire melodies from any 
arrangement and insert them into another arrangement. If the arrangement 
in which you insert the notes has a different tempo than the original, they 
will be inserted in a musically sensible way. The same is true if you want to 
insert notes in the same arrangement from a passage with a different 
tempo. Thus, you can copy and paste notes in an arrangement that was 
recorded with a free tempo. You could copy a voice from the first verse to 
the last verse even if the tempos were different. In any case, Melodyne must 
have previously detected the source and target melodies. If necessary, you 
must also manually define any irregular tempos.
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The way in which the inserted notes adapt rhythmically depends on the 
setting in the quantize menu of the current working window. If “Bar” is 
selected, the inserted notes will be set to the same position in the bar they 
had in the melody they were copied from. In this case, it is not important 
to accurately set the insertion position. It simply has to be set to the desired 
bar. If however “1/4” is chosen, the position of insertion is set to the closest 
quarter note relative to where the note will begin. The notes will of course 
re-adapt to the tempo from that quarter note on. 

If you work with material that is not meant to be musically rhythmical such 
as with spoken language, you would choose “None” in the quantize menu 
to prevent the inserted material from being adapted to a rhythm.

If you add a previously detected melody to an arrangement with a defined 
tempo using “File -> Add Melody”, the added melody will not automatically 
adapt to the tempo of the arrangement. If you want to adapt it choose the 
tool “Edit Track Time” in the Arrangement Window. In the action menu 
“Edit timing”, choose the action “Adapt time”. Then, the added melody will 
be adapted as if it were inserted by copy and paste with quantizing active. 
If the tempo of the arrangement and that of the added melody are very 
different, you might prefer to have the inserted melody changed to half or 
double its adapted tempo. You do this with the corresponding actions of the 
action menu.

You can insert notes wherever there is sufficient space for them - for 
example, where there is a rest in the melody. If you want to insert notes into 
a continuous melody, you must cut the melody between two notes as 
described in the chapter on the “Tool to Change Note Separations”. This 
will give you two separated melody segments that can be moved 
independently of each other. In most cases, it would be preferable to move 
the trailing segment by one or more bars. In this case choose “Bar Quant” 
in the quantize menu. Select the first note of the segment you want to move 
and choose Edit - > Select -> “Select following Notes” in the menu. You will 
then be able to move the following notes so they snap to the next bar and 
the desired notes can be inserted.

It is not important that the note you want to insert fits exactly into a rest. If 
the note is a little too long, it will automatically shortened so that the 
inserted note ends before the attack of the next note. The same is true if 
you replace notes. If you want to substitute a badly played note, simply 
choose a similar note to the one you would want to have at that point. Copy 
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it. Select the note you want to replace and replace it with “Paste” ( /Ctrl 
- V). It is not necessary that the notes are both exactly of the same length - 
the inserted note will be adapted to the available space. 

As there is more than one way to paste or replace notes in Melodyne, the 
different “Paste” options are grouped in the submenu Edit - > Paste.

A special way of inserting notes is the action “Paste Pitches” in the “Edit” 
menu. Imagine that you have edited a piece with several verses by copying 
a voice and arranging harmony voicings for the first verse. Now, you want 
this same arrangement for the other verses. You would not want to paste the 
text and tonal content of the harmony voicings of the first verse over the 
other verses. You only want to copy the notation of first verse arrangement 
and apply it to the other verses. To do this, you use the function “Paste 
Pitches”. Do the following: 

■  Go to the first verse and select the track you want to transfer.

■   Select the notes whose pitch you want to copy. Copy these notes with 
“ /Ctrl - C” in the same way you would do for copying and pasting.

■   Go to the next verse and select all notes to which you want to transfer the 
pitches. 

■   Now choose Edit -> Paste Pitches and the selected notes will be moved to 
the pitch of the copied notes. 

The function “Paste Pitches” always works in the rhythmical context of its 
bars. This means that the notes that are at the same beat as the ones copied 
will be moved to the pitches of the notes on that beat. If the beat of the 
source and the target do not match exactly, then the notes that overlap the 
most with the source position will be pitched accordingly. If there are, for 
example, several short notes of different pitch in the target region, where 
the source only has one note, all notes will be set to the same pitch of the 
long source note. You might have to reset the short notes to different 
pitches manually if you want to maintain a given ornamentation in the new 
pitch position.

Another paste option is “Replace Keeping Target Pitches”. This one is 
somewhat complementary to the previously descibed: While “Paste 
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Pitches” keeps the sound content of the selected target notes and just 
transfers the pitch of the copied notes to them, “Replace Keeping Target 
Pitches” replaces the selected notes with the copied ones, and at the same 
time sets the pasted notes to the pitches that the replaced ones had before. 
Thus, if you want to substitute a badly played note with a similar one that 
has a different pitch, you would choose the “Replace Keeping Target 
Pitches” option.

In the “Paste” submenu, there are two other options to copy and paste 
notes: “Copy and Paste Selection to Parallel Track” and “Cut and Paste 
Selection to Parallel Track”. These actions perform copy and paste at the 
same time and serve to create a copy of the selected notes and put them 
on another track quickly, while keeping their exact time position. The 
“Cut...” variant can be used to transfer a selection of notes to another track. 
In a drum loop, for example, you could select all notes of the bass drum and 
cut and transfer them this way to treat them differently on a second track. 
In the Arrangement Window, you can also perform these actions by dragging 
a selection upward or downward with the mouse. The simple drag action will 
perform the “Cut...” variant, dragging with the “Alt”-key in Mac /“Ctrl”-key 
in Windows pressed performs the “Copy...” variant.

The Play Algorithms in Melodyne

Melodyne's recently developed, proprietary sound synthesis technique 
“Local Sound Synthesis” allows editing of pitch and time as entirely 
independent parameters. So it is possible to stop a sound at any place in 
time and continue to listen to it at its original pitch without artifacts. Or you 
can playback the original sound with varying speeds. This allows you to 
maintain the attack characteristics of a note when it is moved in time, and 
to modify the duration of the note by contracting or expanding the note in 
a region of the note where it's tonality is more stable. Melodyne offers you 
several variants of this synthesis technique with different parameters that 
are suited for several different purposes. The synthesis-algorithm 
parameters selection function is done with a tool from its own inspector bar.

  When you select the Play Algorithm Tool (the second subtool of the Select 
Tool in any window), you get the inspector bar for selecting the play 
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algorithm parameters. If you click on a note with the Play Algorithm Tool, 
all notes that belong to the same segment on the selected track will be 
selected. The displayed play algorithm parameters in the inspector bar 
apply to all notes in the selected segment.

The parameters are represented by radio buttons and sliders. They can be 
thought of as hierarchical from left to right:

■  Plain Playback or Processed Playback: 
This determines if Melodyne processes the sound at all or if it is simply 
played back. If a melody is not detected, this parameter will be Plain 
Playback by default and will switch to Processed Playback automatically 
after detection. If you want only a few notes to be processed and the rest of 
the recording to be played as original, you can setup different segments for 
the track as described in the next section. If Plain Playback is selected, 
there is still a modification of the sound depending on the next parameter. 
If the next parameter is set to Original, the sound will be played exactly as 
the original recording once a segment is started, regardless of the tempo. If 
it is Sampler, the sound will be played with the pitch higher or lower 
depending on the arrangement tempo - just like faster or slower playback of 
a tape. The Sampler algorithm also reflects pitch changes due to irregular 
tempo course within individual notes. That can be achieved with the tool to 
“Change Initial Speed of a Note” (see Editor Tools chapter) and can be used 
for interesing effects especially on percussive material.

■  Note Based or Time Based: 
In the Note Based mode, each note is treated as a separate entity, and its 
attack is always kept as the original. In the Time Based mode, time is 
running continuously without special treatment of the single notes, except 
that the continuous  time may run faster or slower near a note's start. The 
Note Based mode is more suitable for percussive or plucked sounds with a 
clear attack and decay. In this mode, formants cannot be corrected or 
influenced in any way. The Time Based mode is more flexible especially in 
terms of influencing the sound and formants, and will work better for 
material where there are transitions between the notes. 

After a new detection of a melody, Melodyne selects the Note Based mode 
for material that has been classified as unpitched or percussive for 
detection, and selects the Time Based mode as the default for pitched 
material.
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Note Based and Time Based modes have different controls in the inspector 
bar. This one is for the Note Based mode:

In the Note Based mode, there is a fundamental difference in the type of 
processing applied depending if the recording is either played slower (or 
higher in pitch), or played faster (or lower in pitch). In the first case, there 
is less original sound duration available for each note than would be needed 
until the next note start. Thus, part of the note will have to be stretched to 
sound longer than it originally does. In the second case, there is more 
original sound duration available than needed before the next note starts.

The first two sliders labeled “Stretch Pos” and “Stretch Shape” affect the 
first case only, where notes have to be stretched. The “Stretch Pos” slider 
determines at what point in each note stretching will start: If the slider is 
set to center position, the note will be played as its original up to the middle 
of the note and will start stretching afterwards. Equally, stretching will be 
performed right from the start if the slider is set to the left, and only the 
very last part of the note will be stretched if the slider is set to its rightmost 
position. The “Stretch Shape” slider determines the transition between the 
unstretched and the stretched part. With the rightmost position of the slider 
set, there will be a sudden change in speed at the position determined by 
the first slider, and the speed will be constant from that point on. Moving 
the slider to the left will result in a more smooth transition in speed. With 
the slider in its leftmost position there will be no stretching at all, which 
results in silence from the note end to the next note start. Generally, just 
play around with the stretch sliders to achieve the result you like best.

In the second case, where there is more sound material available than 
needed until the start of the next note, the first two sliders don't affect the 
sound at all. Instead, you can determine with the “Overlap” slider if a note 
will stop sounding as soon as the next one starts, or if and how long it will 
continue to sound into the next note. The available duration in that case will 
still be dependent on how much faster or lower in pitch the recording is 
played.

The “Decay” slider works for both cases and simply applies a decay 
envelope to each note. The notes will keep their original decay with the 
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slider in its rightmost position and will decay faster if the slider is moved to 
the left.

In the Time Based mode, you have different parameters to control sound 
behaviour:

■  Crisp Algorithm or Smooth Algorithm:
These are two different internal sound processing methods called “Crisp” 
and “Smooth”. For most cases, the “Crisp” one will be better as it gives 
more presence and fidelity, and additionally it is faster and thus lets you 
play back more tracks. But there may be cases where the “Smooth” one 
sounds better. This may be the case if you play a sound very slowly or 
stretch it to be very long, or if there are very sudden changes or crackles in 
a sound, that may be emphasized with the “Crisp” algorithm and softened 
with the “Smooth” algorithm. In case of doubt, just test it. Switching 
between these algorithms will never result in a big sound effect as long as 
the other parameters are not changed, so you can just decide which one is 
better for your material. By default, the “Crisp” algorithm will be selected.

■  Formant Correction, 0% - 100%:
If notes are changed in pitch, this parameter determines if the overall 
spectral content of the changed notes is adapted and kept in the original 
position (Formant Correction of 100%), or if the spectral content is 
transposed together with the pitch (Formant Correction of 0%). A Formant 
Correction of 100% is the default. If no notes are changed in pitch, this 
parameter would not affect the sound in any way. A Formant Correction of 
0% gives the same effect as if you would move the formant bars by the 
amount you moved a note in pitch. Nevertheless, with a Formant Correction 
of 0% the formant bars will appear right over the note as if they are 
unchanged, and can still be altered.

■  Formant Style, 0% - 100%:
This determines another aspect of formant behavior for notes that are 
moved in pitch or changed in formant position. Again, if no notes are 
changed in pitch, this parameter would not affect the sound in any way, and 
it will be barely audible in the case of small pitch changes. The default 
setting is 100 %, as this gives the best results in most cases. On more 
extreme pitch shifting of notes, the formant change will be more “lively”, 
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but not as “linear” as with this parameter set to 0%. Although a value of 
100% will sound better in most cases, you should be aware of a special 
unwanted property of that setting. On transposition exactly one octave 
downward, the recording will sound one octave higher (i.e. just like the 
original), and you may have to move the formant position a bit downward as 
well or change the Formant Style to a value different from 100%. So, to get 
the optimum result you may want to experiment with this parameter. 
Additionally, there is the option to change this parameter on a per note 
basis, if desired, as described with the Edit Window tools, see Edit Formant 
Shift Style Tool.

■  Period, 1 - 6:
The default value of this parameter is “1”. All other values cause the 
algorithm to behave as if the recording had been detected with a pitch 
period that is 2, 3, 4... times as long as the actually detected one, i.e. one 
octave, duodecime etc. lower. This can improve playback quality for very 
high pitched flutes, strings, etc., especially if there are traces of a sub-
octave in the sound. Just try this parameter in case of problematic material 
of that kind.

If this parameter is used, the appropriate value will be “2” in most cases - 
the higher values can be used for effects. If you intend to apply pitch 
corrections or pitch changes, no formant correction or formant change 
should be made, i.e. the “Formant Corr.” slider should be set to its leftmost 
position. Formant changes with a “Period” value other than “1” can be 
used to achieve interesting effects, but they are not expected to sound 
“natural”. If only tempo or timing changes are intended, the position of the 
“Formant Corr.” slider doesn’t matter for changed “Period” values.

With the Melodyne studio edition, you can apply each of these algorithms to 
melodies from mono or stereo sound files.

With the Melodyne cre8 version, you can playback stereo files with the 
“Plain Playback” mode only, for example to listen to a reference track in 
stereo. If you switch to a different algorithm in Melodyne cre8, the program 
will only playback and process the left channel of a melody from a stereo 
sound file. 

On exporting sound files, Melodyne applies a special sound processing 
mode for further sound improvement. This mode requires some more 
processing power. If you want to use this processing mode on usual 
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playback as well, you can activate the option “Always use maximum 
processing quality” under Preferences -> Other. Don’t activate this option 
if you are working with an arrangement with a lot of tracks, or if you use 
many plug in effects.

Playback with Different Algorithms Within the 
Same Track

You can use different play algorithm settings within one track. If you want 
only a few notes to be processed and the rest of the recording to be played 
as original, you can setup different segments for that track. To do so, choose 
the Segment Separation Tool in the Editor Window and double click a note 
separation. The melody is thus split into separate segments for which 
different play algorithms can be chosen. It is not appropriate to insert a 
segment separation in a continuously sounding note, as this separation may 
be audible. If a melody is composed of a lot of copied and pasted notes, 
there will be a lot of separate segments. To assign a play algorithm to all of 
them you will have to select them using the selection rectangle or with 
“Select all”.

Temporary Change of Play Parameters

You can change the pitch, the formant position, and the tempo of an entire 
arrangement globally. This can be useful if you want to transpose the entire 
arrangement to a different key, or if you simply want to know how it would 
sound at a different tempo. For that purpose, open this panel using the 
menu Window -> Temporary Play Offsets:

Here, it is possible - even while the music is playing - to quickly change the 
displayed values. Of course, the changes in pitch and time are independent 
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of each other. By clicking the text fields and dragging the mouse up or 
down, you can change the values continuously. By entering a value in the 
text fields you can choose the values more specifically. The values for pitch 
and formant position are displayed in cents in their respective text fields. 
100 cents are equal to a tempered semitone - if you enter “700” into the 
pitch text field, the entire arrangement is transposed up by a fifth. “-400” 
will transpose it downwards by a third. The value 0 in the formant text field 
always corresponds to the corrected formant position. Matching changes in 
the formant and pitch value will sound as if the arrangement were 
transposed by the respective value without formant correction. For example, 
if you enter the value “400” in both the pitch and formant position text 
fields, the sound you hear will be that of an arrangement transposed by a 
third without correction of the formant position. 

The tempo displayed in the tempo text field is its default position and is 
identical with the tempo of the arrangement, as it is displayed in the time 
ruler of the Arrangement Window. If several tempo definitions are set for an 
arrangement with an irregular tempo the tempo field will always display the 
tempo of the first bar. If the tempo is changed using the temporary playback 
settings, the tempo will be changed proportionally for all set tempo 
definitions. Yet, only the tempo corresponding to the first tempo definition 
is displayed. 

Pressing the “Reset” - buttons resets the arrangement to the respective 
original values - 0 cent for pitch and formant position and the original 
tempo of the first bar of the arrangement. 

The values entered here do not change the notes of the arrangement 
themselves but only the temporary playback parameters. If you have 
transposed the entire arrangement by a third here, you will see a note 
previously defined as “C” still displayed in the Editor Window as a “C”. You 
can however also convert the values chosen in this panel to be the fixed 
values for the arrangement itself. The “Fix to Arrangement” button serves 
this purpose. Pressing this button will change the arrangement 
permanently, as specified in the “Temporary Play Offsets” panel. 

If the arrangement has several segments with different tempos, and you 
want to change the tempo of the entire arrangement in equal proportions, 
it is best to use this panel. Otherwise, you would have to change each tempo 
definition individually in the arrangement window.
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With “Fix to Arrangement”, you can either change the whole arrangement, 
or only the region between the current locator positions. This is useful, for 
example, if you only want to transpose a certain section of the arrangement 
to a different key. The panel for the decision to change the whole 
arrangement or only the region between the locators appears after pressing 
the “Fix to Arrangement” button.

You can also apply temporary pitch or formant changes to single tracks. 
With the pop up menu at the top of the panel you determine if your changes 
apply to the whole arrangement, or just to the currently selected track. If 
you perform the action “Fix to Arrangement”, the global changes as well as 
the single track changes will be applied to the arrangement permanently.

On the other hand, you can also exempt single tracks from the global 
changes. This may be useful if you want a global transposition to be applied 
to all melody tracks, but not to drum tracks. If the pop up menu at the top 
of the panel is switched to “Selected Track”, the switch “Globals” appears 
next to it. Usually, this switch is active. If you deactivate it, the track that 
is currently selected in the arrangement will not react to global changes of 
pitch or formants any more.

You can also edit these play parameters via MIDI, either transposing in 
semitone steps by playing the MIDI keyboard, or continuously via MIDI 
controllers (see sections on Editing and Playing via MIDI and MIDI 
Controllers).

Note Positions and Quantizing in Melodyne

In Melodyne, you always work with recorded audio material. The played 
notes are always detected from the audio recording itself, unlike single 
notes played via MIDI. Thus these notes may behave a bit differently in 
terms of time and quantizing from what you may be used to from a MIDI 
sequencer. Some explanation about this may be useful.

As soon as Melodyne detects a melody, each note knows its assigned beat 
position represented by its score notation. Additionally, it knows its 
deviation from that assigned beat position, since its empirical time position 
is completely free in time, whereas the assigned beat positions represent a 
grid. The program automatically detects the assigned positions by 
depending on the detected or edited tempo grid and on the empirical 
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position of the note itself and its neighborhood. In the case of reasonably 
straight tempo and phrasing, Melodyne will generally find the right 
assignments for the notes. It is important for you to check this assignment 
and to correct it if necessary in order to be able to work with the material 
later on in the most flexible way Melodyne generally provides. The checking 
and correction should never be done in the Editor Window, but in the 
Definition Mode window for melodies that have not yet been edited, see 
“Detecting and Defining a Melody.

When editing your music in the Editor window, you will also move melodies 
in time, stretch or compress them or change the time phrasing of groups of 
notes. If note positions are thus changed without any quantizing active, 
they will automatically determine their new assigned position and their 
deviation from that assignment with each movement, depending on their 
new empirical position and the notes present in their neighborhood.

On the other hand, something completely different happens if any 
quantizing is active while editing notes in time. In this case, the notes never 
detect a new assigned position, but their assigned position is simply 
relocated by the active quantizing value, and their deviation from its current 
assignment will stay the same. You can easily watch that difference in 
behavior if the score note display is active while moving notes in the Editor 
Window. If you want to edit the time phrasing of notes in a detailed manner, 
quantizing has to be deactivated in the quantize menu. In this case it might 
happen that a note assigns itself to a new beat position. If that was not your 
intension, you will have to re-assign the note's position with the quantizing 
tool without changing its empirical position.

The same basic difference concerning note behavior applies if you copy and 
paste notes. If no quantizing is active when pasting, notes will be inserted 
at the target position with the same “external” time course that they had at 
the source position they were copied from. At the pasted position, the notes 
will then detect their new assigned positions depending on the tempo grid 
that is valid at the target position.

The opposite applies if any quantizing is active when pasting. In this case, 
the notes keep their assigned beat positions and modify their “external” 
time course. They will adapt to the tempo grid valid at the target position. 
Here the notes will also keep their current deviations relative to their kept 
assigned positions.
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Thus you can copy and paste melodies between arrangements with 
completely different and also irregular time courses. The notes will always 
adapt themselves to the present tempo. On the other hand, if you work with 
material that has no rhythmic meaning, as with speech, you should make 
sure that quantizing is deactivated when pasting.

The actual quantizing, i.e. moving the empirical note positions to a quantize 
grid, is always based on the note's beat position that has been automatically 
or manually assigned. This is different than the way quantizing is done in a 
MIDI sequencer. In a MIDI sequencer, if you choose a quantize grid of 1/4 
for example, all notes will be moved to their closest quarter position. In the 
MIDI process, several neighboring notes may move to the same quarter note 
position, which may well be intended. This will never be intended in the 
case of recorded monophonic and melodic material. A succession of notes 
should always stay successive, and the only question is what beat position 
each of them “belongs to”. In the case of a fast succession of notes, the 
program will have to switch to a higher resolution for beat assignment. 
Thus, the condition for successful quantizing in Melodyne will always be the 
assignment of a note to its valid beat position.

In defining the beat positions in the Melody Definition Window, as well as 
quantizing editing in the Editor Window, the assigned beat positions of the 
notes will always be displayed as note outlines in addition to their actual 
positions. Quantizing is a continuous parameter. The actual note positions 
will approach their assigned beat positions proportional to the value you 
have set for quantize percent in the inspector bar, if their quantize value is 
set to 100% the notes will coincide with the tempo grid positions exactly.

As a default, the tempo grid of the arrangement itself is used for quantizing 
(“hard” quantizing), but you can also use the time behavior of another 
melody present in the arrangement for quantizing. In that case, that melody 
is called “Quantize Master”. If you want to use a melody as a quantize 
master, it is essential that the master melody as well as the melody have 
valid quantized beat assignments, i.e. they must be carefully checked and 
edited if necessary. If a melody is used as a quantize master, the other 
melodies will take their time phrasing from that melody, i.e. its small 
deviations from the assigned beat positions. You can read about the 
Quantizing Tool in the chapter on the Editor Window in the section about 
how a melody is used as a quantize master.
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Defining the Tone Scale and Tuning

In Melodyne, you can work with any scale or tuning you like. The scale 
defines which tonal positions of a scale can be used. The tuning defines the 
exact pitch that the different tonal positions have relative to each other. It 
also defines the tuning pitch of the fundamental.

■   Scales are used by Melodyne to define to which tonal snap-to positions 
notes can be moved by the pitch change tool in the Editor Window when 
“Scale Snap” is activated. 

■  Tuning is used by Melodyne to define the exact pitch of the individual 
tonal positions, if the intonation of notes is to be corrected. 

Scale and tuning are always defined for an entire arrangement. The panel 
to define and edit the scale can be opened from the menu Windows ->Tone 
Scale.

The tone scale panel always first appears in the form in which it is displayed 
in the picture to the left. For most applications, the editing functions that 
are at your disposal here will be sufficient. 

■   To the left, you will find the buttons for the selection of a scale key - by 
clikking on a button the scale key for the arrangement is defined. With 
the a usual mouse click you select the major scale, with the a mouse 
click with the “Shift” key pressed you select the minor scale.

Used 
Tonal Positions

Proportions of the
relative Tonal 

Assign relative
to absolute

Absolute
Tonal Positions

Proportions of the
absolute Tonal

Select a Tone Scale

Select the Base Key

Frequency of the Keys

Tuning Deviation
in cent

Positions

Positions

V2.6
p.172
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■   To the right, you find text fields in which the frequency of each key of 
the scale is displayed. Here, you can enter the tuning of the 
fundamental. All other fields will change according to the tuning chosen 
in a text field. You cannot, however, enter different frequencies for 
different notes of the scale here - the chosen tuning sets the relation 
between the tones. For example, if a piece has been recorded in a tuning 
with A=415 Hz, you should enter “415” into the text field defining A, 
and all other frequencies will change accordingly. 

■   At the bottom there is a text field which is entitled “Offset” - this field 
allows you to enter the deviation from “standard” tuning (A=440 Hz) in 
cents. If you enter a frequency in the note fields, this field will always 
also show the deviation from standard pitch in cents. 

■    There is a pop up menu at the top of the window in which you can choose 
between some of the most common tunings. The frequency display 
changes according to the chosen tuning for each note. The default 
setting here is the usual equal temperament.

The “Edit” button opens the extended tone scale panel as displayed to the 
right. Here, you can define any tuning that you want to apply to the 
arrangement. (If you do not intend to work with historical or oriental 
tunings, you can skip the following sections.)

For a better comprehension of working with tone scales, we must 
distinguish between relative and absolute tone positions. In Melodyne, the 
relative positions are called Do, Re, Mi..., the absolute positions are called 
C, D, E... (in most “Latin” countries, the names Do, Re, Mi... are used as 
having the same meaning as C, D, E... we will not do this here since we 
would lose the difference between relative and absolute positions. It would 
have been best to use the Hindu names Sa, Re, Ga..., as these only intend 
relative positions. This discrimination would be irrelevant for equal 
temperament, since in this (and only in this) temperament the intervals of 
all tonal positions are exactly equal to each other. This means that a C major 
scale on a piano, which is tuned in equal temperament, has the same 
intervals as an E major scale. All other tunings do not share this 
characteristic. 

The relative intervals (Do, Re, Mi...) are used at first as a construction plan 
to specify a tuning relative to the imagined fundamental (Do). The second 



72   Melodyne user manual 

Defining the Tone Scale and Tuning

step is to specify where this fundamental is located in an absolute system, 
i.e. like on a piano key (C, D, E...). 

■   The buttons “Used Tonal Positions” define, which tonal positions (of 12 
possibilities) appear in the scale. (These then become the positions that 
notes can snap to if “Scale Snap” is activated.)

■  The text fields “Proportions of the relative Tonal Positions” define the 
actual tuning. The values are entered in cents. They always relate to the 
imagined fundamental “Do”. (If the Editor Window is opened when you 
make these changes, you can see how the background of tonal positions 
changes relative to the other tonal positions.) This procedure defines the 
relative tuning. 

■   The buttons “Assign relative to absolute” specify which absolute tone is 
set to be the actual fundamental of the relative tuning. If you press a 
button for the assignment, you can see that the displayed cent value 
beside the absolute tone is set to 0. All other text fields now display 
values relative to that fundamental. This procedure defines the absolute 
tuning of each key. 

■   If you press the “Absolute Tonal Positions” buttons, you can see which 
tonal relations result for each tone by the respective assignments in the 
“Proportions of the absolute Tonal Positions” text fields. These buttons 
only have a display function and will not change the tuning.

■  If you changed the values in the “Proportions of the absolute Tonal 
Positions” text fields, you would change the relative tonal positions at the 
same time; only that here, they would be changed from the point of view 
of absolute tonal positions. 

■   Now, the actual tuning definition is complete - we can still specify which 
absolute frequency the tuning is based on using “Frequency of the Keys” 
text fields. This process is comparable to “tuning a piano as a whole” 
higher or lower in pitch without changing the tonal intervals in relation 
to each other. 

■   Finally, you can specify with the “Select Base Key” buttons which key is 
supposed to be the base key for the used scale steps defined before by 
“Used Tonal Positions”. 
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The panel to define tuning and scale is also available in the Melody 
Definition Window. There, however, you only define the tuning of a melody, 
not the tuning of the entire arrangement. If the melody is the first one 
loaded into an arrangement, the melody automatically determines the scale 
of the arrangement. You can of course still change the scale of the 
arrangement, at all times.

The defining of a scale does not change the musical content of the recorded material 
contained in the arrangement - the scale only becomes effective when editing notes with 
the note- or scale snap option active.

The Mixer in Melodyne

The menu item Window -> Mixer opens the audio mixer for the current 
arrangement:

The appearance of the mixer always reflects the present arrangement. It 
shows a channel strip for each track of the arrangement plus channels strips 
for  Group Tracks and ReWire tracks. The order of the tracks in the 
Arrangement Window from top to bottom is equivalent to the order of 
channels from left to right in the mixer. If you change the order of the tracks 
in the Arrangement Window the channels are changed accordingly in the 
Mixer. If you switch between different arrangements, the display of the 
Mixer will change accordingly. 

Volume &
Level Meters

Solo / Mute / Record

Effect Send

Mono / Stereo

Outputs

Inputs

Track Name

Panorama

Insert Effects

Equalizer Type

Equalizer Values
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■   At the bottom the track names are displayed. The track names correspond 
to the names shown in the Arrangement Window. The names can be 
edited in the Mixer as well as in the Arrangement Window.

■   Above the track names, the buttons for Solo, Mute and Record are 
located. These controls are equivalent to those in the track bar of the 
Arrangement Window as well. With these buttons the respective track is 
muted or set to solo. If you click the “Solo” button while keeping the 
“Shift” key pressed, you can also set more than one track to solo, so that 
you don't have to mute all other tracks if you want to hear two tracks 
together. With the record buttons, recording can be activated or 
deactivated for single tracks while recording, which provides punch in/
out on the fly.

■   Above of the switches, the amplitude controls and the level meters are 
located for each channel. The volume sliders are db linear down to -25 
db and amp linear from -25 to - ∞. Their current value is shown above 
them. The level meters are shown next to the volume sliders. The track's 
level meters show clippings while recording.

■   Above of the sliders, the stereo panorama controls are located. They are 
only active if a stereo output is chosen for the respective channel. Their 
current value is shown next to them.

■   With the pop-ups above the pan controls you determine whether a track 
is processed in mono or in stereo. If a melody is loaded on a track from 
a stereo sound file, that track will be switched to stereo automatically, 
but can be reset to mono if desired. It is also dependent on the state of 
this switch which insert effects are available. You may want to set a track 
with a mono sound source to stereo to be able to use a stereo insert effect 
on that track.

■   Above the mono/stereo switches are the output channel pop-ups to set 
the output channels to be used for a track. Selecting “Main” routes the 
signal to the output channels of the master section. Selecting a numeric 
value directs the signal to a particular hardware channel (or pair of 
channels). Furthermore you can send the signal to a Group Track by 
choosing the Group Track’s name. Note that the number of available 
output channels may be limited in the “Preferences -> Hardware”. 
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■   Above the output pop-ups are the input pop-ups. The available inputs 
depend on your hardware and on your settings in “Preferences -> 
Hardware” as well.

■   Use the turning knobs above the input pop-ups to set the amount of the 
channel’s signal routed to an aux effect. The pop-up button in the master 
section at the far right controls which effect is to be used. With the 
switch next to the aux send control you can bypass the effect without 
changing its gain setting.

■   Above the aux-send controls you can select VST or AudioUnits as insert 
effects for a channel. You can select an arbitrary number of insert 
effects, as a new insert will appear for selection once an insert effect is 
activated. A single click on an activated insert effect button will open the 
user interface window for the selected plugin. The list of available plug-
ins is determined by your settings in “Preferences -> PlugIns”, and by 
the current mono or stereo state of the channel.

■   At the top of the Mixer Window is the equalizer section. With the pop-up 
button above the controls you activate an equalizer and select its type 
(high shelf, low shelf, peak). As with the insert effects, a new row of 
equalizer controls will appear once an equalizer has been activated. 
There are three knobs for gain, frequency and bandwidth, and a 
checkbox for activating or bypassing the EQ. Shift-dragging the knobs is 
used for fine tuning. You can also edit all equalizers of a track together 
graphically, as described under the master section.

All controls can be reset to zero position with “Alt”-click in Mac, “Ctrl”-
click in Windows. Shift-dragging the controls is used for fine tuning.

At the far right of the mixer window is the master section that controls the 
main output, the aux effects and some general settings for the mixer.

■   At the bottom are the master faders, together with the master meters. 
The master meters indicate clipping when the output is more than 0db. 
If clipped once, the master meters light the indicator until playback is 
stopped; additionally you can click on the clipping light to switch it off. 
With the checkbox “Sync Faders” you determine if the master sliders can 
be moved separately or if they are coupled.
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■   If the option “Rec Monitor” is active in the mixer, you will hear the 
incoming signal when recording, with all effects active in the signal chain 
(with a latency that depends on the buffer size set in the “Preferences”).

■   Above these switches is the output channel pop-up to set the hardware 
channel pair of the master output. The available output channels depend 
on your hardware, and also on your settings in “Preferences -> 
Hardware”.

■   Above the output control you can select VST or AudioUnits as aux effects. 
You can select an arbitrary number of aux effects, as a new aux pop-up 
will appear for selection once an aux effect is activated, together with a 
new row of aux send controls for the single tracks. A single click on an 
activated aux effect button will open the user interface window for the 
selected plugin. The list of available plug-ins is determined by your 
settings in “Preferences -> PlugIns”.

The pull down menu at the top of the master section serves for some general 
settings of the Mixer:

■   With the upper three entries you determine the appearance of the mixer. 
You can hide or show the EQs and the controls for the insert and aux 
effects.

■   With the “Group Tracks” item, you can create or delete group tracks. A 
group track can serve to group other mixer tracks for a submix. It will 
appear like a usual track in the mixer, but it has no hardware input. 
Instead, it can be selected as an output for other tracks. A group track 
can have another group track as its output as well.

■   With the “Instrument Tracks” item, you can create or delete instrument 
tracks. On an instrument track, you can load a virtual VST- or AudioUnit 
instrument that can be addressed, instead of an external synthesizer, 
from a melody track in Melodyne. To learn how to use virtual instruments 
in Melodyne, please see the chapter “Using Virtual Instruments for MIDI 
Playback”. 

■   The item “Show EQ Graph” opens an editor window where you can edit 
all equalizers of a track together graphically. The view always shows the 
EQ curve of the last track that had EQ changes in the mixer window. You 
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can grab a curve point with the mouse and edit its gain and frequency 
values with a vertical and horizontal movement. The bandwith (Q) value 
is edited with the Q control in the editor window.

The Display of System Load

The menu item Window -> System Load opens the panel that shows the 
current processor usage (and available memory in Mac OS 9).

The Bar in this panel shows the current processor load. This value will be 
higher when Melodyne is playing, and you can estimate from this display 
how many tracks you will be able to play simultaneously.

Mac OS 9: In Mac OS 9 an additional bar shows the current memory usage 
as well. You can configure the amount of main memory used by Melodyne 
in Mac OS 9 (this is not necessary in Mac OS X) and in a few cases you may 
have to change the amount of memory you allocate to Melodyne. If 
Melodyne reports that it cannot start because the available main memory is 
too low, you should first try to quit other running applications before starting 
Melodyne. If Melodyne is not able to open a large arrangement or if the 
upper bar of the “System Load” panel frequently shows a value larger than 
80%, you should increase the amount of memory allocated for Melodyne. 
To do so, go to your Mac's Finder, select Melodyne and press “ - I ” to 
open the file information panel. Choose “memory” in the pop up at the top 
and change the values shown as needed. You can enter the same value into 
both the minimum and preferred size fields and if you have ample physical 
main memory, use large values.
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The Preferences

The menu item “Preferences” opens the Preferences panel. Here you can 
define some general settings in Melodyne. You will not change these 
settings very often. With the top most pop-up menu you can choose to edit 
the preferences associated with the hardware settings, the Sound File 
Format used when writing your recordings to hard disk, the display 
appearance of Melodyne, assigned keyboard shortcuts and other 
miscellaneous options.

The use of the “Hardware” preferences is discussed in detail in the first 
chapter on Installation of Melodyne.

Recording preferences allows you to choose your preferred audio file format 
and the sample resolution. You set the sampling rate, a hardware feature, 
in “Hardware” preferences.If you record in an arrangement that has not 
been saved yet, Melodyne will save the recorded audio file to a default 
folder you can specify in the field “Audio Folder for unsaved 
Arrangements”.
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In the “Appearance” section of Melodyne's preferences panel you can set 
the style and colors Melodyne is using, how autoscrolling works and whether 
to display level meters or not. 

■   The first item is “Style”. It has two options: “Classic” and “Custom”. If 
“Classic” is chosen, the next four items do not have any effect and 
Melodyne's bars and notes appear as they were intended. If “Custom” is 
chosen, the next four items define the colors Melodyne uses to draw the 
background, the notes, their borders and their brightness. Simply play 
around with the colors and the brightness to get your desired appearance. 
The “Unselected” setting determines the lightness of notes of 
unselected tracks, for “Classic” mode as well as for “Custom” mode.

■   The autoscrolling parameter defines the way Melodyne scrolls documents 
to keep a moving position marker visible. The first option provides 
smooth scrolling while the second option causes Melodyne to jump to the 
next 'page' before the position marker disappears.

■  With the next pop up you can determine if the middle C note (262 Hz) 
should be called C3, C4 or C5, as there are different nomenclatures for 
the octaves in use.

■   With the two check boxes at the bottom you can determine if you always 
want to see the tool tips, and if Melodyne should show values that you 
edit in the mixer.
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In the “Plug Ins” section of Melodyne's preferences panel you can select 
the VST and AudioUnit plug ins that can be used in Melodyne’s mixer as 
insert effects or as aux effects, as well as the virtual instruments that you 
can use within Melodyne to play a melody resynthesized via MIDI.

In Mac OS X you can choose if you want to work with AudioUnits, with VST 
plug ins, with both or with none of them. If you activate AudioUnits or VSTs 
with the check boxes on the top, Melodyne will scan your system and try to 
load every corresponding effect plugin. If Melodye crashes while loading a 
particular effect, simply restart Melodyne to continue the scan and to ignore 
the incompatible plug in. If plug ins were activated and plug ins were 
installed or added to the corresponding plug in folders, Melodyne rescans 
the new plugins when starting up the next time.

In Windows you can define the VST plugin folder Melodyne is using. The 
default folder is the “Vstplugins” folder in Melodyne's application folder, 
but it can be set to any other folder.

In both platforms, click on the check boxes of the plugins to activate them. 
They will immediately appear in the mixers effect menus.

In Mac OS 9, effect plugins are not supported.

An up to date compatibility list is available at 
http://www.celemony.com/support/melodyne/plugins.html
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In the “MIDI Ports” section of Melodyne’s preferences panel you can select 
the MIDI Ports to be used for different purposes.

In order to use the options that are described in the section “Editing and 
Playing via MIDI” you have to specify a MIDI Port as the Default Input here. 
If no input is specified, MIDI editing and playing options are disabled.

If you specify a MIDI Port for Default Output, this MIDI Port will be used as 
the default output for the options described under “MIDI Playback of 
Detected Melodies”. You can override this setting in the MIDI send options 
for the individual tracks.

You can synchronize other Programs to play in time with Melodyne, thus 
Melodyne running as the “Sync Master”, or you can have Melodyne to act 
as the “Sync Slave” if another program is set to be the “Master”.

You can choose either MIDI Time Code (MTC) or MIDI Clock as the sync 
protocol. In the Preferences Panel, you only select the MIDI Ports to be 
used for synchronisation. The actual sync state is switched on or off in the 
Transport Bar. Of course, you also have to set up the appropriate parameters 
in the Master or Slave program you want to communicate with.

For performance reasons, we recommend to disable any MIDI Port that is 
not actually used.
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In the “MIDI Controllers” section of Melodyne's preferences panel you can 
set up external MIDI controller devices.

Under “Options”, you can add a MIDI controller device. The first entry 
under “Add” is “Generic Controller”, which sets up a very flexible 
assignment of MIDI data to functions available in Melodyne. The other 
entries select the predefined controllers. You can also export or import 
controller assignments you define.

For more information on controller setup, see se section “Remote Control 
via MIDI”.
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The “Short Cuts” preference allows you to define keyboard shortcuts from 
a set of available actions. Use the mouse to choose an action and hit a key 
on your keyboard. Key combinations with “ ”/”Ctrl” are predefined and 
cannot be used for customization. The “Options” menu allows you to import 
and export whole sets of shortcut settings, to clear any short cut key of a 
previously set action and to reset all short cuts to the factory defaults. Most 
of the actions are self-explanatory and some are only available through 
these shortcuts. The last four actions, “Generic Left”, “Generic Right”, 
“Generic Up” and “Generic Down” are context sensitive and depend on the 
foremost window and the chosen tool. By default the keyboard arrow keys 
are assigned to these actions and this manual explains them when referring 
to these keys.

The function keys F1 - F7 are assigned to the main tools by default - not 
according to the tool’s function, but to the sequence in which they appear 
in the tool box of the respective working window, i.e.F1 = first tool etc.

In Mac OS 9, to use the functions keys (F1-F12), you may have to switch 
off the Mac OS function keys in the Keyboard control panel.
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The “Other” section allows you to setup features for some special cases.

Here you can limit the number of available undo steps. Decreasing the 
number of available undo steps should help if Melodyne seems to be getting 
slower and slower while editing. This is useful in preventing the system from 
running out of memory, especially in Mac OS 9 and Windows 98.

The option “Formant Follow” is described along with the Tool to Change the 
Formant Position in the Editor Window.

The first check box at the bottom gives you the option to “Update Mdd's on 
savimg Arrangement”. The format of .mdd files (which are stored along with 
the sound files and hold the detection information) may change from 
release to release of Melodyne. Enabling this option causes Melodyne to 
update .mdd's for all sound files in an arrangement to the latest format 
whenever you save that arrangement. Melodyne will ask before updating any 
individual .mdd for every sound file. On a given platform Melodyne is able 
to read older .mdd's, so there is no need to enable this option in general. 
Only if you want to exchange files between different platforms, e.g., open 
files in Windows which have been saved on a Macintosh. 

With the next check box you can determine if mdd’s should be 
automatically updated if the Melody Manager finds older versions that do 
not yet support fast note display. For more information, see also the last 
paragraph in the Melody Manager chapter.

If you activate the option “Always use maximum processing quality”, the 
processing quality that is used on writing soundfiles will be used for 
playback as well. This feature is decribed under “The Play Algorithms in 
Melodyne”.
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Integration and Communication 
with other Recording Applications

MelodyneBridge
The MelodyneBridge is a small effect plug in that connects to Melodyne. 
MelodyneBridge allows an application to use Melodyne as if it were a plug 
in, even if the application remains standalone.

■  The Concept

If you run a sequencer application, 
you have one or more audio tracks 
played through a mixer chain:

To edit this audio track with 
Melodyne's capabilities, the 
MelodyneBridge plug in can be 
inserted as the first insert effect in 
the mixer chain:
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When Melodyne is not running, the MelodyneBridge simply passes through 
the audio signal. When Melodyne is running, the MelodyneBridge can be 
used in two ways:

■   Record mode: to transfer audio from your recording application to 
Melodyne 

■    Playback mode: to merge Melodyne's audio into your mixer while playing 
back. 

If the MelodyneBridge is in Record mode, it copies all played audio data into 
the corresponding track in Melodyne. By switching on the Record mode and 
playing back from bar 3 to 5 you will get this:

Now you can edit the recorded audio signal within Melodyne. If you then 
choose the Playback mode and play from bar 1 to 6, the MelodyneBridge 
will take the audio from Melodyne whenever Melodyne has audio available 
during the playback time. Otherwise it passes through the original signal. 
From bar 1 to 2 you will hear the original signal:
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From bar 3 to 4 you will get the audio from Melodyne:

From bar 5 to 6 you will get the original audio again:

So far we have been using the host application's transport bar to start and 
stop playback. If you start playback from Melodyne's transport bar, 
Melodyne will send its audio signal through the recording application's 
mixer chain, but the applications will not be synchronized and the host 
application won't play. Thus you can listen to your melody while editing in 
Melodyne indpendently, and the use the host application's transport for 
synchronized playback.

■  Running the MelodyneBridge
Start a recording application (e.g. Cubase SX) and open a file with a vocal 
track. Then go to the vocal track's mixer chain and choose 
“MelodyneBridge” at the first insert effect. Open the editor panel for the 
“MelodyneBridge”. 

Now start Melodyne. Melodyne will detect the recording application and will 
ask you how you want to connect to it. Select “MelodyneBridge”.

Create a new arrangement within Melodyne. By default Melodyne creates 
an 8 track arrangement, where the tracks are labeled “Track 1”, “Track 2”, 
etc. Important: Save this arrangement into the project folder of your Cubase 
song.
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Now go back to the MelodyneBridge in Cubase. Note that the Bridge is now 
showing all tracks of the Melodyne arrangement:

Switch on “Track 1” by clicking the check mark. This means that from now 
on the Cubase vocal track “Ch 1” (on which the MelodyneBridge is inserted) 
corresponds to Melodyne's “Track 1”.

Switch on the Record mode by clicking the mode button in the 
MelodyneBridge panel. 

In Cubase, move the play cursor to the bar from which you want to transfer 
audio to Melodyne. Start playback in Cubase, wait until 2 bars have been 
played and stop playback. Note that the MelodyneBridge mode will 
automatically switch from Record to Playback again.

Switch to Melodyne and detect the file as usual.
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Go back to Cubase and set a cycle around the region that has been 
transferred to Melodyne, including some of the surrounding region that has 
not been transferred. Start playback in Cubase.

Now go back to Melodyne and open the transferred audio in the Editor 
Window. Move some notes in pitch or in time as usual. Thus you can edit 
your melodies in realtime while it is played back into the arrangement of 
the host application.

More details on the MelodyneBridge, up to date compatibility lists and 
configurations hints and are available at http://www.celemony.com/support/
melodyne/bridge.html

ReWire

Melodyne supports communication via ReWire like many other applications 
and can be run both as a ReWire host and as a ReWire client.

■  Melodyne as a ReWire Host
Start Melodyne and open a new file or an existing arrangement. Open the 
“ReWire Devices” panel from the “Windows” menu:

Choose the ReWire client application from the pop up in the upper left 
corner and start the client application, either by pressing the “Start 
Application” button or by launching it the usual way.

Set the number of channels you want to use by clicking the check boxes in 
Melodyne's ReWire Devices panel. For each ReWire channel Melodyne adds 
a new channel strip in the mixer, which is fed by the corresponding output 
channel of the other application:
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The first two channels may be grouped as one stereo channel strip.

Press play and do your work. It is also possible to connect more than one 
application to Melodyne. Always quit the client application before you quit 
Melodyne!

■  Melodyne as a ReWire Client
Start the host application and choose the Melodyne ReWire channels from 
the application's ReWire panel:

Start Melodyne. Melodyne will detect the host application and will ask you 
how you want to connect to it. Select “ReWire”.

Open a new arrangement or an existing one. Open the mixer. The output 
channels in the mixer now relate to the corresponding rewire channels:

Input channels are not available if you are connected to a ReWire 
application using Melodyne as a client.
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In contrast to other ReWire implementations, you do not need to quit the 
applications in any specific order. If you restart e.g. “Live” without quitting 
Melodyne, the application will be reconnected automatically.

Technical note: Melodyne does not load a full “engine” into the host 
application. Instead it uses the technology of the MelodyneBridge to pipe the 
audio I/O from Melodyne to the host.

Melodyne does not support ReWire in Mac OS 9.

More details on the Melodyne and ReWire, up to date compatibility lists and 
configurations hints and are available at http://www.celemony.com/support/
melodyne/rewire.html

Synchronizing via MIDI Clock and MTC

Melodyne can be synchronized to other applications by MIDI Clock or by 
MIDI Time Code, and can also act as a sync master for other applications 
by sending these sync codes. To take advantage of Melodyne's abilities to 
play audio with a varying tempo, it is generally more useful to use MIDI 
Clock, as this relates to musical beats and can thus be used to control a 
varying tempo.

To use these options, you can specify in “Preferences -> MIDI Ports” on 
which MIDI port synchronisation should be sent or received. In the transport 
bar, there are the buttons “Master” and “Sync”. If “Master” is activated, 
Melodyne will send MIDI Clock or MIDI Time Code according to the settings 
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in the Preferences. If “Sync” is activated, Melodyne will react to sync 
signals coming in from the selected MIDI port.

The SMPTE Type to be sent with MIDI Time Code (24, 25, 29.97 drop, 30) 
can be specified in the “View” menu.

If Melodyne is synchronized by MIDI Clock with the “Cycle” button active 
in Melodyne's transport bar, the cycle defined in Melodyne will be repeated 
in sync with the MIDI clock. If you want Melodyne to follow the master's 
song position continuously, you have to disable the “Cycle” button. 
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Using MIDI with Melodyne

Editing and Playing via MIDI

You can edit your arrangement using a MIDI keyboard, or you can even use 
Melodyne like an instrument by playing it via MIDI in real time. To activate 
MIDI, you have to select the Default MIDI Input in “Preferences -> MIDI 
Ports”.

With the “MIDI” item in the main menu you can select the mode to be used 
with MIDI:

■  Play Notes: If “Play Notes” is selected, you can play a melody in the 
arrangement via the MIDI keyboard. If playback is stopped, you will go 
from note to note in step mode. If you hold down the “Shift” key on the 
computer keyboard, the last played note will be repeated. (You can also 
step backward or forward in the melody with the arrow keys of the 
computer keyboard.)
If playback is running, you will hear the melody with the pitches you play 
on the MIDI keyboard. Playback is always monophonic, i.e. you will hear 
the pitch of the last pressed key. If you release the last key, pitch will go 
back to its original in the arrangement. In the “Play Notes” mode, all 
changes are temporary real time changes only, i.e. the notes in the 
arrangement are not changed.

■   Edit Notes: If “Edit Notes” is selected, you can use the MIDI keyboard to 
edit the melody, i.e. the notes in the arrangement will move to the played 
positions and stay there. The behaviour is similar to the “Play Notes” 
mode: if playback is stopped, you can edit the melody in step mode, or 
you can move the notes in realtime while the arrangement is playing. 
With realtime editing, the effect of the notes being moved will be a little 
different from what you hear while you are playing: You hear the played 
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notes exactly as you are playing, but in fact the notes are set to their new 
positions according to their defined separations. Thus you will have 
better transitions between the notes. If you play some short notes over a 
long original note, the note will not be separated - if you want that, you 
can separate the long note at the desired places with the note separation 
tool before you play.

■   Transpose: Another option that can be chosen from the MIDI menu is to 
transpose the whole arrangement or single tracks with the MIDI 
keyboard. In this case, playing the center C key (C3) on the keyboard will 
result in the original pitch, playing D3 will transpose the arrangement up 
by 2 semitones etc. The relative pitch course of the notes will not be 
altered in this mode. You can apply transposition to the whole 
arrangement or to single tracks. In contrast to the “Play Notes” mode, 
the transposition will be performed permanently, i.e. will stay on the last 
played level and will not go back to the original if you release a key unless 
you reset transposition by playing C3 again. The effect of transposition 
mode is the same as modifying the pitch in the “Temporary Play Offsets” 
panel, and you can see the changes in that panel if it is visible while you 
are playing. You could also transpose, or detune continuously via MIDI 
controllers, see below.

■  Omni/Poly/Mono Mode: With the next two items in the MIDI menu you 
determine the assignment of MIDI channels to the target tracks in 
Melodyne. With “All Channels to Selected Track”, the MIDI channel is 
not considered, and the target track will always be the currently selected 
track. With “MIDI Channels to Track Numbers”, the notes played on a 
specific MIDI channel will affect the respective track in Melodyne, i.e. a 
note on MIDI channel 1 will control the melody on track 1 etc. Thus you 
could play two voices with a keyboard split, or you could copy the same 
melody on different tracks and control it polyphonically from different 
tracks of a MIDI sequencer. In “Edit Notes” mode, the option “MIDI 
Channels to Track Numbers” is disabled, i.e. the target for editing notes 
is always the selected track.

If you play a melody over a wide range via MIDI, you may realize that if you play an octave 
or more below the original pitch, this may not sound really like an octave lower. This is 
due to the setting of the “Formant Style” parameter in the Play Algorithm Parameters for 
the melody. The default setting is the slider for that parameter at its very right position, 
which is generally better for more subtle pitch changes. If you want to use lower octaves, 
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please set the “Formant Style” slider to its left position to make the transposed melody 
sound lower.

■   Portamento Time: You can determine the speed of pitch transitions when 
you play in real time. This only affects what you hear while you play, it 
does not affect the arrangement permanently like the “Pitch Transition” 
tool in the Editor Window does.

■  MIDI Send Parameters...: This item changes the tool inspector of the 
current Arrangement or Editor Window to the tool for editing the 
parameters for MIDI Playback of detected melodies. You can select the 
same tool with the tool box in the respective window directly.

MIDI Playback of Detected Melodies

You can use Melodyne as a flexible pitch-to-MIDI converter and play the 
detected (or edited) melodies with an external synthesizer, or with a virtual 
MIDI instrument that you can load into Melodyne directly (see next 
chapter). You can reproduce, via MIDI, the exact pitch and amplitude 
envelope of a melody by sending pitch bend messages and expression (or 
volume) controller data. You can also export pitch bend messages and 
controller data using MIDI file export options.

To activate the MIDI Out option for real time playing, select the “Send 
MIDI” tool, the third subtool of the “Select” tool. The “Send MIDI” 
inspector bar will then show up. All settings here apply to the currently 
selected track. Clicking the first check box determines if MIDI will be sent 
for the selected track. The next two controls determine MIDI channel and 
out port respectively. If you have loaded virtual MIDI instruments in 
Melodyne’s mixer, the names of the mixer’s instrument tracks will show up 
as a MIDI target in the out port pop up as well. The next control is a velocity 
map that determines the relation of the envelope peak of each note to the 
note-on velocity to be sent. You can change the curve shape by clicking 
inside the control and dragging upward or downward. You can also limit the 
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upper or lower values by clicking close to the upper and lower edge of the 
control and dragging up or down.

To use pitch bend, activate the check box following the velocity map 
control. The control following the pitch bend check box determines the 
pitch bend range to be used. Please make sure that the pitch bend range is 
set to the same value in your target MIDI instrument (using different ranges 
will either flatten or exaggerate the synth's pitch phrasing). The pop-up 
menu next to the pitch bend check box determines the pitch bend mode to 
be used. If you have a continuous rise in pitch between two notes, each of 
them will have its own attack. To achieve a continuous pitch change effect, 
the pitch bend values would have to be increased towards the end of the 
first note, and then suddenly have to be set to a low value relative to the 
following note's center and increase from there. This may lead to glitches 
in the sound. The various pitch bend modes handle this issue in different 
ways. The first mode, “Each Note”, does exactly what has just been 
described, and may work well in many cases, depending on the source 
material and on the target sound. The second mode, “Central Note”, in fact 
only sends the same (central) note number with each “Note On”, and all 
pitch differences are realized with pitch bend values only. Depending on the 
pitch range of the whole melody, you may have to set the pitch bend range 
to a higher value, for example, if the melody has a pitch range of one octave, 
the pitch bend range has to be set to a minimum of (+/-) 6 semitones. If 
your target MIDI instrument supports the required pitch bend range and the 
appropriate pitch bend resolution for the given melody, this mode will 
generally give very good results. The third mode, “Alternating Channel”, 
switches between two successive MIDI channels for each new note. Thus, 
the pitch change for the next note does not influence the previous one, 
which is especially useful if the notes of the target sound have an audible 
release phase. If you use this third mode, please make sure to have the 
same sound program assigned to both channels, and do not use the next 
channel for other tracks. For example, if you set the MIDI channel to 1 for 
a particular track, channels 1 and 2 will be used in “Alternating Channel” 
mode. Remember MIDI pitch bend generally applies to a whole channel, 
and you have to use separate MIDI channels for each track if you use pitch 
bend in the track.

You can also use the original sound's envelope to control the target 
instrument's envelope or any other parameter for that matter. This will give 
very expressive results. To use this feature, click the “Use Envelope” check 
box in the inspector bar. The next control determines the MIDI controller 
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number to be used. The default is set to controller 11, expression pedal, 
but you could also use controller 7, volume, or any other controller. For 
example, you could control a filter parameter. The control “Envelope 
Controller Mapping” determines the relation between the original Melodyne 
envelope values and the controller values to be sent, similar to the velocity 
map curve described above. If you use the envelope option, you will have to 
set the velocity mapping to always send quite high velocity values. 
Otherwise, by having the amplitude controlled both by velocity and 
controller values the note will end up barely audible. Alternatively, you can 
set the target synthesizer to react to different velocity values by only 
changing the sound quality and not the amplitude. The unlabeled knob, 
“Attack from MIDI Instrument”, determines the envelope's behavior at the 
start of each note. Set to its very left position, the original Melodyne 
envelope will control the amplitude of the attack phase, which may be more 
expressive, but the target instrument's attack will be lost. On the other 
hand, at its very right position, the target instrument will dominate the 
attack envelope. Not all target instruments may apply an amplitude 
interpolation when receiving expression or volume controller data, which 
may result in “zipper noise” due to sudden amplitude changes. You’ll need 
to experiment with different target instruments to get a desired result! As 
with the pitch bend option, please be aware that MIDI controllers always 
apply to a whole channel, and you have to use separate MIDI channels for 
each Melodyne track if you use the controller option.

You may want to edit the melody to be played via MIDI with the different 
tools available in Melodyne, such as deleting or inserting a note separation 
to force a new note to be sent or you may want pitch changes to be 
exclusively determined by pitch bend. Other Melodyne tools can be used to 
change phrasing, amplitude transitions or rhythmic behavior. Melodyne 
gives you a whole new and expressive way of doing MIDI programming. If 
you want to use Melodyne as a MIDI programming tool, and want to use the 
original audio as well, it may be a good idea to copy the melody to a 
different track. Also, muting the audio of a track will allow you to edit the 
MIDI expression without the interference of the audio.

Melodyne offers two options for the export of MIDI: first, “As Specified in 
Tracks” with the pitch bend and controller data preserved, or second, 
“Quantized for Notation”, which will quantize each note as represented by 
its score notation, and will omit all pitch bend and controller data. For 
further information on MIDI export, please refer to the section “Exporting 
Files”.
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Using Virtual Instruments for MIDI Playback

Instead of using external MIDI instruments, you can also use virtual VST- 
or AudioUnit instruments in Melodyne directly. For that purpose, you first 
activate the instruments you want to have ready for selection in Preferences 
-> PlugIns.

To use a virtual instrument, you generate an Instrument Track in the mixer. 
To do so, you select the action “Instrument Tracks -> Add Instrument Track” 
from the “Configure” pull down menu in the upper right corner in the mixer 
window. The new instrument track will be added to the mixer as the last 
track. It initially has the name “i1”, but you can rename it at any time. Now 
you can select a virtual instrument for this track. You select the instrument 
with the (initially empty) pull down menu in the instrument channel strip 
that is located where you would select the input for the normal channels 
(the upper one in the group of three above the gain slider). After selecting 
the instrument, a single click on the same button will open the instrument’s 
user interface.

To address the instrument from a melody track, you go into the arrangement 
window, select the desired track and choose the tool “Send MIDI”, as 
described in the previous chapter. The “Send MIDI” inspector bar will then 
show up. The pop up button where you can select the MIDI out port will now 
show the names of all instrument tracks created in the mixer. If you choose 
an instrument track now, the instrument on that track will receive the MIDI 
data from the selected melody track.

Remote Control via MIDI

External MIDI hardware controllers can control most functions available in 
Melodyne, such as transport control, Melodyne's mixer, or more Melodyne-
specific functions including editing pitch or formant offsets for single 
tracks or for a whole arrangement. You can easily setup your own controller 
mapping for your MIDI controller device. Melodyne supports some 
dedicated controller devices that provide feedback with factory presets, like 
MackieControl, LogicControl and Radikal SAC.

To setup an external MIDI controller device, go to “Preferences” and select 
“MIDI Controllers”. Under “Options”, you can add a MIDI controller device. 
The first entry under “Add” is “Generic Controller”, which sets up a very 
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flexible assignment of MIDI data to functions available in Melodyne. The 
other entries select the predefined controllers. You can also export or import 
controller assignments you define.

Once a controller device has been added, you can click its checkbox to 
make it active. Double clicking a controller entry (or choosing the “Edit” 
option) opens an editor window in which you can define your controller 
assignments. The controller mappings can be setup in several banks, so the 
same MIDI hardware controller element can be mapped to a different 
function in each bank. A newly added controller will have one empty bank 
with no mapping entries. You can name your controller in the “Title” field 
and select the MIDI In port to which your controller is connected.

With the “Mapping: Add” button you can add as many mappings as you 
need, for as many control elements as your hardware controller has 
available. Each mapping becomes a row in a table. In the first column, you 
can enter an arbitrary name that describes one of your hardware controller’s 
elements such as sliders, buttons etc. The next three columns determine 
the MIDI event to be used by the respective controller element. You can 
either set the event type, channel and number manually, or by MIDI. If the 
MIDI connection is active, the selected controller mapping will be set to the 
last MIDI event that arrives. This can be either controller data, or note on/
off or program change or pitch bend data. These first four columns will stay 
the same for each bank, as they represent the hardware device itself.

In the next column, each cell contains a hierarchically structured pop-up 
menu, from which the available actions can be selected. The entries in the 
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last four columns, Channel, Index, Min and Max Value, depend on the 
action that has been selected. If it is a simple action that does not have a 
value, such as “Play” or “Save”, there won't be any entries. For the “Master 
Gain” action, for example, there will be Min and Max values, but no channel 
or index. For the “Track Gain” action, you can set a channel entry, and a 
controller will be assigned to a single track in the mixer. For the “Equalizer 
Gain”, for example, there will be an additional index entry, as you can have 
more than one equalizer per channel. The “Min” and “Max” values are 
predefined with useful default values in most cases, but you can edit 
column values according to your needs. An Example of this is the action 
“Change Track Pitch”, min and max values are set to -24 to +24 
(semitones), but if you want to use the action for fine-tuning only, you could 
set the values to -0.5 to +0.5 (semitones).

If you add a new bank with different mappings, the current bank will be 
copied, so that you don't have to enter the same mappings over again if you 
just want to change a few actions in the new bank. If you work with different 
banks, you should always assign one of the actions “Select Bank by Index”, 
“Select Bank by Value”, or “Select Next Bank” and “Select Previous Bank” 
to a specific controller element, so that you are able to switch banks from 
your MIDI controller device. These bank switching actions can be found 
under the last entry, “MIDI Controller”, in the action pop-up menu.

As long as the Controller Assignment Window is open, incoming MIDI 
events determine the values assigned to the selected mapping. As soon as 
the window is closed, the MIDI events will act as defined. MIDI keyboard 
keys or controllers that are assigned to actions will not be used for regular 
playing anymore, i.e., if you assigned the lowest keys of your MIDI keyboard 
to act as “Start” and “Stop”, these keys will not be evaluated for editing or 
playing your melody notes.

Specific controller devices, such as the MackieControl have their own 
interface and you usually just assign the MIDI port they are connected to, 
and the desired actions for some user definable keys.
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The Tools and their Inspectors

The Tools in the Arrangement Window

In the inspector bar of the Arrangement Window, the tool selection and 
quantize menus remain visible at all times. The other operating elements 
change based on the processing capabilities of the tool in use.

The Selection Tool

The selection tool serves to select melodies on the individual tracks. You 
can only work on notes in the currently selected track. In order to change 
to another melody, it is necessary to shift tracks first. A track can be 
selected by clicking on its visible melody representation; if the track is 
empty it can be selected by clicking on the vertical track bar. A frame in the 
track bar indicates the selected track. 

To change individual notes in a melody, the melody must first be detected. 
An undetected melody can only be processed as a whole. For example, you 
can move the whole melody in time or delete it with the backspace key.

You can copy and paste notes chosen with the selection tool. If you want to 
copy an entire melody you need to first select all its notes. In order to 
duplicate a melody to create harmony voicings, for example, copy the 
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melody, select an empty track, and paste the melody into the selected 
track. If the pasted melody is supposed to run exactly in time with its copied 
original, use the “Bar Quant” option in the quantize menu- in which case 
you don't have to position the pasted track exactly under the original 
version. Just getting the copied version anywhere in the right bar will cause 
it to snap into place. 

The quantize menu determines how notes behave when pasted. If none is 
selected in the quantize menu, notes will be inserted exactly at the chosen 
position. If any quantize size is set, the notes will be pasted in the same 
relative position to the quantize size unit as the notes held in the original 
melody. If, for example, you select “Bar Quant”, a note copied from a 
position where it was the third eighth beat in a bar, will be pasted to the 
closest third eighth beat of the selected target bar. This makes it easy to 
paste melody sequences at the right beat position. 

If you select the Hand subtool of the Navigation Tool, you can grab a 
window's content and move it directly in the horizontal and vertical 
directions.

You can switch that tool to act as a Zoom Tool, either by double clicking 
and dragging on the second click, or by pressing the “Alt” key (“Ctrl” in 
Windows) before or while moving the mouse. As you drag the mouse, you 
will zoom in or out in horizontal and/or vertical directions. 

The Play Algorithm Tool is described in detail in the chapter “The Play 
Algorithms in Melodyne”.

The MIDI Send Parameters Tool is described in detail in the chapter “MIDI 
Playback of Detected Melodies”.

In Melodyne's scrub mode it is possible to listen to the “local sound” at its 
original pitch independent of the tempo (this requires of course a previously 
detected melody). In order to use this option drag the mouse over the 
melody while holding the mouse button down.

The “Scrub Solo” tool only plays the currently selected melody. To switch 
to another track in the scrub solo mode, you have to click in the new track's 
track bar on the left.
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At the end of the Select subtool bar you will find the “Play Note” tool that 
allows you to quickly and easily switch between editing and listening. The 
“Play Note” tool plays the selected note or selected notes in case of 
multiple selection. You can select multiple notes by dragging the mouse 
over a group of notes. You can switch between this playback tool and the 
currently active editing tool quickly with the function key F12.

From the action menu entitled “Define Melody” you can start Melodyne's 
detection process of a previously undefined melody. You can also start the 
detection process by double clicking the melody. Once a melody has been 
detected it can be opened for definition editing in the Melody Definition 
Window by selecting “Edit Definition” (also see the chapter “Detecting and 
Defining a Melody”). 

The menu item “Reset to Definition” applies the original melody definition 
to an already processed melody. If a melody has already been processed 
with copy and paste it will be composed of multiple segments. In this case, 
the “Reset to Definion” action is applied to every selected segment with 
each segment being reset to its original from its own start point. Beware: if 
pitch and time changes were made they will be lost by using the “Reset to 
Definition” function!

The action “Apply Arrangement Properties...” can be used in case the 
tempo definition can be done better with all tracks of the arrangement 
visible and audible, and you want the tempo track (and tone scale) 
definitions to be applied to all single melody definitions in the current 
arrangement.

The Tool to Move a Melody in Time
   

This tool always moves the entire melody in its track. If you want to change 
the timing of single notes or parts of a melody within a track you will have 
to use the Editor Window. Once a value has been chosen in the quantize 
menu all notes of the melody will always move by the chosen quantize 
steps. If an arrangement is defined with an irregular course of tempos the 
notes will always move according to the correct beat. In this case, the 
distance between the single notes is not constant but will adapt to the 
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tempo of the respective bar. If no quantize value is chosen, the notes will 
move independent of changes of tempo.

The arrow buttons in the inspector bar perform the same function in moving 
notes in time as the mouse: they move the melody by the chosen quantize 
step. If no quantize is chosen the arrow buttons remain inactive. 

The action “Adapt Time” in the action menu automatically adapts the 
timing of a “foreign” track (a track not in time with the current 
arrangement) to the tempo of the arrangement. This requires the “foreign” 
track to have been previously analyzed by Melodyne.

If a melody or parts of a melody is inserted into an arrangement by copy and 
paste with a selected quantize value active, the pasted notes are 
automatically adapted to the tempo of the arrangement. If no time 
adaptation is to take place it is necessary to select “No Quant” before 
pasting. 

The other actions in the action menu, doubling, slowing down by half, 
tripling or slowing down to a third of the tempo, serve generally to change 
the tempo of an automatically adapted melody.

The Tool to Modify the Tempo of an Arrangement

This tool serves to modify the tempo. It is used to change the time course 
of the whole arrangement, or to insert a ritardando at some places in the 
arrangement or set an irregular course of timing.

This tool changes the sound content of the arrangement, thus audible 
music will be faster or slower in the changed region.

Please note the difference between this and the next tool: This next tool 
only changes the definition for the arrangement's tempo - not the sound. 
This second tool adapts the time background to the recording without 
changing the time course of the recording itself.

action menu
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You can enter the desired tempo in the tempo field directly. Alternatively, 
you can change the tempo by clicking the tempo field and dragging the 
mouse upward or downward. You can also vary the tempo by clicking on the 
darker blue start of a beat in the arrangement and drag the tempo to the 
desired value while holding down the mouse button. 

You can define tempo changes in the arrangement by double clicking the 
start of a bar - a dark blue line will then appear that indicates the change 
in tempo. In arrangements with changing tempos the text fields in the 
inspector bar will indicate the value for the current position. You can 
remove a tempo change by double clicking on the dark blue line. 

If you want to change the tempo globally in an arrangement with multiple 
tempo definitions, you can do so as described in the chapter “Temporary 
change of play parameters”.

The action “Equal Tempo” in the action menu is used to unify the tempo 
of a freely played melody that was previously identified in the melody 
definition mode. It removes all definitions of tempo change and sets the 
entire arrangement to its average tempo. All notes then automatically adapt 
to it.

The action “Tempo from Melody” in the action menu takes the tempo 
course of the selected melody as a reference for the entire arrangement - as 
long as this melody was previously detected. The melodies in the other 
tracks then adapt to the original tempo of that melody. The result of this 
action will only make sense if the notes of the other melodies were on valid 
beat positions before taking this action.

The other actions in the action menu are decribed under the next tool to 
define the arrangement’s tempo. The difference between the actions here 
and those for definition is that as the action is performed, that here the 
notes in the arrangement will be adapted to the new tempo and thus will be 
changed.
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The Tool to Define the Tempo of an Arrangement

Like the previously described tool, this tool edits the tempo of the whole 
arrangement. With the previous tool, tempo changes affected the positions 
of all notes based on the new tempo. With this tool, the time background 
for all melodies is defined, but the notes don't change their positions when 
the tempo definition is edited.

With the previous tool, the notes “assume” that they are on their valid beat 
position. When the tempo changes, they keep this beat position and thus 
move in “external time”. In contrast, with this tool, the notes will be 
assigned to new beat positions when the tempo is changed and thus don't 
move in “external time”.

If a new arrangement is empty its tempo can be defined here. This tempo 
will then be used for the recording or will be the tempo into which melodies 
are loaded or pasted. Pasted melodies will automatically adapt to that 
tempo. 

If there are already one or more melodies present in the arrangement, the 
tempo for the given melodies can be defined here. This will be especially 
useful if several tracks had been recorded that only together would 
determine the tempo, as described under “Working with related sound 
files”. On the other hand, the tempo of a single melody should always be 
determined in the Melody Definition Window.

In the fields for the signature you can enter the desired signature. The 
background display will adapt accordingly. An entry in the field for the 
denominator does not change the bar division. It only changes the definition 
of the smallest beat - i.e., if you enter an 8 into the denominator field of a 
3/4 signature, the numerator will automatically switch to 6.

Next to the signature denominator field, there is a checkbox labeled “1/8 
T” (if the denominator is 4). If it is set active, the program assumes that 
each quarter beat is divided into triplets and will prefer triplet positions 
during automatic detection of the score note position assignments. 
Switching “1/8T” on or off will cause Melodyne to perform a new detection 
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of score note positions. If there are multiple bar starts defined, you will find 
the “All Triplets” action in the Action Menu switches triplets on or off for 
all defined bars at once.

If you grab the bar background right at the start of the first bar, you can 
move the position of the entire bar background. With the arrow buttons to 
the right of the action menu the position of the entire bar definition is 
moved by the step size set in the quantize menu. If no quantize is selected 
the arrow buttons remain inactive. 

If you grab and drag a beat start at a position other than the start of the first 
bar, you will change the tempo. Alternatively, you can enter the desired 
tempo in the tempo field directly, or you can change the tempo by clicking 
the tempo field and dragging the mouse upward or downward.

You can define tempo and signature changes in the arrangement by double 
clicking the start of a bar - a dark blue line will appear there that indicates 
a change in tempo. In arrangements with changing tempos the text fields 
in the inspector bar will indicate the value for the current position. You can 
remove a tempo change by double clicking on the dark blue line yet again. 

The actions “Double Tempo” and “Half Tempo” in the action menu change 
the basic beat size. Thus a note that previously was considered a quarter 
note is changed into a half note in the “Double Tempo” option. The inverse 
is the case in the “Half Tempo” option.

The action “Equal Tempo” in the action menu is used to erase all 
definitions of tempo change and sets the entire arrangement to its average 
tempo. If you want to have a constant tempo from a given bar on, you place 
the play cursor into that beat and select the action “Same Tempo for 
Following Bars”.

If you want to cancel signature changes from a given bar on, you use the 
action “Same Signature for Following Bars”.

If irregular beats within a bar have been defined and you want to change 
them to regular beats, you can use one of the actions “Equal Beats in 
Current Bar” or “Equal Beats in Following Bars”.

If you have defined an irregular tempo by setting a different tempo for each 
bar, the tempo will change at the start of each bar only. If you want to have 
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smooth transitions of tempo changes instead, you select the action 
“Smooth Tempo Changes”. This action will smoothen the whole tempo 
course an will result in irregular beats within each bar.

The action “Set Tempo Zero to Sound Zero” will set the start of the tempo 
definition right to the start of the sound file.

The action “Tempo from Melody” in the action menu takes the tempo 
course of the selected melody as a reference for the entire arrangement - as 
long as this melody was previously detected and has a valid tempo. The 
tempo of that melody will be applied to the whole arrangement.

You can also import a tempo map from another application. This can be 
done in different ways:

■  You can import a MIDI file containing a tempo map with the action 
“Tempo from MIDI File...”. With this action an open panel is opened 
where you can select the MIDI file that should define the tempo.

■   You can record a tempo map via MIDI clock with the action “Tempo from 
MIDI Clock”. This action is only active if Melodyne is in slave mode for 
MIDI Clock, i.e. a MIDI port for MIDI clock has been selected in the 
Preferences, and the “Sync” check box in the Transport Bar is active. If 
you now perform the action “Tempo from MIDI Clock”, tempo map 
recording will be activated and Melodyne will wait for the host 
application to start playback. After playback has been started, the 
relevant time region has been played and transport has been stopped 
again, the recorded tempo map will be applied to the current 
arrangement. As soon this has been performed, the tempo recording 
mode is switched off automatically, and you would have to select “Tempo 
from MIDI Clock” again if you would want to record the tempo again.

■   You can record a tempo map from a host application via MelodyneBridge 
with the action “Tempo from Host Application”. This works the same way 
as just descibed for MIDI Clock, only that the information is transferred 
via the MelodyneBridge. This action will only be available if Melodyne is 
connected to a host application by the MelodyneBridge. If soundfiles are 
recorded from a track in the host application, tempo will be transferred 
along with them automatically. Thus you will only need this option if you 
want to transfer a changed tempo map from the host.
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There are two quite different scenarios of importing a tempo map. One of 
them is done from the action menu of this tool for Tempo Definition, the 
other one with the previous tool for Tempo Editing.

■   In the first case, you have imported one or more sound files that belong 
to an arrangement from another application, and there is an irregular 
tempo defined in that arrangement. In that case, you don’t want to 
change the recording itself when you import the tempo map, you just 
want the notes to find their valid beat assignments to the tempo 
background. For that purpose, you select the respective actions under 
the tool for Tempo Definition.

■   In the second case, you have a valid arrangement within Melodyne, and 
all notes have their valid assignment to their beat positions. Now you 
want to change the tempo of the arrangement according to an external 
tempo map, and of course you want the notes to change their time 
position along with it. For that purpose, you select the respective actions 
under the tool for Tempo Editing.

Generally, the present tool for Tempo Definition is similar to the “The Tool 
to Define the Tempo of a Melody” in the Melody Definition Window, except 
that there, the time assignment of a single melody is defined, whereas here 
the tempo of a whole arrangement is defined. In the corresponding chapter 
on the Melody Definition Window, you can read more on how to proceed in 
editing the tempo definition.

If you defined a tempo of an arrangement that already contained melodies with this tool, 
the defined tempo will not automatically be assigned to these melodies, i.e. their .mdd 
file will not automatically be updated. If you want to use a melody in other arrangements, 
you should assign the valid tempo of the arrangement to that melody. You do so with the 
action “Apply Arrangement Properties...” in the action menu of the selection tool. With 
that action, the tempo and tone scale definition of the arrangement will be applied to the 
definitions of all melodies present in the arrangement, and their .mdd files will be saved 
automatically.
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The Tools in the Editor Window
       

The menus for tool choice, quantize size, playback mode, and track 
selection always remain visible in the inspector bar of the Editor Window. 
The other controls change according to the tool selected and its range of 
applications. 

The quantize menu shows how notes behave when pasted. If no quantize is 
selected they will be inserted directly at the chosen position. If a quantize 
value is selected the notes are pasted relative to the position from where 
they were copied relative to the selected quantize position. If for example 
“Bar Quant” is selected a note copied from a position where it was the third 
eighth in a bar, will be pasted to the closest third eighth of a bar relative to 
the position selected for pasting. This makes it easy to paste melody 
sequences at the right beat position in the bar. 

The “play mode” defines what you can listen to working in the Editor 
Window: if you choose “Play Selected” you can only hear the melody you 
are currently working with; “Play Visible” plays all melodies that are 
currently in the Editor Window together; “Play Arrangement” plays all the 
melodies of the arrangement. 

The menu “track selection” determines which melodies of the arrangement 
appear in the Editor Window. It also switches between the melodies you 
want to process. You can also select a melody by clicking on one of its notes 
if it is already present in the Editor Window. You can also double click a 
melody in the Arrangement Window to transfer it to the Editor Window. The 
last menu option “Remove from Editor” removes the selected melody from 
the Editor Window (of course, it still remains in the arrangement).

track selectionplay modequantize
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The Selection Tool
l

Notes that have been selected with the selection tool can be copied and 
pasted. If you want to copy a melody in its entirety it is necessary to select 
all notes first. In order to duplicate a melody, to create harmony voicings for 
example, it is copied, an empty track is selected via the track select menu, 
and is finally pasted into the empty track. If the pasted melody is supposed 
to run exactly in time with its copied original, it is best to use the “Bar 
Quant” option in the quantize menu- in that case it is not necessary to 
position the pasted track exactly under its copied original version.

A part of a melody can only be inserted where there is enough space for it 
in time. If you want to insert notes into a continuing melody you have to 
separate the melody at the insertion position (see “The Note Separation 
Tools”). Then you must move the following notes in the track and finally 
insert the desired notes.

An exception is the direct replacement of notes. You can copy one or more 
notes, then select those you want to replace and directly replace them. You 
don't have to check that the notes inserted are as long as those they replace 
- the inserted note will shorten itself if required.

The quantize menu shows how notes behave when pasted. If no quantize is 
selected they will be inserted directly at the chosen position. If a quantize 
value is selected the notes are pasted relative to the position from where 
they were copied relative to the selected quantize position. If for example 
“Bar Quant” is selected a note copied from a position where it was the third 
eighth in a bar, will be pasted to the closest third eighth of a bar relative to 
the position selected for pasting. This makes it easy to paste melody 
sequences at the right beat position in the bar. 

If you select the Hand subtool of the Navigation Tool you can simply grab a 
window's content and move it directly in horizontal and vertical directions.

Play note

Scrub mode

Navigation

Play Algorithm

Send Midi
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You can switch that tool to act as a Zoom Tool, either by double clicking 
and dragging on the second click, or by pressing the “Alt” key (“Ctrl” in 
Windows) before or while moving the mouse. As you drag the mouse, you 
will zoom in or out in horizontal and/or vertical directions. 

The Play Algorithm Tool is described in detail in the chapter “The Play 
Algorithms in Melodyne”.

The MIDI Send Parameters Tool is described in detail in the chapter “MIDI 
Playback of Detected Melodies”.

In Melodyne's scrub mode it is possible to listen to the “local sound” at its 
original pitch independently of the tempo (this requires of course a 
previously detected melody). In order to use this option drag the mouse over 
the melody while keeping the mouse button pressed. Depending on the 
selected playback mode, the active melody, all melodies in the Editor 
Window or the entire arrangement will be played.

At the bottom of each subtool list you find the “Play Note” tool that allows 
you to switch easily between editing and listening. The “Play Note” tool 
always plays the selected note or segment if you selected more than one 
note by dragging a selection rectangle with the mouse. You can switch 
between this playback tool and the currently active editing tool quickly with 
the function key F12.

The Pitch Shifting Tools

If you choose the pitch shifting tool, the exact pitch course becomes visible. 
It is in most cases different from the tonal center of a note calculated by 
Melodyne and sways around it.

With this tool the notes can be dragged to new pitches even while the music 
is playing. The phrasing within a note and its formant character will remain 
unchanged by this operation. The transitions between the pitch-shifted 

pitch quantize

Play note

Change pitch transition between notes

Change pitch alignment in a note

note cent hertzaction menu

Change wide pitch alignment in a note
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notes will always be adapted in a musically sensible fashion if desired (see 
the setting of pitch transition below).

The settings in the quantize menu specify how the notes behave when they 
are pitch shifted: “No Snap” allows the pitch to be freely changed without 
reference to tonal intervals.

The “Note Snap” option provides blue rectangles behind the notes that 
indicate their assigned semitone positions. Double clicking on a note in the 
“Note Snap” mode automatically corrects it to its assigned semitone 
position. If all notes are selected and one of them is double clicked, all 
notes will be corrected in pitch to their closest semitone. In this mode the 
notes can only be shifted to semitone intervals. If the score note display is 
visible, you can grab the notes there as well and change their pitch position. 
In this case, they will always behave as if the “Note Snap” mode were 
active.

If “Scale Snap” is selected the blue rectangles will appear in positions that 
fit within the key of the arrangement. A double clicked note now snaps to a 
position within the specified key (to the blue rectangles). If all notes are 
selected and one of them is double clicked, all notes will shift to the closest 
position allowed by the given key. In this mode the names of the notes 
appear as buttons to the left of the window. They allow you to choose the 
scale key. With the a usual mouse click you select the major scale, with the 
a mouse click with the “Shift” key pressed you select the minor scale. The 
key that is chosen here does not change the key of the arrangement but 
solely the assignment of the notes just processed. If all notes are selected 
in this mode you can change the key and all notes will be shifted to their 
respective positions in the new key.

The last two items in the Pitch Quantize Menu are similar to the two 
previous ones, except that they don’t force a note to snap to a position, but 
it allows its movement by a step in semitones or scale steps. Thus these 
modes keep the individual deviation of the pitch curve from the note center 
- useful when editing more “blue” phrasings.

The scale, fundamental pitch and the tuning of the tone steps that you want 
to work with in the respective arrangement can be defined freely - see 
“Defining the Tone Scale and Tuning”.
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The three text fields in the inspector show information concerning the 
currently selected note. The field “Note” shows the name of the note and 
its octave - you can enter a new name to change the note or click and drag 
in the text field to change it in semitone steps. The “Cent” field shows the 
deviation of the note from its defined scale position. 100 cent are 
equivalent to a tempered semitone. i.e. if a note is placed between F and 
F# a possible display in the note field would be “F” and “+45” in the cent 
field. If you move the note up beyond +50 cents, the display will change to 
“F#” in the note field and “-49” in the cent field. In the Hertz field the 
absolute pitch in Hertz is displayed.

If more than one note is selected all three fields will display the value “0”. 
The display now works relative to its starting position: by entering  “-7” in 
the note field the selected notes are lowered by 7 semitones. The same 
effect is achieved by entering “-700” in the cent field.

The “Change Phrasing in the Note” tool amplifies or decreases the course 
of pitch within a note that surrounds the perceived note center. This allows 
you, for example to amplify or decrease a vibrato. At a certain position of 
this control all phrasing disappears and the pitch is completely straightened 
out. If you drag the mouse further down from that position results in an 
inversion of the pitch curve: if it has been rising before it will be falling, 
vibrato is inverted.

With the “Pitch Wide Align Tool”, you can align the pitch course of a note 
to the note center similarly to the previous one, but without canceling out 
vibrato and the fine structure of the pitch course. Thus only the average 
pitch course will be aligned. This is especially useful if a singer or player 
did not keep the pitch of a note constant over a wider range, but his vibrato 
or other phrasing should be kept.

The tool “Change Pitch Transition between Notes” changes the pitch 
transition between adjacent notes. For that purpose blue lines appear at the 
transitions that can be grabbed and dragged upwards or downwards such 
that the transitions can be made steeper or flatter.

The transitions between the pitch-shifted notes will always be adapted in a 
musically sensible fashion if the “Transition” button is active. In the 
detection process, Melodyne tries to decide if adapting the pitch transition 
between two notes seems to be appropriate, according to the continuation 
of their pitch curve and envelope, and sets the transition state accordingly. 

V2.6
p.164
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In addition to that automatic decision, you can switch the “Transition” 
button on or off for all notes or for each note individually. If it is switched 
off, the pitch course for the region of each note will be treated 
independently.

Together with the detection parameters, portamento adaptation can be 
specified in advance as a default “on” or default “off” for a given melody. 
For example, it is set to “off” by default for material that had been specified 
as “unpitched, percussive” on detection. But the original transition 
defaults can be changed at any time after detection with the “Transition” 
button as described.

The “Edit Pitch” action menu applies changes to the currently selected 
notes. The actions “Reset Pitch Center to Original”, “Reset Pitch Align to 
Original”, “Reset Wide Pitch Align to Original”, “Reset Pitch Transition to 
Original” reset the respective properties to their original values. The action 
“Add Random Offset To Pitch Center” offsets each of the selected notes by 
a different random value in the range of a few cents. This can be useful if 
a melody has been copied for voice doubling to avoid each voice sounding 
exactly the same. This action can be used in combination with the similar 
action “Add Random Offset To Time Course” decribed under the time 
editing tools.

With the pitch tool active, a special mode is provided for fast generation of 
harmony voicings: Select some notes, keep the “Alt”-key in Mac /“Ctrl”-key 
in Windows pressed, and drag the notes upward or downward. With this 
action, the selected notes will be copied to a parallel track and will be 
moved up or down in pitch at the same time (it may be useful to have the 
scale snap mode active with this action). 

Additionally, the copied notes will become “scattered” in their time course 
a bit, so that the new voice doesn't sound completely parallel to the original 
one. This feature may not be desired if you copy e.g. percussive material to 
a parallel track. In this case you can use the main menu action “Copy and 
Paste Selection to Parallel Track” which copies the selection without 
changing their time course.
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The Tools to Change the Formant Position

Once the tool to change the formant position is selected, a horizontal bar 
will appear for each note. It displays the formant position relative to the 
pitch of the note. In the neutral position the bar is exactly in the center of 
the note. If a note was pitch shifted the bar is also exactly in the center of 
the note as the formant position was adapted to the new pitch. The formant 
position changes by dragging the bar up or down.

You can also specify the formant position in cents in the text field - 0 cent 
is equal to the original formant position or the adapted formant position for 
notes that were pitch shifted. If a note were shifted downwards by 4 
semitones or 400 cents and you would change the formant position to “-
400” cent in the text field the result will be the pitch shifted note without 
formant correction. If you want to change the character of a voice as a whole 
- e.g., in order to make a soprano voice that was pitch shifted to a tenor 
register sound like a tenor as well - select all notes and change the formant 
value in the text field or drag the formant bar of a note to the desired 
position. 

The Edit Formant Shift Style Tool: there are different ways the formant 
character will change when notes are moved in pitch. With this tool you can 
adapt that Formant Style to your needs. It is the same parameter as 
described with the Playback Algorithm Parameters, but provided as a per-
note parameter here. You won't use this tool often, but sometimes it is good 
for fine-tuning a changed note's sound.

The tool “Change the Formant Transition between Notes” changes the 
speed of transition of the formant position between two notes that were set 
to different values. If the formant position of the entire melody was shifted 
this will not have any effect as the formant position of all notes was shifted 
equally for each.

The “Edit Formant” action menu resets the respective formant related 
properties of the currently selected notes to their original state. 

Play note

Change formant transition between notes

formant in centaction menu

Change formant shift style of notes
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A special formant adaptation can be set in Preferences -> Other; this option 
is called “Formant Follow”. There are two completely different cases of 
what happens when moving notes in pitch with the corresponding formant 
adaptation. In the first case, you may want to edit single notes in a melody 
while the melody, as a whole should stay on the same pitch level. In this 
case, you will expect the spectral content or formant character to be 
adapted to keep the sound character of the melody consistent.

In the other case, you may want to move the whole melody to a different 
register, say, a fifth downward. In this case, you will nearly always adapt the 
formant position of the notes manually, say, move the formant bars down 
by about 3 semitones, to make the sound character fit that new overall pitch 
position. For this case, a general format shift ratio is available that can be 
set in the Preferences. It is only applied if all notes of a melody are selected 
when moving the pitch up or down. Changing this parameter in the 
Preferences will not affect any melodies that have already been edited. It 
only applies the automatic formant following when the user executes the 
action of moving all notes in pitch. You will see that the format bars have 
moved to a new position when you switch to the Formant Tool after editing 
the notes in pitch. If some single notes are altered in pitch after that action, 
the formant bars will keep their relative position to the note's pitch and their 
formant character is adapted to the new general position as usual.

This feature is optional and you can set it to your needs. By default, the 
“Formant Follow” value is set to 0% in Preferences -> Other (leftmost 
position of the slider), which means that this feature is disabled. In its 
rightmost position, the formant position would follow the pitch of the edited 
notes by 100%, in the middle for example the formants would follow 6 
semitones down if the melody is moved down by one octave. 
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The Tools to Change Amplitudes

The tool to change amplitudes changes the dynamics of a single note or of 
a selection of notes when you grab and drag the notes with the mouse.

The change of amplitude relative to its original value in db is displayed in 
the “Amplitude” text field. You can also modify these amplitudes directly 
by typing values into the amplitude text field.

The tool “Change Amplitude Transition between Notes” modifies the speed 
of transition between two notes modified by their amplitudes. 

If you double click on a note with the tool “Mute note” its amplitude will 
be set to 0. A muted note will be displayed as an outline when it is selected, 
and as a simple line if it is not. By double clicking on it yet again with this 
tool the note is switched back on. This would not be possible if you had 
used the “cut” command to remove a note from the arrangement.

The “Edit Amplitude” action menu resets the respective amplitude related 
properties of the currently selected notes to their original state. 

Play note
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The Tools to Change Notes in Time

For your work with these tools, please refer to the chapter “Note Positions and Quantizing 
in Melodyne” as well!

The main tool to change notes in time moves one or more notes in their 
respective time position in the track by grabbing them with the mouse and 
dragging them horizontally to the desired position. This tool is useful to 
make subtle changes of phrasing in time; it is also useful if you want to 
move notes to a new beat.

Depending on its context, a modified note will behave in different ways: if 
it is located directly before a rest, the note is moved as a whole unchanged 
in its length. If however the note is followed directly by another note, it will 
be shortened or lengthened according to the start of the next note. The 
same change will occur with notes that immediately precede the moved 
note.

The chosen quantize size is relevant only if you want to move notes to a 
different beat: dragging the note with the mouse will only be limited to the 
quantized steps. This will only work if there is enough space before or after 
a note in the direction you want to move the note. Moving a group of notes 
is subject to the same restrictions as if a quantize for the whole bar is 
chosen. It will only be possible to move the group if there is a large enough 
rest where you want to move the notes.

If you use the arrow buttons in the inspector bar to move notes, they will 
move according to the quantize value specified, providing there is enough 
space. If no quantize value is chosen, the arrow buttons remain inactive.

Please note that with this tool the current setting of the quantize value is 
used to move notes by a certain step, not to a quantized position. If 
quantizing to a beat grid is intended, please use the quantize tool described 
below.

Play note

Stretch notes
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Change initial speed of notes
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If you want to change subtleties in the time phrasing the quantize value 
must be switched off in the inspector bar.

The “Stretch Notes” tool lengthens or shortens a note in time. If you grab 
a note before its midpoint you change its length from the front. The reverse 
happens if you grab the note in its endpoint. The change of a selected group 
of notes is also dependent upon where you grab them - beginning or end. If 
you select all notes you can stretch the entire melody in time - this however 
is only a useful option if the melody really is supposed to be altered in 
tempo relative to the time of the arrangement. If you want to change the 
entire arrangement in time please see the chapter on “The Tool to Modify 
the Tempo of an Arrangement” in the Arrangement Window.

With the tool “Quantize Note Positions”, a note or a selection of notes will 
be moved to their assigned beat positions. In fact, this tool is used for two 
different purposes: On one hand for moving the beat assignment of a note 
to a different position, which is done by horizontal movement, and the 
actual quantising on the other hand, which is done with a vertical 
movement. The snap position is not dependent upon the specified quantize 
size, but only on the assigned beat position for each note. 

When the “Quantize Note Positions” tool is active, you will see the 
quantized target position of each note displayed as a note outline. The 
assigned position can be edited either by grabbing the note and moving it 
horizontally in its usual representation in the editor, or its score 
representation if visible. The quantize size pop-up button in the inspector 
bar determines the resolution of quanta positions to which notes can be 
assigned. You can also specify triplet positions here.

Quantising is a continuous parameter, displayed between 0% and 100% 
with the “Quantize Notes” tool active. The value is changed by selecting 
notes and dragging the mouse up or down with the mouse button pressed. 
You will see the notes approach their quantized position. When a note is 
quantized to 100%, the actual note will move when the position of its beat 
assignment is edited, while only its assignment representation will move 
when the quantize value is 0%.

Modifying the quantize value with a vertical movement will always apply to 
all selected notes, whereas moving the assigned beat to a different position 
with a horizontal movement only applies to the note you actually grabbed.
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As a default, the tempo grid of the arrangement itself is used for quantizing 
(“hard” quantizing), but you can also use the time behavior of another 
melody present in the arrangement for quantizing. In that case, that melody 
is called the “Quantize Master”. If you want to use a melody as a quantize 
master, it is essential that both the master melody as well as the melody to 
be quantized have valid beat position assignments, i.e., the melodies 
should be carefully checked and edited if necessary. If a melody is used as 
a quantize master, the other melodies will take their time phrasing from that 
melody, i.e., its small deviations from the assigned beat positions. The 
master melody (or Time Track as master) can be selected via a pull down 
menu when the Quantize Tool is active. If the master melody for a melody 
has been changed, you will see the outlines representing the quantized 
position move to their new positions immediately, but you will have to select 
all the notes that should adapt to the master and double click them to move 
to the new position. Of course, this will only happen consistent with their 
individually set quantize value, i.e., nothing will happen if their quantize 
value is 0%.

The tool to “Change Initial Speed of a Note” shortens or lengthens the 
attack of the selected note. This allows you to give the melody a softer or 
harder attack, i.e. to make it sound more staccato or legato. Upon choosing 
this tool a little “lever” appears. If you grab the blue point at its beginning 
and pull it upward you increase the speed of attack, if you pull it downward 
you decrease it. If you drag out the lever as a whole the region upon which 
the changes take effect is extended. If the overall tempo is changed this 
happens automatically such that pluck and wind noises as well as 
consonants in sung pieces remain unchanged whatever the tempo of the 
overall arrangement.

You can also modify the initial speed of notes with the “Attack” text field. 
Here, “0%” corresponds to the original speed, “100%” is the maximum 
and    “-100%” is the minimum speed. Changing the attack with the text 
field is especially useful if you want to change the characteristics of several 
or all notes simultaneously.

The “Edit Time” action menu resets the respective time related properties 
of the currently selected notes to their original state. The action “Reset 
Relative Time Course to Original” will set the selected notes to their relative 
time course of the original, but will keep their current overall duration if 
they have been stretched. The action “Reset Time and Duration to Original” 
will reset the complete time course including the duration if there is enough 
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room after the selection to reset the selected notes to their original length. 
The action “Reset Notes Quantise” will reset the selected notes to their 
unquantized position. The action “Reset Note Time Handles to Original” 
will set the attack and the internal time course of the selected notes to their 
original state.

The action “Add Random Offset To Time Course” will “scatter” the selected 
notes in their time course a bit. This action can be useful if a melody has 
been copied for voice doubling to avoid each voice sounding exactly the 
same. This action can be used in combination with the similar action “Add 
Random Offset To Pitch Center” decribed under the pitch editing tools.

The Note Separation Tools
   

The tool to change the separation of notes defines which segments of the 
recorded audio material are to be considered as single notes. These become 
the smallest units of modification. Melodyne makes an initial separation 
automatically; however, you can of course change these first note-
separations manually. 

At this point, to work successfully with Melodyne, you must first understand 
the fundamental difference between the definition of a melody and the 
editing of a melody. The note separation tool is also available in the Melody 
Definition Window. All changes of note separation that concern melody 
definition must be made there, i.e., if you want to correct an originally 
undetected separation of two notes. All detection errors or modification to 
melody definitions should be done in the Melody Definition Window before 
moving on to the editing process. See also the Chapter on “The Note 
Separation Tool” in the Melody Definition Window.

In the Editor Window, this tool is used to change note separations for 
editing purposes. For example, you may want to add a complementary 
ornament, or give a melodious character to a long held note by cutting it 
apart and thus create new individual notes which can be modified in pitch.

Play note

Separate segments
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Vertical lines appear between the notes if this tool is selected. They indicate 
the note separation. If you want to change the position of a note separation, 
grab the separation line and move it. If you want to divide a note, double 
click on it at the desired location. A new separation will appear there and 
both notes will recalculate their pitch center. Melodyne attempts to detect 
the best place to divide notes. This might cause the separation line to 
appear not exactly where you clicked. If you want to change this, you can 
grab the line and drag it to where you want the separation to be. To hear 
whether the separation is at the desired place, you can play a selected note 
by pressing the space bar on the computer keyboard or click the note with 
the “Play Note” tool to listen to it. In the play note mode, the note will be 
played exactly between its separation lines.

If you want to cancel a separation and unite two notes, double click the 
separation line between them. To unite more than two notes, select all of 
them with a selection rectangle and double click one of the selected notes 
- they will be fused to one note.

The tool to separate segments cuts parts of the melody into freestanding 
segments. Two notes that follow upon each other directly will always be 
treated by Melodyne such that if the second one is moved the first one is 
stretched accordingly in order to keep the audio material flowing. All that 
is changed is the course of time. If you want to insert a long rest between 
two notes that will move a following group of notes without stretching a note 
it is best to introduce a segment separation. This can also be applied if you 
want to shorten the end of a note without changing the start of the next one.

To insert a segment separation, double click on an existing separation line 
between two notes. Now a segment separation marker appears at the 
beginning and end of a segment. This segment can now be modified 
independent of the time of the rest of the melody. Separated segments can 
also be united again by double clicking between segment separation 
markers. Of course, you can only combine segments that fit together in time 
in the original recording.

If you have separated a segment in order to move all subsequent notes, you 
can select the first note of that segment and select all notes after that one 
by choosing “Select following Notes” from the menu “Edit -> Select”.

If a melody was created using copy and paste, each “paste” event has 
created a separate segment. You can see the segments if the note 
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separation mode is active. You can also move the start and end limits of 
these segments if there is enough space for such a movement. This allows 
you to hear the part of the melody that was previously not defined as part 
of the note. This is useful for example if you want to copy some notes of a 
vocal line including the initial breath of the singer. The initial breath might 
not have been copied together with the first note, but can be recovered with 
this tool. In order to apply this technique you just grab the left segment 
range marker of the pasted melody and pull it further left. The previously 
unheard part of the recording is recovered.

Segment separation can also be used to play back segments of a melody on 
a track with different algorithms, as described in the chapter on the 
playback algorithms in Melodyne.

You can toggle between the Note Separation and Segment Separation tools 
comfortably with the “Alt”-key in Mac /“Ctrl”-key in Windows.
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Detecting and Defining a Melody

What Type of Material is Suited for Melodyne?

In general all musically monophonic sound material is suitable for 
Melodyne. That is, recordings that do not contain more than one voice. This 
includes those instruments that are naturally monophonic such as the 
human voice and all types of wind and brass instruments. 

Stringed instruments are suitable with some restrictions: bowed strings like 
a violin only if played without double voicings and plucked strings like a 
guitar only if solo lines are played without chords. Unplayed strings should 
also not be heard too loudly in the recording. Theoretically even piano music 
can be processed with Melodyne under the unlikely condition that it is 
played as a single line. Instruments that have a long sustain such as the 
harp are unlikely candidates even when played as a single melody since the 
harp's sustain automatically creates polyphony. 

Percussion and drum loops are very well suited as well as human speech.

However, music that has more than one musician at a time on a track as 
well as whole mixes are not suitable input to Melodyne.

If you want to process music with Melodyne each musician should be 
assigned their own track during the recording. If it is necessary to record 
musicians simultaneously you should take care that the different tracks 
remain as pure as possible given the circumstances. The recording should 
be as “dry” as possible - without any reverb as, again, this would create 
polyphony.
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Detecting a Melody

Either you can record directly with Melodyne as described in “Recording 
with Melodyne”, or you can load an already recorded melody as a sound file 
in Melodyne. To load a melody open the file using File - >Open in the menu. 
A new arrangement is created and the melody is loaded in the first track. 

In opening the sound file, Melodyne automatically tries to detect the tempo 
of the melody and that tempo is assigned to the arrangement (and to the 
melody itself).

If there are great tempo variations in the melody, Melodyne will only be able 
to establish an average tempo. This has to be worked over manually as 
described under the next heading.

As long as the melody has not been detected you will see it as an envelope 
display that you may be acquainted with from other programs. To start the 
detection process, double click the melody or use the “Detect Melody” item 
in the action menu. In the detection window that appears, you usually only 
need to click “Detect” to start detection.

You can also access the Sound Files Panel via the menu item Windows -> 
Sound Files.

Optional Batch Detection: All sound files currently used will be visible in the 
detection panel and can all be detected together if desired. Additionally, 
there is detailed information about the individual sound files shown in the 
right part of the panel. The files to be detected can be selected with the 
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checkbox button. If a previously detected sound file should be redetected 
with different parameters, this can be done by double clicking that button. 
The detection parameters for the currently selected sound file are optionally 
shown in the lower part of the panel (if the triangle in the lower left of the 
box has been clicked to extend the box).

Detailed Access to Detection Parameters: You can either set each detection 
parameter individually, or you can choose a set of parameters from the pull 
down menu. After choosing a parameter set, the parameters can still be 
altered individually. The most used choices will be “Pitched, Melodic” and 
“Unpitched, Percussive”. After selecting a parameter set, you could still set 
the Pitch range from C3 to G4 for example, if you know that the content of 
the melody to be detected is only in that range. But in most cases you will 
just choose “Pitched, Melodic” or “Unpitched, Percussive” and leave 
everything else as it is without taking a look at the parameters.
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What the parameters do in detail:

Pitch Range: The range in which the program tries to find note pitches 
(fundamentals). If you know the range of a melody for sure, you can set the 
range as narrow as possible to avoid octave detection errors. The limitations 
on the pitch range of an instrument may also be useful for example to 
exclude a bass that can be heard in the background of a recording of a high 
pitched solo instrument - but generally you can leave this parameter as 
given.

Separation: By Pitch / By Attack Only: Melodic material should always be 
separated by pitch, whereas in unpitched percussive material the pitch 
doesn't have much meaning and thus the note attacks would be the only 
criteria. Also in the case of speech, the syllables should only be separated 
by attack, not by pitch.

Tempo: Arrangement Tempo / Own Tempo: When “Arrangement Tempo” is 
chosen, the melody detection will skip tempo detection and take the 
arrangement tempo. This option will be set to “Arrangement Tempo” in 
nearly all cases, as a tempo detection has already been performed. Only if 
you add an undetected melody to an arrangement with a tempo that is 
supposed to be different from the melody’s tempo, should you choose “Own 
Tempo” to perform independent tempo detection.

Separation Sensitivity: Determines if more or less segments will be detected 
as separate notes. If separation mode is set to “By Pitch” (see above), pitch 
will be the main aspect of note separation. Thus this parameter will have 
greater effect on percussive material, when separation mode is set to “By 
Attack Only”. The same parameter is available after detection in the Melody 
Definition Window to modify separation without having to redetect the 
whole melody, see Note Separation Tool.

Amplitude Sensitivity: Determines the threshold below which segments are 
considered to be silence. If the slider is set to its rightmost position, no 
silence at all will be defined, and the silence after a note decay will always 
be considered to belong to that note. This parameter may also affect note 
separation. The same parameter is available after detection in the Melody 
Definition Window to modify separation without having to redetect the 
whole melody, see Note Separation Tool.
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Pitch Tracking Sensitivity: Is set to a low value if the pitch information in 
melodic notes is quite clear to prevent the tracking of irrelevant pitch in 
noisy parts of notes. On the other hand, will be set to a high value for more 
percussive sounds or sound with less dominant pitch informantion, e.g. 
speech, to prevent pitch tracking from stopping too early. The same 
parameter is available after detection in the Melody Definition Window for 
single notes to correct pitch tracking manually if appropriate, see Correct 
Pitch Detection Tool.

In the lower part of the panel, there are some “Melody Property” 
parameters, that don't affect the melody detection itself, but rather 
determine how the melody is treated generally afterwards on editing and 
playback:

Notation: Tonal / Rhythmic: Determines if the notation of that melody is 
displayed as rhythm notation on a single line, or as the usual notation for 
melodic material.

Portamento: Treat Notes Separately / Track Portamento: On detection, 
portamento will always be tracked, of course. But later on, when you edit 
the melody by moving notes in pitch, you may want the program to 
reproduce a consistent portamento between altered notes similar to the 
original one, or you may want it to treat each note separately. Here, this is 
just a default setting, you can change that behavior afterwards in the Editor 
Window for the whole melody or per note, see Pitch Transition Tool.

Play Algorithm: Note Based / Time Based: This is just a default setting that 
determines the play algorithm used right after detection. Of course, you can 
change the play algorithm at any time, as described in the chapter about 
selection of sound synthesis algorithm parameters.

Start the detection process by pressing the “Detect” button. The process 
will take about as long as it would take to play the tune - dependent of 
course on your processor speed and on the material to be detected.

When the detection is complete you can see the melody in its track and its 
notes organized by pitch. This display also allows you to recognize whether 
a melody was previously analyzed by Melodyne.
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There is a special setting for the parameters if the start and duration of your 
soundfiles is already determined before processing them with Melodyne, 
and their start and duration should not be changed by Melodyne’s note- and 
silence detection. This may be the case if you use Melodyne as a sample 
editor. In this case, make the following settings in the detection panel: 1. 
Move the “Amplitude Sensitivity” slider to its far right. 2. Move the 
“Separation Sensitivity” slider to its far left. Thus no notes will be separated 
and no silence will be cut off at the start or end of the sample.

Processing the Melody Definition

On detecting a melody, Melodyne automatically creates a file on your hard 
disk that contains the detection and definition data of the detected melody. 
It is located in the same folder as the original sound file and shares its same 
name. It has the additional ending .mdd (stands for melody definition data). 
If this detection file is present the respective melody can be used in any 
arrangement without it having to be detected over again.

Never delete the .mdd- file if its corresponding sound file is used in an arrangement and 
always copy the .mdd- file along with the sound file if you transfer it a to different 
computer! 

The Melody Definition File

After Melodyne has detected the melody, it is accessible for further editing. 
If all is well, Melodyne has detected the melody correctly in all its 
parameters - depending on the raw material this will be true 90% - 100% 
of the time. It is possible however that a note has been wrongly detected 
(i.e., an octave too high or too low in pitch, a note too many or a note too 
few separated from its neighbors, or an unclear rhythmical arrangement has 
been wrongly detected). Thus, you should always open a newly detected 
melody in the definition mode first, if only to check that all has indeed been 
correctly analyzed. If you only want to have a go at correcting some 
intonations or changing the tempo, eventual detection mistakes will 
scarcely come through at all and you can work with the melody at once. Yet, 
you should make it a Melodyne habit to carefully check the definition of a 
detected melody and if necessary make some corrections. Working in this 
way will make it abundantly easy to use the melody in other arrangements 
and over time you will have a wonderful collection of universally applicable 
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melodies. If you want to use a detected percussion track later on in an 
arrangement in a different tempo from the original tempo, the track will 
automatically adapt to the new tempo - of course, only if its detection and 
definition is correct. 

There is a fundamental difference between the definition of a melody and 
editing a melody. 

The definition process leaves the melody musically and tonally unchanged. 
It only defines how the content of a sound file is to be understood musically. 
Editing the definition is equivalent to editing the melody definition file 
(.mdd) that you change in modifying the definition of a melody. There is 
only one melody definition file for each sound file, which relates to the 
soundfile's original content.

Editing a melody on the contrary changes its musical and tonal content - 
this is the actual musical work done with Melodyne; definition is its 
prerequisite. There are no limitations to how many versions of an edited 
melody one can make derived from the same detected and defined sound 
file. These versions can be melodies on one or more tracks in an 
arrangement that is saved as a “Melodyne-Arrangement”.

An unedited original is always available as long as Melodyne has detected 
it, as its definition was saved to an .mdd file.

Working in the Melody Definition Window

The definition of a melody is checked and edited in the Melody Definition 
Window. With the tools that are available there you can:

■  correct the pitch of falsely identified notes

■  change the position of note separations

■  define the signature and tempo of a melody

■  correct the assignment of the notes to their intended beat

■   correct the assignment of the notes to their intended semitone positions

V2.6
p.156
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You can open the Melody Definition Window from the Arrangement Window 
by selecting an already detected melody and then choose “Edit Definition” 
in the “Define Melody” action menu. Alternatively, you can also open the 
Melody Definition Window for a selected sound file directly from the Melody 
Manager.

The Melody Definition Window is conceptually similar to the Editor Window. 
Yet, there are different tools available in this window. Here the task is not 
to change the melody but only to define it. In order to differentiate the 
Definition Window from the other Windows the Definition Window has a red 
background as compared to blue in the arrangement and Editor Window.
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The Tools of the Melody Definition Window

It is useful to use a specific order of steps to define a melody - first, the 
occasionally falsely detected notes should be corrected in their pitch; 
second, the note separation should be checked. Only then should the tempo 
be defined. The buttons in the Melody Definition Window are arranged 
accordingly from left to right. In some cases it may be necessary to switch 
between tools which is, of course, possible.

The Selection Tool
       

The selection tool itself has no special function in the definition mode, as 
there is no copy and paste function available in this window. The same 
subtools as in the other windows for navigation, for selecting a play 
algorithm, for playing single notes and the scrub mode are available.

 Play Algorithm Tool: You can select the default play algorithm for a melody. 
This play algorithm will be saved with the melody definition and will be used 
as default play algorithm when you use that melody in any arrangement. If 
you selected a play algorithm only for temporary listening purposes during 
melody definition, please make sure to select the desired default play 
algorithm again before saving the melody definition!

The menu item “Redetect Melody” in the action menu serves to redetect 
the entire melody if other detection parameters than the ones previously 
chosen seem appropriate. If you tried to detect a percussion track with the 
option “Pitched, Melodic”, and the note separations here turn out to be 
somewhat unsatisfactory for your use, it is possible to repeat the detection 
process with better parameters from here. 

The menu item “Tone Scale...” opens the panel where you can define the 
tone scale, as described in the chapter “Defining the Tone Scale and 
Tuning”. The tone scale you define here is not assigned to an arrangement, 
but to the melody itself. “Take tone Scale From Arrangement” assigns the 

Play note

Scrub mode

action menu

Navigation

Play Algorithm
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tone scale of the arrangement where the melody definition was opened from 
to the current melody definition.

The Tool to Correct the Detected Pitch

This tool is used to correct notes that were detected on a wrong pitch by 
Melodyne. It is possible that the fundamental of a note is scarcely present 
in its sound. Thus, it may be detected an octave higher than it actually is. 
It is also possible that the sound of a note contains “roughness”, which 
would lead to an inaccurate detection an octave too low. Detection mistakes 
other than false octave identification are rare. The detected pitch of a 
selected note is displayed in the text fields in the inspector bar as note 
name and deviation in cent, and in hertz.

In order to set the pitch of the note to be detected anew, drag the note with 
the pitch correcting tool near the position you suppose to be correct. If 
appropriate, you can also drag a group of notes. Melodyne will attempt to 
recalculate the pitch curve in the region of the new pitch position. 
Sometimes, notes whose tonal content was too unclear may be attached to 
their direct neighbors as undetected notes. These can then be separated 
with the note separation tool and the undetected note then dragged to its 
supposed actual position. 

Redetection could possibly also change the tonal course of neighboring 
notes. If it seems to you that the result of a displayed tonal course is not 
very likely in this context, double click the note without moving it. Melodyne 
will then re-evaluate the pitch course.

For pitch redetection, there is a “Detection Sensitivity” parameter, which 
can be set with the slider. This parameter determines how far the pitch 
course is followed if it becomes very irregular. This parameter has been set 
to a lower value for pitched material or to a higher value for unpitched notes 
by default before detection, but it can be set to any value that is appropriate 
to detect the present material. Here, pitch redetection is always performed 
for a single note and the sensitivity can be set to a different value for each 

Play notes resynthesized

Play note

note cent hertz pitch tracking sensitivity
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note if appropriate. If a note is selected, redetection will be performed for 
that note immediately after setting the sensitivity slider to a new value.

The first subtool attached to the pitch correcting tool does not play the 
melody with its original sound. It resynthesizes the notes whereby it is a lot 
easier to find possible mistakes just by listening.

If you have to change between the Pitch Correction Tool and the Note 
Separation Tool often when editing the melody definition, you can toggle 
between these tools comfortably with the “Alt”-key in Mac /“Ctrl”-key in 
Windows.

The Note Separation Tool

It is often a question of interpretation whether an ornament is musically an 
independent note or whether it is integrated with its main note - and even 
Melodyne is not a flawless interpreter of musician’s meaning. Thus, you can 
change note separations with the note separation tool. 

If you select the note separation tool vertical lines will appear between the 
notes in the melody. They indicate the note separation. If you want to 
change the position of a note separation, grab the separation line and move 
it. If you want to divide a note double click on it at the desired location. A 
new separation will appear there and both notes will recalculate their pitch 
center. Melodyne attempts to detect the best suited place to divide notes. 
This might cause the separation line to appear not exactly where you 
clicked. If you want to change this, you can grab the line and drag it to 
where you want the separation to be. To hear whether the separation is at 
the desired place, you can play a selected note by pressing the space bar 
on the computer keyboard or click the note with the “Play Note” tool to 
listen to it. In that play mode, the note range will be played exactly between 
its separation lines.

If you want to cancel a separation and unite two notes, double click the 
separation line between them. To unite more than two notes, select all of 
them with a selection rectangle and double click one of the selected notes 
- they will be fused to one note.

Play note

separation silence detection separation mode

V2.6
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A comfortable way to check the note separation quickly and edit them is to 
go through them with the cursor keys on your computer keyboard. Place the 
play position in front of the first note and press the right cursor key. Now 
you will hear the first note exactly up until its separation line. Using the 
right and left cursor keys you can listen to the notes forwards and 
backwards- if you hear two notes that should have been separated press the 
down cursor key. Melodyne will then separate the note you heard last where 
it considers a separation to be the most probable. If Melodyne were to be 
mistaken, grab the separation line and move it with the mouse to the correct 
position. If you hear two separate notes that should actually be one note, 
press the up cursor key and the last two notes you heard will be fused.

Separation Sensitivity Slider: Determines if more or less segments will be 
detected as separate notes. If separation mode is set to “Separate By Pitch” 
with the check box on the right, pitch will be the main aspect of note 
separation. Thus this parameter will have greater effect on percussive 
material. The re-separation will be performed for the whole melody 
immediately after setting the slider to a new value.

Silence Sensitivity Slider: Determines the threshold below which segments 
are considered to be silence. If the slider is set to its rightmost position, no 
silence at all will be defined, and the silence after a note decay will always 
be considered to belong to that note. This parameter may also affect note 
separation. The re-separation will be performed for the whole melody 
immediately.

With the note separation tool you can also change the start of the first note 
and the ending of the last note: Melodyne may have cut off a breathing 
noise at the start of a melody you want to keep; or Melodyne may have cut 
the decay at the end of the last note too early. If you want to recover these 
elements grab the left (beginning) or right (ending) segment separation and 
move it. The previously unheard part of the recording is now recovered.

If you have to change between the Pitch Correction Tool and the Note 
Separation Tool often when editing the melody definition, you can toggle 
between these tools comfortably with the “Alt”-key in Mac /“Ctrl”-key in 
Windows.
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The Tool to Define the Tempo of a Melody
   

This tool defines the relation the melody has to time and signature. 
Melodyne attempts to find the correct tempo in the detection process. If the 
material is rhythmical in nature and holds a constant beat, it is probable 
that Melodyne will make a correct identification. If the tempo is generally 
constant throughout the piece, yet a few beats are before or after their 
intended beat, Melodyne will set the bar background such that the best 
congruence with the played material is reached. If the detection was 
successful you might still need to move the first bar start to its intended 
position as the first beat of a bar may not always be recognized. The best 
way to correct this is to choose “1/4” in the quantize menu. Then use the 
arrow buttons in the inspector bar to move the bar start of the background 
to where the first beat of the bar is located in the melody.

Next to the signature denominator field, there is a checkbox labeled “1/8 
T” (if the denominator is 4). If it is set active, the program assumes that 
each quarter beat is divided into triplets and will prefer triplet positions on 
automatic detection of the score note position assignment. On switching it 
on or off, a new detection of score note positions will be performed. If there 
are multiple bar starts defined, you will find the “All Triplets” action in the 
Action Menu to switch triplets on or off for all defined bars at once.

If the tempo was correctly identified but you want to define the signature 
set by Melodyne in quarter notes to eighth notes you can change this in the 
action menu. Choose “Half Tempo” in action menu. In the reverse case 
choose “Double Tempo”.

If the tempo is irregular throughout the arrangement it will have to be re-
edited in most cases. It is best to activate the metronome for that purpose.

Choose the tool for defining the tempo of the melody. First enter the 
signature you desire in the signature fields - if it is not in common time. If 
you choose the tool to define the tempo of the melody a yellow line will 
appear at the start of the first bar. That is our “time anchor”. If you grab 
and drag this line the entire bar background moves with it. Yet, if you grab 
the background at some other place at the start of a beat you change the 
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action menu signature triplets quantizetempo
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tempo without moving the time anchor. At first the time anchor is located 
at the start of the first bar, however it is not necessary that it remain there. 
You can affix it to a note - wherever in the bar it is located - by double 
clicking on it if you think it represents the beat of the entire piece best. The 
time anchor will then move to the start of that note. If in your piece the third 
beat of a bar best represents the beat of the piece move the time anchor 
such that the third beat is very close to the start of the note to which you 
want to throw the anchor, double click on the note once more and the 
anchor is cast. Playing the music with the metronome click, you can now 
find the best tempo for the melody by varying the tempo. 

If you found a tempo that you think is appropriate you can get Melodyne to 
set this tempo and its general disposition to fit the present notes by 
choosing “Optimize Tempo” in the action menu. (whether this proves to be 
successful depends largely on the material you want to detect...) This 
option is only available if no independent tempo segments were previously 
defined. 

A melody which is sung or played with completely free tempo or with 
strongly varied tempo can and should be defined bar by bar in order to 
achieve an ideal assignment of notes to their beats or allow the notes to find 
their intended place in the beat. This is also required for inserting such a 
melody later into a different arrangement; only then will the melody adapt 
to the tempo of the new arrangement correctly.

Placing the bar starts is quite comfortable and - having practiced a little - 
should allow you to finish this task in just one playing of the melody: drag 
the time anchor to the start of the first note in the first bar and stretch or 
compress the tempo by grabbing the next bar start such that it comes to 
rest close to the first note of the next bar. Triple click the note. The bar start 
will snap to that note and a red line will appear, which displays the start of 
a new tempo definition. If the first note of the next bar again is somewhat 
close to the start of the bar triple click that note as well. If it is too far away 
adjust the tempo a little by dragging the background and then triple click 
the note. 

The difference between double click and triple click actions here is: With a 
double click on a note you set the closest beat to the start of that note. With 
another double click on the background you insert a new bar definition 
there. With a triple click on a note you perform both actions at the same 
time.
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In this fashion you click yourself from bar to bar through the entire melody. 
With a little experience you will be doing this while the music is playing: 
engage the metronome click over the menu item Play -> Click. In the 
“Temporary Play Offsets” window activated by the menu item Windows -> 
Temporary Play Offsets you can reduce the playing speed as far as you like 
and set the bar start while the music is playing. This change of playback 
speed of course in no way influences the tempo that you are about to 
process and define.

You can also change the tempo at a bar start without having to anchor it 
with a note by clicking in the background at the start of a bar where no note 
is present. A set tempo change can be cancelled by double clicking on that 
particular bar start again. 

If you want to cancel all tempo changes you can do this by the action “Equal 
Tempo” in the action menu. If you want to have a constant tempo from a 
given bar on, you place the play cursor into that beat and select the action 
“Same Tempo for Following Bars”.

If you want to cancel signature changes from a given bar on, you use the 
action “Same Signature for Following Bars”.

If irregular beats within a bar have been defined and you want to change 
them to regular beats, you can use one of the actions “Equal Beats in 
Current Bar” or “Equal Beats in Following Bars”.

If you have defined an irregular tempo by setting a different tempo for each 
bar, the tempo will change at the start of each bar only. If you want to have 
smooth transitions of tempo changes, you select the action “Smooth Tempo 
Changes”. This action will smoothen the whole tempo course an will result 
in irregular beats within each bar.

If the melody that is supposed to be defined was opened from an 
arrangement that contains several melodies it will appear with its own 
tempo in the Definition Window if it was identified in the detection process. 
This tempo does not have to be identical to the tempo of the arrangement 
from which it was opened. If you want to assign the tempo of the current 
arrangement to the definition of the melody you can do so with the action 
“Tempo from Arrangement” in the action menu.
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Another action in the Action Menu is labeled “Set Tempo Zero to Sound 
Zero”. This will set the start of the tempo definition right to the start of the 
sound file.

The Tool to Assign the Notes to their Intended Beats
  

If the tempo was correctly defined the notation display of the melody will 
get a lot neater and more correct at once. Yet, maybe it is not entirely 
equivalent to what the musicians would have in front of them while 
recording the piece - or, to put this differently, the way it was musically 
intended. A musician does not play like a machine, nor would we want them 
to. We do not want to change that here. (We are in the Definition Mode and 
do not want to change the music anyway!) Yet, we want to assign the notes 
played to the intended notes. That will allow a very intuitive and flexible way 
to work musically with Melodyne later on. 

If you choose the tool to assign the notes to their intended beats, the notes 
will temporarily be moved to exactly the place that corresponds to their 
representation by the score notes in the above score display. These assigned 
positions are displayed by the note’s outlines, whereas their actual position 
is still displayed in the background. You can now listen to the music in this 
quantized version and decide whether the intention you can see in the score 
comes through. If the melody is not written correctly in the score, you can 
grab the notes and move them to the intended place. You can grab the notes 
either in their score representation above, or in their outline representation 
below. Thus, they will also be played in a different manner rhythmically.

With the quantize menu you define the smallest unit by which the notes can 
be moved on assignment. If a note had been assigned automatically to a 
beat with smaller units than the ones defined in the quantize menu, it will 
move to the closest beat position allowed by that size first.

If the notes are written correctly in the score, but are still somewhat off beat 
when you listen to the melody, you choose the “Correct Beat Anchor” tool 
and drag the outline representation of the note to the place where it sounds 
the way it is supposed to according to the score. In this case, you move the 

Correct beat anchor

quantize

Play note
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note attack anchor within the sound material, whereas by moving the notes 
with the main tool, you assign that attack anchor to a place in the notation.

If you choose a different tool this temporary quantising will disappear. 
Remember: we do not change the melody in the Definition Mode!

The Tool to Assign the Notes to their Intended Semitones
  

If the pitch of a note is not clear enough with respect to its tonal position it 
can be assigned to a semitone with this tool. The assignments appear as a 
blue background in the shiftable semitone steps. With this tool, the melody 
is played with the pitch assigned to these quantified steps such that simply 
listening to the melody can check the assignment.

For the difference between the two tools of this group, a bit of explanation 
may be useful: Right after detection, there is just the pitch course in a 
region that has been defined to be a note. Then, Melodyne tries to detect 
where the “pitch center” of that pitch course may be that the listener would 
perceive as the “pitch” of the note. This pitch center, of course, will not 
necessarily be identical to the pitch of one of the given note steps in a scale. 
So, in a third step, Melodyne tries to assign the note's pitch center to a note 
step in the given tone scale. These are the positions the notes would move 
to if they were quantized in pitch. These positions are represented by the 
blue rectangles behind the notes and will always be located exactly on one 
of the “key” positions, whereas the position of the note pitch itself may be 
located somewhere between two keys. The Define Pitch Assignment Tool 
serves to assign an empirical note center to a key position where it is meant 
to be and to where it would be pitch corrected. For that purpose, you would 
move the blue rectangles to the intended key position.

On the other hand, the initial attempt of the program to derive a pitch 
center from a pitch course that may be quite irregular may not have been 
satisfying. This can only be corrected by listening and is done with the 
Correct Pitch Center Tool. With this tool active, the notes will be temporarily 
quantized to the pitch positions they are assigned to, and now you can 
judge by listening if the detection of the pitch center is appropriate. If not, 
you grab the pitch course indicated by the red curve and move it up or down 

Correct pitch center

Play note
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until it sounds “right”. This in turn will correct the center of the pitch 
course. Caution: if you re-separate the note or move the note’s separation 
line after that correction, you will have to check a corrected pitch center 
again, as Melodyne always tries to find the pitch center of a note each time 
its boundaries are changed.

Generally, you will need to use the Correct Pitch Center Tool in very few 
cases.

The Tool to Define Note Start Regions
   

 The Define Time Handle Tool is not really related to a property that has 
been “detected” in the detection process, but it nevertheless changes a 
property that belongs to a note's definition. You will remember that when 
changing the tempo of a melody, the region around the start of each note 
will be kept at its original speed. It largely depends on the material how far 
this “region around the start of each note” should extend to give good 
results. You may change the size of these regions in forward and backward 
direction by moving these handles. You can change the overall tempo of the 
melody in the “Temporary Play Offsets” panel to hear how the notes behave 
when changing the size of the region around the note starts. 

Of course, you can still edit the time handles later in Edit Mode for special 
purposes. This just defines a general behavior on tempo changes.

Play note
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Confirming Melody Definition Changes
You can save your work on the melody definition at any time with the usual 
“Save” command respectively “ /Ctrl - S”. If you have not saved your 
work, you can decide on closing the Melody Definition Window whether you 
want to keep the changes you made.

In the Melody Definition Window, with “Save”, the melody definition will be saved, thus 
updating the “.mdd” file that refers to your original sound file. It is not an Arrangement 
that is saved as usual!

If you confirmed the changes, the melody in the arrangement from which 
the Melody Definition Window was opened will automatically be updated 
with the new detection data, if that melody had not yet been edited.

If you already made some changes prior to defining the melody, it will not 
be automatically updated. If you still would want to apply your changes of 
definition the melody, you can do so with the action ”Reset to Definition” 
in the “Define Melody” action menu in the Arrangement Window. However, 
the musical changes you made prior to the definition of the melody will be 
lost. This is why you should always check a detected melody in the Melody 
Definition Window before editing it musically. 

If you edited the tempo assignment of the melody in definition mode, the 
new tempo will not automatically be applied to the arrangement that the 
melody was opened from for definition. If the newly defined tempo course 
of the melody should determine the tempo of the arrangement, you select 
the “Tool to Define the Tempo of an Arrangement” in the Arrangement 
Window (the 4th tool, not the 3rd one “to Modify the Tempo”!), and in the 
action menu “Define Tempo” you select the action “Tempo from melody”. 
Thus the melody’s tempo is assigned to the arrangement.

A detailed description of the work with the tools can be found in the chapter 
“The Tools and their Inspectors”
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A Quick Reference of Tools and 
Inspectors

The Tools in the Arrangement Window

The Selection Tool

■  Selection: selection for copying and pasting

■    Navigation: grab and move the window area, switch to the zoom tool with 
a double click

■  Play Algorithm: set the play algorithm parameters

■  Send Midi: set the MIDI parameters

■  Scrub-Mode: listening to the “local sound” with pressed and dragged 
mouse

■  Scrub Solo: scrub mode for the selected melody

■  Play Note: plays a single clicked note or selection

■   Quantize: Defines the behavior of copied and pasted melody segments

action menu quantize

Play note

Scrub mode

Scrub solo

Navigation

Play Algorithm

Send Midi
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■   Action menu: “Detect Melody” starts the detection of an undetected 
melody, “Edit Definition” opens the Definition Window if the melody is 
detected, 
“Reset to Definition” resets a melody to its original definition, 
“Apply Arrangement Properties...” applies the tempo- and tone scale 
definitions of the arrangement to the definitions of all melodies in the 
arrangement.

The Tool to Move a Melody in Time

■   Mouse tool to move a melody in time: moves the entire melody in its track

■  Quantize: the step size when moving a melody quantized

■    Arrow Keys: to move the melody with the steps selected in the quantize 
menu

■    Action Menu: “Adapt Time” adapts a (previously detected) melody to the 
time of the arrangement, 
“Half Tempo”, “Double Tempo”, “Third Tempo”, “Triple Tempo” stretch 
or shorten the melody by these factors.

The Tool to Change the Tempo of the Arrangement

■   Changing the Tempo: To drag the beat of the background changes the 
tempo, double clicking the background at the beginning of a bar 
introduces a tempo change, a double click on a tempo change cancels it

■   Tempo: manual definition of the tempo of the arrangement or segment

action menu quantize

Play note

move melody quantized

action menu

Play note

tempo
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■  Action Menu: “Equal Tempo” cancel all tempo changes and sets the 
entire arrangement to a regular tempo, “Same Tempo for Following Bars” 
does the same for the following bars only. 
“Equal Beats in Current Bar” and “Equal Beats in Following Bars” set 
irregular beats in a bar definition to equal.
“Tempo from Melody” defines the own tempo of the selected melody as 
a reference for the arrangement and adapts the other melodies 
accordingly. 
“Tempo from Midi File...” opens a MIDI file to be used for tempo map 
import, “Tempo from Midi Clock” and “Tempo from Host Application” 
record tempo maps from running host applications.

The Tool to Define the Tempo of the Arrangement

■   Changing the Tempo: To drag the beat of the background changes the 
tempo, double clicking the background at the beginning of a bar 
introduces a tempo change, a double click on a tempo change cancels it

■   Signature: entering the desired signature for the arrangement or segment

■   Tempo: manual definition of the tempo of the arrangement or segment

■  Arrow Keys: move the entire bar background by the steps previously 
defined in the “Quantize” menu

■   Action Menu: “Double Tempo” and “Half Tempo” changes the notation 
to its double or half note value. 
“Equal Tempo” cancels all tempo changes and sets the entire 
arrangement to a regular tempo, “Same Tempo for Following Bars” does 
the same for the following bars only. 
“Same Signature for Following Bars” cancels all following signature 
changes. “Equal Beats in Current Bar” and “Equal Beats in Following 
Bars” set irregular beats in a bar definition to equal.
“Smooth Tempo Changes” smoothens the time course if irregular tempo 
is defined. 
“Set Tempo Zero to Sound Zero” sets the start of the tempo definition to 

action menu quantize

Play note

signature triplets tempo
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the start of the sound file.
“Tempo from Melody” defines the own tempo of the selected melody as 
a reference for the arrangement
“Tempo from Midi File...” opens a MIDI file to be used for tempo map 
import, “Tempo from Midi Clock” and “Tempo from Host Application” 
record tempo maps from running host applications.

 

The Tools in the Editor Window

For all tools:

■   Playback Mode: determines if the currently edited melody, the melodies 
visible in the Editor Window or the entire arrangement are played

■   Track Selection: selects the melody to be edited or transfers a melody to 
the Editor Window if not present

The Selection Tool
   

■  Selection: select to copy or paste

■    Navigation: grab and move the window area, switch to the zoom tool with 
a double click

■  Play Algorithm: set the play algorithm parameters

■   Scrub-Mode: listen to the “local sound” with pressed and dragged mouse

track selectionplay mode

quantize

Play note

Scrub mode

Navigation

Play Algorithm

Send Midi
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■  Play Note: plays a single clicked note or selection

■  Quantize: Defines the relative position of copied and pasted melody 
segments

The Pitch Shifting Tools

■  Change Pitch: changes the pitch with the mouse

■   Changing Pitch Alignment in a Note: straighten the pitch course to the 
average pitch, diminish or amplify a vibrato by dragging it up or down

■   Changing Wide Pitch Alignment in a Note: straighten the pitch course to 
the average pitch while keeping vibrato or fine phrasing

■   Change the Transition between Notes: adap the transition of notes that 
were pitch shifted to their environment by dragging the blue transition 
lines 

■  Text fields “Note”, “Cent”, “Hertz”: display of the pitch change in 
semitones or in Cents, Hertz for display only

■   Quantize: allows free movement of the pitch or the snapping of notes to 
semitones or notes of a key

■  Action Menu: actions to reset selected notes to their original pitch, 
phrasing or original transition. “Add Random Offset To Pitch Center” 
scatters note pitches

quantize

Play note

Change pitch transition between notes

Change pitch alignment in a note

note cent hertzaction menu

Change wide pitch alignment in a note
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The Tools to Change the Formant Position

■   Changing the Formant Position: changes the formant position of a note 
by dragging its formant bar

■   Changing Formant Shift Style: changes the formant adaptation behavior

■   Formant Transition: changes the velocity of formant transition between 
notes with different formant positions by dragging the blue transition line

■   Text Field “Formant”: display and numerical entering of the offset of the 
original or changed formant position in cent

■  Action Menu: actions to reset selected notes to their original formant 
position.

The Tools to Change the Amplitudes

■   Change Amplitude: by dragging a note upwards or downwards

■   Change the Amplitude Transition between Notes: by dragging the blue 
transition lines

■   Mute Note: by double clicking on a note, another double click makes it 
audible again

■   Text Field “Amplitude”: displays the numerical change of the amplitude 

Play note

Change formant transition between notes

formant in centaction menu

Change formant shift style of notes

Play note

Change amplitude transition between notes

amplitudeaction menu

Mute note
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■   Action Menu: actions to reset selected notes to their original amplitude 
or un-mute notes

The Tools to Change Notes in Time

■  Move Notes: by grabbing one or more notes and horizontal dragging

■  Stretch Note: by grabbing and dragging a note in front the note is 
stretched or shortened at its start, respectively the same happens at the 
end by grabbing it from behind

■   Quantize Note Positions: by clicking selected notes, their attack time is 
set exactly to the positions defined by their score notation.

■   Change the Initial Speed of a Note: by moving the blue point on the lever 
at the start of a note upwards more staccato, inversely downwards, or by 
entering a value in the “attack” field

■   Arrow Keys “Moving” and Quantize: move selected notes by the steps 
selected in the quantize menu

■   Action Menu: actions to reset selected notes to their original time course 
or cancel quantizing. “Add Random Offset To Time Course” scatter the 
selected notes time course.

Play note

Stretch notes

move

Change initial speed of notes

quantizeaction menu

Quantize and assign note positions
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The Note Separation Tool

Changing the Note Separation: by double clicking on a note it is divided into 
two parts, by double clicking on a note separation notes are fused, by 
grabbing and dragging a separation marker it is moved

Separate Segments: by double clicking on an existing note separation the 
melody is divided into two processable segments, by double clicking on a 
segment separation segments are fused

The Tools in the Melody Definition Window

The Selection Tool

■  Selection: this tool has no special function in the definition mode

■   Navigation: grab and move the window area, switch to the zoom tool with 
a double click

■   Play Algorithm: set the play algorithm parameters for default algorithm

■  Scrub-Mode: listening to the “local sound” with pressed and dragged 
mouse

■  Play Note: plays a single clicked note or selection

■   Action Menu: “Redetect Melody” restarts the detection of a melody with 
different parameters, “Tone Scale...” opens the tone scale editor panel. 

Play note

Separate segments

Play note

Scrub mode

action menu

Navigation

Play Algorithm
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“Take Tone Scale From Arrangement” takes the tone scale of the 
arrangement from which the melody definition was opened.

The Note Separation Tool

■  Correct Pitch: by dragging a note to its correct position

■  Play notes resynthesized: for finding detection errors by listening

■  Sensitivity: pitch tracking sensitivity for re-tracking a note’s pitch

The Tool to Correct the Detected Pitch

■   Changing the Note Separation: by double clicking on a note it is divided 
into two parts, by dragging the selection rectangle over the separation 
and double clicking notes are fused, by grabbing and dragging a 
separation marker it is moved

■   Melody margins: are changed by grabbing and dragging the start or end 
segment separations

■  Separation and Silence Detection: sensitivity for automatic note 
separation

Play notes resynthesized

Play note

note cent hertz pitch tracking sensitivity
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Melody margins
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The Tool to Define the Tempo of a Melody

■  Definition of the Tempo: moving the yellow anchor line in the bar 
background, click a note drops the anchor, dragging a bar beat changes 
the tempo, double clicking a bar start sets or removes a new tempo 
definition

■   Arrow Keys and Quantize: moves the entire bar background by the steps 
selected in the quantize menu 

■   Signature: manually enter nominator and denominator of the signature

■  Tempo: manually enter the tempo

■   Action Menu: “Double Tempo” and “Half Tempo” changes the notation 
to its double or half note value. “Equal Tempo” cancels all manually 
entered new tempo definitions, “Same Tempo for Following Bars” does 
the same for the following bars only. “Same Signature for Following 
Bars” cancels all following signature changes. “Equal Beats in Current 
Bar” and “Equal Beats in Following Bars” set irregular beats in a bar 
definition to equal.“Smooth Tempo Changes” smoothens the time 
course if irregular tempo is defined. “Optimize Tempo” attempts to 
adapt the tempo to the present notes if tempo was manually 
approximated, “Tempo from Arrangement” sets the tempo of the 
arrangement from which the melody definition was opened. “Set Tempo 
Zero to Sound Zero” sets the start of the tempo definition to the start of 
the sound file.

Play note

action menu signature triplets quantizetempo
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The Tool to Assign the Notes to their Intended Beat

■   Assign Notes to their Intended Beat: moving the notes in assigns the 
notes to a new beat

■  Correct beat Anchor: moving the notes moves their sound content in 
relation to the beat

■   Quantize: defines the smallest note size step for assigning a note to a 
beat

The Tool to Assign the Notes to their Intended Pitch

■   Assign the notes to their intended Pitch: by dragging the notes by the 
blue background rectangles upwards or downwards a semitone position 
is assigned

■   Correct Pitch Center: moves the detected pitch center in relation to 
actual pitch course

The Tool to Define Note Start Regions
   

■   Define Note Start Regions: determines the region where sound will be 
kept constant on arrangement tempo changes.

Correct beat anchor

quantize

Play note

Correct pitch center

Play note
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New Features in Melodyne 2.6

What’s new in the Melody Definitions Editor

Trill Recognition
As a result of the automatic vibrato recognition, trills in the past were 
conflated to a single note. If ever you did want to reduce a trill to the 
individual notes of which it was composed, you had to double-click on the 
start of each note. Now in the Inspector for the Separation tool, you will find 
an action pull-down with a single entry: Separate Trill. This command can 
only be used when a single note is selected. Assuming the note in question 
is capable of being interpreted as a trill, it will then be reduced to the 
individual notes of which it is composed.

This function also generally works for other ornaments besides just trills. A 
mordent, for example, will be reduced to three separate notes. Please make 
sure, though, that the pitch progression has been recognized correctly 
before using the function; if this is the case, the trill will be clearly visible 
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in the pitch curve. It may be necessary in some cases to track the pitch 
again with a higher sensitivity setting prior to using the function.

After using the function, always check that the results are as you expected.

The trill recognition function can be invoked using the keyboard shortcut 
‘t’. The function is also available from the normal editor whenever the 
Separation tool is selected.

Definition of Note Groups
Another useful function when working with ornaments is the ability to group 
notes. This makes it possible to combine all the notes that comprise an 
ornament into a single note, the length of which will be that of the entire 
group and the pitch of which will be that of the note defined as the principal 
note of the group. Any editing performed upon the principal note will apply 
then to the entire group.
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In the Main Menu, under View you will find a new sub-menu called 
NoteGroups. When the first entry Use Note Groups is checked:

■   Notes that have been amalgamated into a group will be displayed as a 
single note in the notation window.

■   Selecting this note will select all the individual notes of which the group 
is composed.

■   When stepping forwards or backwards through the melody using the right 
and left arrows respectively, as soon as the principal note is selected, the 
entire group of notes will sound in sequence.

■   Whenever the tool selected is such that the use of group mode would 
make no sense, as is the case, for example, with the tools for note 
separation or pitch definition, group mode is temporarily disabled to 
allow the notes to be treated singly. (When editing pitch in the Edit 
Window, however, groups remain active).

Keyboard Shortcuts
It is possible and, indeed, advisable to assign keyboard shortcuts to all the 
commands in the Note Groups menu under Preferences. The commands in 
question are:

■   Group Notes. All the notes currently selected are made members of a 
group. In the event that some of the notes selected already belong to 
another group, they will be removed from the old group and reassigned 
to the new one. No note can belong to two groups simultaneously. It is 
possible to select some notes belonging to a group but not others through 
the use of the rubber band. Simply clicking on a note that belongs to a 
group, however, will result in the entire group being selected.
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■   Ungroup Notes. This command abolishes the association between the 
notes of a group; in other words, the individual notes will continue to 
exist but not the group.

■   Show Note Group. Where some but not all the members of a group have 
been selected, this command extends the selection to the entire group.

■   Set Group Main Note. By default, the longest note of a group is 
interpreted as the main note. This command reassigns the status of main 
note to whichever note is currently selected. Note that to select one note 
only, you must either rubber band it or temporarily turn off the Use 
Groups option.

■   Show Group Main Note. This limits the selection to the main note of the 
group.

When using the new trill recognition function (Separate Trill), you will 
nearly always want to create a group consisting of the individual notes of 
which the trill or other ornament is composed. 

To make this the default behaviour, in the Options -> Other dialog, check 
the entry Make Group on Trill Separation.

All group definition and group editing functions are also available in the 
normal editor but the settings made there only apply to the current 
arrangement and are not stored in the melody’s definition file.

You are urged to make extensive use of groups, as this will considerably 
facilitate other editing tasks. Ornaments should first be broken up into their 
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component parts (Separate Trill) and these then organized into groups. 
Create a group whenever you feel you might want to perform the same 
action on each of a set of adjacent notes, whilst retaining the option of 
treating them individually. A prima facie case exists for the creation of a 
group whenever a single note accompanied by an ornamentation sign (or 
with a miniature grace note beside it) would normally be displayed in the 
score. 

Define Tone Scale
The last tool but one in the definition window, Define Pitch Assignment, has 
acquired a number of additional tasks in Version 2.6. Now it can also be 
used for the recognition and definition of the tonality and mode of the 
melody [in the key of F# minor, ‘F#’ is the tonality and ‘minor’ (or ‘Aeolian’) 
the mode]; this is useful as it allows chromatic passing notes (and therefore 
the integrity of the melody) to be retained during transposition regardless 
of whether Scale Snap or Scale Step are selected. 

Although advanced functions like these are of more benefit to those with a 
grounding in musical theory, other users, too, can profit from experimenting 
with different scale definitions; indeed the new functions may even provide 
a more intuitive approach to what might otherwise seem a rather dry 
subject.

When the Define Pitch Assignment tool is selected, the notes of the scale 
are indicated by grey beams, whilst notes lying outside the scale are paler.
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The new commands make the most important functions of the Tone Scale 
Panel available also in the Definitions Window and the Editor.

■   In the left-hand margin of the window, the Key Buttons are active, as in 
Scale Snap Mode in the Editor Window. The name of the note (in upper 
case) accompanied by an ‘m’ (in lower case) represents the minor mode 
(or some other mode, such as the Dorian, in which the third degree of the 
scale is a minor third above the tonic), whilst the name of the note alone 
(in upper case) indicates the major mode (or some other mode, such as 
the Lydian, in which the third degree of the scale is a major third above 
the tonic).

■   Another way of defining the tonality and mode is through the use of the 
pop-up menus at the top of the Inspector. Here any of the church modes 
as well as other scales not forming part of the Major/Minor system can be 
selected. The tonalities are arranged in accordance with the circle of 
fifths to make it easier to switch between closely related keys.

■   To use anything other than concert pitch (A=440Hz), enter the desired 
offset in cents (hundredths of a semitone).

■   Double-clicking on any of the grey beams redefines that note as the tonal 
centre without altering the key signature. If the key were C major, for 
example, [the tonality being ‘C’ and the mode ‘Ionian’ (which is 
synonymous with ‘major’)] clicking on the note ‘E’ would select the 
Phrygian mode with E as the new tonal centre (or ‘finalis’). In the pop-
up windows at the top, ‘E’ would be displayed as the tonality and 
‘Phrygian’ as the mode. The key signature (or lack of it in this case…) 
would remain unchanged.

■   Clicking on the Key Buttons in the left margin of the window also changes 
the tonality but this time the mode remains unchanged. In this case, if 
the key was C major before (tonality = C, mode = Ionian) and you clicked 
on ‘E’, the key would be E major (tonality = E, mode = Ionian) afterwards, 
and the new key signature would have 4 sharps. 

■   If you perform the same action with the Shift key held, not only does the 
tonality change but also the mode, the effect (depending upon which 
mode you start from) being to toggle between major (Ionian) and minor 
(Aeolian), between Dorian and Lydian, or between Phrygian and 
Mixolydian. A few examples: if you are in A major (i.e. A Ionian) and you 
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shift-click on Eb, you will get Eb minor (i.e. Eb Aeolian). If you are in G 
Lydian (two sharps) and you shift-click on C, you will get C Dorian (two 
flats); shift-click a second time on C, and you will get C Lydian. If you 
are in A Phrygian (one flat) and you shift-click on F, you will get F 
Mixolydian (two flats).

The actions in the Define Tone Scale pop-up next to the toolbar on the right 
of the screen help you locate the most probable key automatically. Unclear 
note assignments in relation to the scale can be improved.

■   Find Scale with Standard Tuning considering Tuning Offset ascertains 
the tonality or mode and corrects the note assignments. Here any 
deviation from standard tuning [i.e. concert pitch (A=440Hz)] is 
detected and used to improve the assignment of notes to a scale. The 
scale and note assignments actually used, however, still relate to concert 
pitch. The same happens implicitly during the automatic detection of the 
melody. Redefining the pitch is nonetheless useful, as otherwise notes 
may be divided erroneously or assigned to the wrong degrees of the scale. 
After conducting this type of rationalization of note divisions and note 
assignments, Melodyne can often find a more suitable scale

■   Find Scale with Standard Tuning works like the above except that concert 
pitch alone is used to determine the scale and note assignments within 
it. Melodyne does not look to see whether a better match might be found 
by reinterpreting the melody in the light of a different pitch (i.e. where 
the frequency of A is higher or lower than 440 Hz and that of all other 
notes similarly offset). Use this function, when you are confident that the 
instrument was correctly tuned (i.e. to concert pitch) and played in tune.

■   Find Tuning Offset from Standard Tuning works like the first command 
except that the deviation from concert pitch is stored in the melody 
definition. This function should only be used when the deviation is 
significant. The point of storing this information is that otherwise when 
you first load a melody for which an offset has been defined, the new 
tuning might be adopted by the newly created arrangement. To prevent 
this happening without your being aware of it, a dialog box appears 
asking you whether you wish the detected offset to be used for the 
definition of the scale.



162   Melodyne user manual 

What’s new in the Melody Definitions Editor

■   Find Note Assignments for Current Tuning. When you have already 
defined the scale and pitch, this function will ensure that notes are 
correctly assigned.

■   Reset all Manual Note Assignments. Whenever an existing note 
assignment has been modified by the user, the default behaviour is for 
such an assignment to be retained throughout any subsequent automatic 
note assignment operations. Whilst no reassignments occur immediately 
when this command is used, any subsequent automatic note assignment 
operations will begin by wiping the slate clean and the manual 
assignments will therefore be lost.

■   Take Tone Scale from  Arrangement. When you select this function, the 
scale of the arrangement whose definition is open is assigned to the 
melody to be defined. This action should be followed by Find Note 
Assignments for Current Tuning. 

■   Show Tone Scale Panel. The Tone Scale Panel can be used for the more 
precise definition of the tuning system (or ‘temperament’). The 
temperament you define here will apply to the melody but not the entire 
arrangement. Please note that the Scale Panel is context-sensitive. The 
tuning system displayed here will be that of whichever edit, definition or 
arrangement window is currently in the foreground.

When any of the first four functions are used, you can stipulate that notes 
falling between the notes of the scale as defined should ‘snap’ to the 
nearest member of the scale. You can specify the catchment area for the 
snap function as a percentage. If the value is set to 100%, all notes will 
snap to the nearest member of the defined diatonic scale; (in C major, for 
example, an F# will be interpreted as either F or G – whichever is nearer). 
If the value is set to 50%, an F# will remain an F# (i.e. outside the defined 
scale) unless it is out of tune and in fact closer to either F or G. If the value 
is set to 0%, no snapping will occur and notes lying between members of 
the scale will be left alone. The default value is 40%.

Note that when you change the scale using either the key buttons on the 
left or the pop-up menus at the top of the screen or the Key Panel, notes 
will not automatically be reassigned to degrees of the new scale. To reassign 
them, you must then use function Find Note Assignments for Current Tuning. 
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When the first three commands are used, on the other hand, notes are 
automatically reassigned to the newly defined scale.

Further recommendations for handling definition of the tonality and mode 
and the assignment of notes to degrees of the scale…

■   The main object of defining the tonality and mode is that it makes it 
possible to distinguish between notes forming part of the scale (diatonic 
notes) and others (chromatic notes), which are handled differently by the 
Scale Snap and Scale Step functions as well as when melodies are 
dragged and dropped into the Edit Window and their tonality is 
automatically matched to that of the arrangement. 

■   Before defining the tonality, mode and note assignments, the results of 
the pitch recognition and note separation functions should be checked 
carefully and if necessary corrected. Only then should you begin with the 
Define Pitch Assignment tool. Otherwise, if you were to split a note after 
having assigned it manually to one of the degrees of the scale, you might 
have to do so a second time, as corrected notes are automatically 
reassigned.

■   If you already know the tonality and mode of the melody, enter it 
manually and then invoke the function Find Note Assignments for 
Current Tuning.

■   If you wish the pitch (of the entire melody) to be analyzed, use the 
function Find Scale with Standard Tuning considering Tuning Offset.

■   After using Find Tuning Offset from Standard Tuning or Find Note 
Assignments for Current Tuning, listen to the melody again. The notes in 
these modes are quantized to the assigned pitches. Correct any false 
assignments manually.

Under certain circumstances, when you close the Definition Window, the 
newly defined tonality and mode will be adopted by the arrangement from 
which the Definition Window was opened. This will happen when you have 
not previously defined the tonality and mode and there are no other 
melodies in the arrangement.
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Define Pitch Transitions
Melodyne can recognize whether a gradual transition in pitch exists 
between two notes — a portamento (or ‘slide’ in other words) — or a jump 
. Whilst it might be hard to distinguish a portamento from a slur when the 
notes are lying close together, if the melody is modified so as to increase 
the interval to a fifth (say) or an octave, the difference could be very 
noticeable.

Previously you could only determine prior to detection whether or not a 
pitch transition (i.e. a portamento) should be used and the detected 
transitions could subsequently only be altered in the normal editor. The 
changes therefore only applied to the current instance of the melody in a 
specific arrangement and could not be included in the definition of the 
melody for general use.

With Version 2.6, the definition tool for pitch transitions offers the same 
functionality as the equivalent tool in the Editor.

Once you have selected the last tool in the Definition Editor, Define Pitch 
Transitions, you can add or remove pitch transitions.

■   When you double-click on a note, a pitch transition to the following note 
will be added. Double-clicking a second time deletes the transition

■   If several notes are selected, a transition will be created after each of 
them. Provided all the notes selected are followed by transitions, double-
clicking a second time will remove them; otherwise, transitions will be 
added after those notes that previously lacked them and the rest of the 
selection will be left unchanged

■   Another way of performing the same action is to select the note or notes 
to which you intend to append a transition and then click the Transition 
button in the Inspector, which (again) is a toggle, adding transitions if 
they are absent or else removing them if they are present
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Melodyne 2.6 allows to manually change the definition of pitch transitions. 
The Inspector now offers a number of new controls:

■   The Sensitivity Fader helps with the automatic detection of transitions. 
It serves to find a plausible starting condition for the material prior to 
manual editing. Each time the setting of this control is altered, Melodyne 
will search again for pitch transitions based on the new setting, 
redefining all transitions in the process including those you have entered 
manually. The Sensitivity Control always works upon the entire melody.

■   The Change Notes button in the Inspector assigns a new pitch randomly 
to each note without changing the expression. This is helpful since you 
can only assess the effect of the transitions when the intervals between 
notes have been changed.

■   Reset Notes restores the notes to their starting positions.

The Recognition of Rough Sounds
The pitch recognition function does not always produce optimum results for 
sounds with a rough edge, a growl or a sub-octave element to them, but 
clicking on the new Roughness button before dragging the affected notes 
to their supposed pitches can help. If they are already close to the correct 
pitch, double-clicking will be enough to trigger a fresh attempt by Melodyne 
to identify the pitch of the notes.



166   Melodyne user manual 

What’s new in the Melody Definitions Editor

When this option is selected, a pitch-recognition algorithm specially 
optimized for this type of material is used. Note, however, that if the 
Roughness button is clicked unnecessarily and the algorithm is applied to 
sounds lacking in roughness, details of the performance may be lost, even 
though the basic notes will still be identified correctly.

New Playback Mode
Analogous to Play Original with the ‘o’ key, the function Play Recognized 
Pitch has been added to the Definition Editor (Shortcut: ‘p’). Here the 
detected pitch can quickly be compared with the original recording.

Improvements in the Use of Tools
When editing a melody definition, you constantly need to switch between 
the Note Separation Tool and the Identify Pitch Tool. For example, after 
using the Note Separation Tool, the pitch of any newly created notes needs 
to be identified, which normally would require you to swap tools. Now 
whenever notes have been separated or joined or else the split points 
between them have been moved using the Note Separation Tool, a fresh 
attempt will be made to identify automatically the pitch of neighbouring 
notes, obviating the need to switch to the Identify Pitch Tool. Furthermore, 
any time you drag a note upwards or downwards with the Note Separation 
Tool, it will change to the Identify Pitch Tool until the mouse button is 
released.
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New Features in the File Menu

■  Add Melody
If you select multiple files in the File -> Open dialog followed by Add 
Melody, a new track is created for each of the selected files in alphabetical 
order. Previously the order was undefined.

■  Insert Empty Tracks
When the function Insert Empty Tracks is selected from the File menu or 
using the new keyboard shortcut (Mac: [Apple]+[+]. PC: [Ctrl]+[+] ), a new 
dialog appears from which you can select the number and location of the 
new tracks, possible locations being the top and bottom of the track list as 
well as just above, and just below, the track currently selected. 

■  Remove Selected Track
When the Remove Selected Track function is selected from the File menu 
or using the new shortcut (Mac: [Apple] + [-]. PC: [Ctrl] + [-] ) and the track 
in question is not empty, a warning dialog now appears inviting you to 
confirm your decision to delete the track.
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New Features in the Edit Window

■  Scroll to Paste Position
When notes are pasted from the clipboard into a track, the cursor moves to 
the end of the pasted material and the screen display now scrolls so that 
this occupies the centre of the screen. Previously the display did not scroll 
so that the cursor sometimes disappeared from the screen.

■  Show Pitch
Now you can toggle at any time between a 1-line stave (which shows only 
the rhythm of the notes) and a 5-line stave (which shows both their rhythm 
and their pitch) by unchecking or checking (respectively) the menu entry: 
View -> Selected Track -> Pitched Notation. 

Previously you had to make a final decision as which type of display you 
wanted prior to the detection stage.

This option is also available in the Definition Window; if changed here, the 
setting will be stored as part of the definition, so that if the melody is later 
loaded into a new arrangement, the preferred display mode (which applies 
to the entire track) will be retained. 

Scales
Important improvements have been made in Version 2.6 to the behaviour 
of Melodyne when a melody is transposed into a different key. In the past, 
melodies were unwittingly altered, because certain tones were excluded and 
notes of different pitches ended up sharing the same degree of the scale. 
Now the original shape of the melody is retained as far as possible. This is 
done by distinguishing in the original melody between diatonic and 
chromatic notes. Chromatic notes (e.g. notes foreign to the key and for 
which an accidental would therefore be needed in the score) are now no 
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longer obliged to snap to the nearest diatonic note but are allowed to retain 
their original positions relative to the other notes of the melody. 

This is most noticeable when melodies are dragged and dropped from the 
Melody Manager into the Edit Window when the Adapt to Key function is 
active. A word of advice: use Scale Step mode so that small deviations in 
pitch are retained. You will seldom need Scale Snap mode (which forces all 
notes to snap to the diatonic scale) when adding a melody. The 
improvement described also affects changing the key of selected notes 
when in Scale Snap or Scale Step mode; if you wish all the notes of the 
imported menu to snap to the nearest scale degree as before, you can 
change the default behaviour by unchecking Consider Original Scale Notes 
on Scale Snap in the Preferences -> Other dialog.

Key Buttons
When Scale Snap mode or Scale Step mode are 
selected, the notes of the note display on the left 
hand side of the window become radio buttons for 
determining the key (i.e. the tonality and mode). 
Previously if you wanted the minor mode (key), you 
held down the [Shift] key whilst clicking on the key 
note (to select the tonality); otherwise the major 
mode would be selected. 

Now when you click on a new key button, the tonality 
changes but the mode (i.e. the scale structure) 
remains the same. If you were in F# minor, for 
example, and you click on ‘E’, you will get E minor. 
If you were in F# Dorian (one sharp), and you click 
on ‘E’, you will get E Dorian (one flat).

If you perform the same action with the Shift key held, not only does the 
tonality change but also the mode, the effect (depending upon which mode 
you start from) being to toggle between Ionian and minor Aeolian, between 
Dorian and Lydian, or between Phrygian and Mixolydian. A few examples: 

■   If you are in A major (i.e. A Ionian) and you shift-click on Eb, you will get 
Eb minor (i.e. Eb Aeolian). 

■   If you are in G Lydian (two sharps) and you shift-click on C, you will get 
C Dorian (two flats). 
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■   Shift-click a second time on C, and you will get C Lydian. 

■   If you are in A Phrygian (one flat) and you shift-click on F, you will get F 
Mixolydian (two flats).

Pitch Transitions
In the past, when the Pitch Transition Tool was selected, you could only set 
or delete transitions by clicking the Transition knob in the Inspector. Now 
you can do this by double-clicking on the relevant notes.

■   When you double-click on a note, a pitch transition to the following note 
will be added. Double-clicking a second time deletes the transition.

■   If several notes are selected, a transition will be created after each of 
them. Provided all the notes selected are followed by transitions, double-
clicking a second time will remove them; otherwise, transitions will be 
added after those notes that previously lacked them and the rest of the 
selection will be left unchanged.

New Features in the Arrangement Window

The Edit Tempo and Define Tempo tools
The tempo editing possibilities have been greatly improved through the 
addition of a new option. When the Edit Tempo or Define Tempo tools are 
selected, you can now choose between two settings: Next follows or Next 
fixed. This option, which is obviously only of interest if you have more than 
one tempo definition in the melody, determines what happens to a later 
tempo definition when you edit an earlier one.
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If Next Fixed is selected and a tempo definition is moved or deleted, the 
tempo is adjusted to ensure that the following tempo definition does not 
have to move (i.e. that it retains its absolute position in time).

Next Fixed: After the middle tempo definition is moved, the following one 
retains its position, with the intervening bars stretched or compressed to 
make this possible. 

Next Follows: Whenever a tempo definition is deleted, the bars previously 
governed by it will fall under the control of the tempo definition before. 
Removing the centre (B) of three tempo definitions (A, B and C) will result 
in C moving forwards or backwards in time depending upon whether the 
tempo of B was slower or faster than that of A.

Next Follows: With Next Follows selected, the removal of one tempo 
definition affects the position of all the tempo definitions that follow.
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If the Edit Tempo Tool is selected, the default option is Next Follows. If the 
Define Tempo tool is selected, Next Fixed is the default. This is because 
when you are defining the tempo, a tempo definition will generally be 
anchored to a note in the melody and you will want it to stay there. On the 
other hand, when you are editing the tempo, the musical contents will 
themselves shift so you will want the definitions to switch along with them.

You can only delete a tempo definition containing a new time signature if 
the number of beats separating the tempo definitions on either side of it is 
a multiple of the key signature of the preceding tempo definition. In other 
words, if you have two bars of 4:4 (total: 8 bars) followed by two bars of 3:4 
(total: 6 bars) you cannot delete the second tempo definition, because 14 
(8+6) is not a multiple of 4 (four into fourteen won’t go…). The only 
solution is to change the second time signature (in this case to 4:4).

Playback Parameters
Melodyne now handles the attack phase of transposed notes in a way that 
yields more realistic results. If you have loaded an arrangement created with 
older versions of the program, however, you have to make some arbitrary 
change in one of the playback parameters, such as setting the global tempo 
to 50% — you can restore it to 100% immediately afterwards — before the 
new algorithm kicks in.

The result will generally be an improvement in quality unless perhaps you 
are using extreme sound settings or large transposition intervals for effect.

New Features in the Tone Scale Panel
Here you can choose from a number of different types of scale, such as the 
major and  various types of minor scale, the church modes, jazz, exotic and 
other scales. 

Please note that these scales serve simply to provide a means of 
distinguishing members of the scale (diatonic notes) from non-members 
(chromatic notes) and that the tuning system (or ‘temperament’) is the 
same regardless of the scale selected. To select a different temperament or 
else to load or define one of your own, you have to push the Edit button. 
Then you will have access to advanced options, allowing you to select or 
define special temperaments.

User temperaments can be saved and reloaded.
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Key Buttons
When Scale Snap Mode or Scale Step Mode are selected, the notes of the 
note display on the left hand side of the window become radio buttons for 
determining the key (i.e. the tonality and mode). Previously if you wanted 
the minor mode (key), you held down the [Shift] key whilst clicking on the 
key note (to select the tonality); otherwise the major mode would be 
selected. 

Now an unshifted click on any of the tone buttons establishes that as the 
new tonal centre and the scale structure moves in parallel with it; the 
tonality changes, in other words, but not the mode. If you were in a major 
key (any major key) before and you click on Bb, you will get Bb major. If you 
were in a minor key, any minor, you will get Bb minor. If you were in the 
Phrygian, you will get Bb Phrygian (Key signature: 6 flats). And so on.

If you perform the same action with the Shift key held, not only does the 
tonality change but also the mode, the effect (depending upon which mode 
you start from) being to toggle between major (Ionian) and minor (Aeolian), 
between Dorian and Lydian, or between Phrygian and Mixolydian. 
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New Features in the Export Window
If the option Individual Sound File for each Marker Region is selected in the 
Regions Selector, when you click on Export, file names are now generated 
automatically for the individual files based on the folder name and the file 
ending you have entered, whereby the file ending ( “.wav” or “.aiff”) 
indicates the desired format. If the markers, for example, are named ‘A’, ‘B’ 
and ‘C’ and you enter the folder name ‘MySound’ with the file ending ‘.aiff’, 
the files within the MySound folder will be named ‘MySound_A.aiff’, 
‘MySound_B.aiff’ and ‘MySound_C.aiff’.

New Shortcuts
Keyboard shortcuts provide swift access to commonly used functions and 
can therefore streamline your work with Melodyne. The current shortcuts 
can be reassigned at any time by selecting Shortcuts in the Preferences 
dialog. In addition to those already mentioned in the text, Version 2.6 
contains the following new shortcuts.

Commands > Melody Manager

■   Open in New Arrangement

■   Add to Current Arrangement

■   Edit Melody Definition

■   Update .mdd file

This provides access to the commands from the action menu in the Melody 
Manager

Navigation > Scroll

■   Move Locator Range Forward

■   Move Locator Range Backward

Without changing the distance between the locators, these commands 
respectively move the entire block forwards or backwards such that the 
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Right Locator occupies the position formerly occupied by the Left or the 
Left the position formerly occupied by the Right.

■   Set Left Locator to Current Song Position

■   Set Right Locator to Current Song Position

These commands can also be used during playback. The locators then snap 
to the nearest gridline to the cursor, the resolution of the grid being 
determined by the quantization settings
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